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Read these instructions carefully and look at the equipment to become 
familiar with the device before trying to install, operate, service or maintain it. 
The following special messages may appear throughout this bulletin or on the 
equipment to warn of potential hazards or to call attention to information that 
clarifies or simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning” safety label 
indicates that an electrical hazard exists which will result in personal injury if 
the instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal 
injury hazards. Obey all safety messages that follow this symbol to avoid 
possible injury or death.

NOTE: Provides additional information to clarify or simplify a procedure.

Electrical equipment should be installed, operated, serviced, and maintained 
only by qualified personnel. No responsibility is assumed by Schneider 
Electric for any consequences arising out of the use of this material.

DANGER
DANGER indicates an imminently hazardous situation which, if not 
avoided, will result in death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation which, if not 
avoided, can result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not 
avoided, can result in minor or moderate injury.

CAUTION
CAUTION, used without the safety alert symbol, indicates a potentially 
hazardous situation which, if not avoided, can result in property damage.

HAZARD CATEGORIES AND 
SPECIAL SYMBOLS

PLEASE NOTE





Contents 63220-100-200E1
06/2011

Contents

Contents 1
Introduction 9
PowerLogic SCADA—A Complete Solution 10
Assumptions 10
What is SCADA? 10
What is PowerLogic SCADA? 10
Preparing for PowerLogic SCADA 10

Components of a Project 11
Configuration Tools 11
Runtime Environment 11
Supported Device Types and Protocols 11

System Requirements and Installation Instructions 13
Uninstalling and Reinstalling PowerLogic SCADA 13

Quick Start: Typical Workflow 14
IEC 61850 System Setup Workflow 17
Getting More Information 18
Manuals 18
Help files 18
Customer support 18

The Profile Editor 19
Overview of the Profile Editor 21
Typical Workflow Illustration 22
Workflow Overview 22
Create/Edit Device Type 23
Create/Edit Device Profile 24
Create/Edit Unit Templates 25

Launching the Profile Editor 26
Locked and Custom Icons 26
Setting the Screen Resolution 26

Main Menu Options 27
Adding Engineering Unit Templates, Units, and Conversions 28
Setting Up Engineering Templates and Selecting Conversions 28
Creating or Editing an Engineering Unit Template 29
Selecting Conversions 30
Deleting a Template 30

Adding or Editing a Base Engineering Unit or Conversion 30
Adding a Base Engineering Unit and Unit Conversion 31
Editing a Base Engineering Unit or Conversion 31
Deleting a Base Engineering Unit or Conversion 31

Defining Device Types and Tags 33
Device Type Screens and Workflow 33
Using the Define Device Type Tags Tab 33
Adding, Editing, or Deleting a Device Type 35
Adding a Device Type 36
Editing a Device Type 37
Deleting a Device Type 38
Assigning Tags to Generic I/O Points 38

Printing the .CSV File 39
Setting Up Device Type Categories 39
Adding a Category or Subcategory 40
Editing a Category/Subcategory Name 40
Deleting a Category or Subcategory 40

Editing Functional Addresses 41
Adding Custom Tags and Tag Addresses 42
Setting Up Custom Tags 42
Adding a Custom Tag 44
Editing a Custom Tag 45
Deleting a Custom Tag 45

© 2011 Schneider Electric All Rights Reserved 1



Editing Tag Addresses 46
Real-Time Tag Addresses 46
Onboard Alarm Tag Addresses 47
Reset Tag Addresses 47
Control Tag Addresses 48
Editing Address Information 49
Adding a New Tag Address 50

Editing Tag Addresses, Generic 50
Creating Device Profiles 51
Enabling Waveforms 51
Viewing Device Profiles 51
Adding, Editing, or Deleting a Device Profile 52
Adding a Profile 52
Editing a Profile 53
Deleting a Profile 53
Adding a Device Profile 54
Editing a Device Profile 56
Deleting a Device Profile 56

Selecting Trend Intervals 56
Setting Up Trend Intervals 57

To add a trend interval: 57
To edit a trend interval: 57
To delete a trend interval: 57

Editing IEC 61850 Datasets 57
Creating a New DataSet 57
Creating a DataSet from an Existing DataSet 58
Copying a DataSet to a Device Type 58
Editing and Deleting DataSets 58

Editing IEC 61850 Report Control Blocks 58
Creating a New Report Control Block 59
Creating a Report Control Block from an Existing Report Control Block 59
Copying a Report Control Block to a Device Type 59
Editing and Deleting Report Control Blocks 60

Creating a Composite Device Type 60
G3200 Device Setup 62

For use with multiple devices 62
In the Profile Editor 62
In SFT850 62
In PowerLogic SCADA 62

For use with a single device 62
In the Profile Editor 63
In SFT850 63
In PowerLogic SCADA 63

IEC 60870-5-104 Protocol Support 63
DNP3 Protocol Support 63

Setting Up Projects in the Profile Editor 65
Project Screens and Workflow 65
Typical Workflow 65

The Set Up Projects Tab 66
Adding, Editing, or Deleting a Project 66
Adding a Project 67
Editing a Project 68
Deleting a Project 68

Editing and Deleting Information in a PowerLogic SCADA Project 68
Customizing Tag Names 68

Importing and Exporting Project Files 69
PowerLogic SCADA Export 69
Before you export 69
To export a Profile Editor project to the PowerLogic SCADA project: 69
Moving Files if the Profile Editor is not with the Server (Reusing a Project) 70

Profile Editor Export 71

2 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 Contents
06/2011



Contents 63220-100-200E1
06/2011

SCL Export 71
Exporting the File 72

Importing Files into the Profile Editor 72
Import Reconciliation Screen (Search) 73

Editing the Item 74
Completing the Import of an Item 74

Import Reconciliation Screen (Merging-Matching) 74
Importing SCL Files 76
Using Import Templates 76

Creating a New Template During Import 76
Applying a Template During Import 77
Deleting a Template 77

Understanding Tags 78
IEC61850 Tag Construction 78
Defining an Enumeration 79
Using Special Tags to Control Circuit Breaker Status 79
Format Code Definitions 80
Real-Time Format Code Definitions 81
Alarm Format Code Definitions 82
Control Format Code Definitions Rules of Operation 82
Predefined Control Format Codes 82
Predefined Reset Format Codes 82
Custom Control and Reset Format Codes 83

Logic Codes 83
Using Block Writes 90

The Profile Wizard 92
Before You Use the Profile Wizard 93
Adding the Cluster, Network Address, and Servers 93
When Setting Up More than two I/O Servers per Cluster 95
Entering Copy for Translation 96

Using the Wizard to Add and Remove Devices 97
Adding a Device to a PowerLogic SCADA Project 97
Adding a TCP Device to a PowerLogic SCADA Project 97

Adding the TCP Device 98
Adding a Serial Device to a PowerLogic SCADA Project 99

Adding the Serial Device 100
Adding a DNP3_TCP Device 101

Adding the DNP3_TCP Device 101
Adding an IEC61850 Device to a PowerLogic SCADA Project 103

Adding the IEC 61850 Device 103
LDName 104
BRCBs and URCBs 104

Naming Ports 105
Editing Devices in a PowerLogic SCADA Project 105
Editing a Profile and Adding it Back to the Project 105
Editing a Device in PowerLogic SCADA Only 106
Adding Device Data in PowerLogic SCADA Only 106

Removing a Device From the PowerLogic SCADA Project 106
Adding Multiple Devices through the Automation Interface 107

Using the OLE Automation Interface to Add and Remove Devices 109
Examples 109
C# 109
Excel VBA 110

Command Line Interface 110
Interface Workflow 110
Prerequisite information 111
Interface 112

© 2011 Schneider Electric All Rights Reserved 3



Graphics: Using the Design Time Environment 114
Typical Workflow 115
The PowerLogic SCADA Pages 116
Creating a PowerLogic SCADA Project 117
Reusing Projects Created in the Profile Editor 117
Before You Begin 118
Adding a New Graphics Page 118

118
Setting a New Page as the Project Startup Page 118
Creating a One-Line on a Graphics Page 119
Using Menu Configuration to Edit Pagemenu.dbf (Changing the Graphics Page Appearance) 121
Creating and Editing Genies 123
To create a custom genie, follow these steps: 123
To create a custom symbol for a custom genie, follow these steps: 123

Deleting Information from PowerLogic SCADA 124
Working with Alarms 125
Alarms Overview 125
PC-Based Alarms 125
Onboard Alarms 125

Adding Setpoints and Delays 125
Setting Up an Alarm Based on an Enumeration 126
Changing an Alarm Severity 126
Enabling Waveforms for Onboard Alarms 126
Setting Parameters for Event Log Length and Historical Logging of Events 126
Event Storage: [Alarm]SummaryLength Parameter 127
Event Logging: [PLSEventLog] Parameter 127

Adding an Onboard Alarm Tag 128
Setting Up Audible Alarms 128

Restoring and Backing Up Projects 129
Restoring a Project 129
PowerLogic SCADA Backup 129

The Project Color Change Tool 130
Adding a Custom Genie for Use in the Color Change Tool 130
Changing the Colours of Busbars and Circuit Breakers 130

Using Cicode to Customize a Project 132
Customizing PowerLogic SCADA Default Behaviours 133
Time Zone Settings 133
Time Synchronization 133
Trend Tag Scan Intervals 134
Calculating Disk Storage for Trends 135

Waveform Management 136
Waveform Storage 137
Waveform Database and Special Waveform Tags 138

Graphics: Using the Runtime Environment 139
Launching and Closing the Runtime Environment 140
Viewing the Graphics Page in the Runtime Environment 141
Logging On to the Runtime Environment 141
Viewing the Interface 141
Communications Loss 142

Viewing the Alarms/Events Page 142
The Event Log 142
The Alarm Log 142
Unacknowledged Alarms and Disabled Alarms 143
Alarm and Events Logging 143
Sorting Logs 143
Filtering and Freezing Information 143
Alarm Viewing Options 143
Viewing, Printing, and Export Options 144

When Alarms do not Display Correctly 145
Event/Alarm Log Columns Table 145

4 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 Contents
06/2011



Contents 63220-100-200E1
06/2011

Changing the Display Name in an Alarm or Event Log 146
Filtering and Freezing Log Views 147
Filtering Information 147
Freezing the View 148

Using the Analysis Page 149
Using the Equipment Pop-Up Page 150
Viewing Waveforms 151
Entering Setpoints for Alarms 152
Viewing Real-Time Trends 153
Viewing Lists of Real-Time Information for the Genie 153
Overriding Tag Status 153

Multi-Monitor Support 155
Using the Graphics Test Mode 156
Using the Demo Mode 157

Assigning and Controlling User Privileges 158
Default User Access Settings (Privileges) 159
Adding and Modifying User Accounts 160
Using Windows Integrated Users 160

Changing Access Rights 162
Appendix 1: Default Genie Library 163

PLS_ALARM 163
PLS_ANSI_BASE_1 / PLS_ANSI_BASE_2 163
PLS_ANSI_CB_1 / PLS_ANSI_CB_2 164
PLS_ANSI_SW_1 / PLS_ANSI_SW_2 166
PLS_DISPLAY 166
PLS_GEN_BASE_1 / PLS_GEN_BASE_2 166
PLS_GEN_CMD_1 / PLS_GEN_CMD_2 167
PLS_GEN_EQ_1 / PLS_GEN_EQ_2 167
PLS_IEC_BASE_1 / PLS_IEC_BASE_2 168
PLS_IEC_CB_1 / PLS_IEC_CB_2 169
PLS_IEC_SW_1 / PLS_IEC_SW_2 169
PLS_METER 169
ITEM1 170

Appendix 2: Using Citect INI Parameters 171
Parameters Database 171

General PowerLogic Driver Parameters 173
watchtime 173
kernelStatisticUpdateRate 173
UseWriteMultiRegistersOnly 173
timeout 174
retry 174
RetryTimeout 174
RetryException 175
standbyRefreshRate 175
standbyCheckTime 175
statusUnitCheckTime 176
initUnitCheckTime 176
initCacheTimeout 176
cacheRefreshTime 177
StatusRegister 177
StatusRegisterType 177
ModbusBase 178
RegMode 178
timeZone 179

Performance Tuning Parameters 180
Bandwidth Allocation Parameters 180
Packet Blocking Optimisation Parameters 181
Advanced Tag Block Capabilities (Invalid Memory Access Blocks defined) 183
Invalid Block Tag Definition Syntax 184

© 2011 Schneider Electric All Rights Reserved 5



Configuration Notes 184
Write-only Memory 185
Tag Blocking Notes 186
Write-only Tags 186

Waveform Parameters 188
WaveformsDisable 188
WaveformMatchMargin 188
WaveformCheckTime (PM, CM, and Sepam) 188
WaveformZone (Sepam) 189

Sepam Event Reading Parameters 190
EventTable 190
EventIdle 190

MicroLogic Modules Configuration Parameters 191
CCM 191
Module-Specific Packet Blocking Optimisation Settings 191

Data Replication Parameters 192
Database root folder path 192
Database root UNC path 192
Replication destination configuration 192

Graphics Library Parameters 193
Maximum number of entries that can be held in Event Log 193
Parameters for Alarm and Event States 193

Appendix 3: Additional INI Parameters 195
Quantum PLC Time-Stamped Events 195

Appendix 4: Glossary 196
address 196
alarm categorization 196
alarm text (On/Off) 196
alarm filters 196
alarm groups 196
alarm levels 196
alarm types 196
Automation Interface 196
bandwidth 196
baud rate 196
bitmask 197
Cicode 197
cluster 197
Color Change Tool 197
CommsMethod (communications method) 197
ComPort 197
composite device type 197
configuration environment 197
control 197
custom device type 198
custom tag 198
DataBits 198
data type 198
demo mode 198
design time environment 198
device category 198
device profile 198
device type 199
device type drivers 199
engineering unit templates 199
enumeration (used for the circuit breaker status) 199
format code 199
functional addressing 199
genie 199
graphics test mode 199

6 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 Contents
06/2011



Contents 63220-100-200E1
06/2011

ICD file 200
IEC tag name 200
IED 200
IID 200
logic code 200
metadata 200
multi-monitor support 200
onboard alarm 200
parity 200
PC-based alarms 201
PMCU 201
point (see SCADA tag) 201
polling priority 201
PowerLogic SCADA tag name library 201
Profile Editor 201
Profile Wizard 201
project 201
Project Color Change Tool 202
register scaling 202
resets 202
reserved names 202
runtime environment 202
SCADA tag (SCADA point) 202
SCL 202
StopBits 202
super-genie 203
tag 203
tag address 203
tag description 204
tag group 204
units 204
units template 204
user privileges (user access, user rights) 204
vector math 204
voltage levels 204

Appendix 5: Frequently Asked Questions (FAQs) 205
How do multiple engineers create device types and profiles at the same time? 205
If I don't use PowerLogic drivers, how do I create device profiles? 205
Can I install ION E or SMS on the same computer as PowerLogic SCADA? 205
When creating custom tags, how do we ensure consistency in their names and attributes? 206
How should we manage categories and subcategories? 206
How should we manage units and unit templates? 206
When should I create a device type rather than device profile? 206
How do we share or transfer device types and device profiles between computers? 207
How can we re-use previous Profile Editor projects? 207
How do we synchronize a new PC with the master Profile Editor PC? 208
What do I do before I add or remove devices in the Profile Wizard? 208
What are the requirements for device names? 208
How do I troubleshoot device communications issues? 209
How do I use MODBUS communications methods? 209
How can I add more than one device at a time? 209
In PowerLogic SCADA, what are the naming conventions for servers and clusters? 210
How and when do I create users for the Runtime environment? 210
How do I manage projects in the Citect Explorer environment of PowerLogic SCADA? 210
On the Graphics page, what do I need to know about creating genies? 212
How do we customize existing templates? 212
How do I change the default pickup/dropout text for alarms? 213
What can I modify during runtime? 213
Why do the browser navigation buttons not work? 214
What can I set up in logging and archiving? 214

© 2011 Schneider Electric All Rights Reserved 7



On the Graphics page, how are colour changes displayed for voltage levels? 214
How do I create and configure busbars? 215
What INI parameters should I use for debugging? 215
How do I tune my system for best performance? 216
If a tag is configured in PowerLogic SCADA, how is it polled in the device? 218
Device popup from a one-line: Why do the fields overlap? 218
Can I change the %CLUSTER% name in the Profile Wizard? 219
When viewing PowerLogic SCADA from a web client, I see a licensing error. How do I fix it? 219
A device can prevent writes to its registers: how do I ensure that writes are successful? 219
How do I prevent PowerLogic SCADA from accidentally making invalid areas in memory available to
reads and writes? 220
How do I create an audit in the Event Log for user logins and logouts? 220
Why do I get an "out of memory" message when I try to run the Automation Interface? 221
Why am I seeing #COM for circuit breaker status in the genie status page? 221
Why can't I acquire waveforms in the waveform viewer? 221
Why won't the Excel DBF Add-In toolbar install? 221
What causes the "First dbf record" error message? How do I keep it from happening? 221

Index of Terms 222

8 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 Contents
06/2011



Introduction 63220-100-200E1
06/2011

Introduction
Welcome to the help file for PowerLogicTM SCADA version 7.20. To navigate through
the file, you can use the search options on the left. Additionally, you can access the
PowerLogic SCADA help files for PowerLogic SCADA-specific information.

In this section, you will find these topics:

PowerLogic SCADA—A Complete Solution on page 10

Assumptions on page 10

What is SCADA? on page 10

What is PowerLogic SCADA? on page 10

Preparing for PowerLogic SCADA on page 10

Components of a Project on page 11

Configuration Tools on page 11

Runtime Environment on page 11

Supported Device Types and Protocols on page 11

System Requirements and Installation Instructions on page 13

Uninstalling and Reinstalling PowerLogic SCADA on page 13

Quick Start: Typical Workflow on page 14

IEC 61850 System Setup Workflow on page 17

Getting More Information on page 18

Manuals on page 18

Help files on page 18

Customer support on page 18
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PowerLogic SCADA—A Complete Solution
The PowerLogic SCADA system provides a complete solution for the monitoring and
control of any electrical distribution network. Using PowerLogic SCADA as the engine,
PowerLogic SCADA includes additional tools that users will use to acquire data from
various devices, and then to apply the data for HMI viewing, alarming, trending, and
reporting.

In this section, you will find these topics:

Assumptions on page 10

What is SCADA? on page 10

What is PowerLogic SCADA? on page 10

Assumptions
The person who installs PowerLogic SCADA will have received training in the entire
PowerLogic SCADA product and will understand the application’s basic functions.

What is SCADA?
SCADA (Supervisory Control and Data Acquisition) is a system that collects data from
various points, both local and remote, and then stores the data at a central location.
The system also can control equipment at an installation.

What is PowerLogic SCADA?
The PowerLogic SCADA product includes several tools that use the PowerLogic
SCADA engine to collect information from all PowerLogic devices:
• In the Profile Editor, you create, configure, and modify profiles for device types that

use the same tags (for example, to set up alarms and trends).
• In the Profile Wizard, you add and modify devices in the PowerLogic SCADA

system.
• In the Project Color Change Tool, you set colours for the different states of circuit

breakers and busbars. These colours display on the final runtime environment
page.

• In the CitectSCADA Graphics Builder (design time mode), you create one-line
drawings, into which you can incorporate objects (genies). Genies are versatile
objects that include variables or other expressions that are specified when you
view the drawing.

• In the CitectSCADA Graphics Builder (runtime mode), users can view the final one-
line drawings, including alarms, events, and history data. With the appropriate
degree of password-controlled authority, users can also perform advanced tasks,
such as changing alarm setpoints and racking devices in and out.

Preparing for PowerLogic SCADA
For a full discussion about preparation for a PowerLogic SCADA project, see Planning
a Project in the CitectSCADA.chm help file (Start > Programs > Schneider Electric >
PowerLogic SCADA 7.20 > PowerLogic SCADA Help). This section of the help
discusses physical layout; requirements such as architecture and security; and project
design.
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Components of a Project
For detailed information about the components that make up a PowerLogic SCADA
project, see Components of a project in the CitectSCADA.chm help file (Start >
Programs > Schneider Electric > PowerLogic SCADA 7.20 > PowerLogic SCADA
Help). The project components include graphic components, tags, alarms, system
components, communications components, I/O Server components and
Cicode/CitectVBA.

Configuration Tools
Configuration tools consist of:

Profile Editor: Use this tool to select tags to be used by device types (tags must be
consistent with IEC 61850 naming conventions), create device profiles for individual
devices, and create projects that include the device profiles to be used in a single
installation. You can specify real-time tags, PC-based alarm tags, onboard alarm tags,
trend tags, and reset tags to be generated for this device.

Profile Wizard: Using this wizard, you will import device profile information from the
Profile Editor into a PowerLogic SCADA project. This tool is simply a means of moving
device profile information into the PowerLogic SCADA project and converting it into
formats that PowerLogic SCADA can use.

Citect Explorer: Use Citect Explorer for basic navigation. From here, you also choose
the active project.

Citect Project Editor: Use the Project Editor for entering database-type information,
such as adding clusters and servers, creating new users, and editing tags within
PowerLogic SCADA projects.

Graphics Builder, Design-Time environment: Use the Citect Graphics Builder to
create one-line drawings that users can view in the runtime environment. These
drawings are populated with interactive objects that are generated by genies. You can
also use the graphics tool to set up system alarms and trends.

Project Color Change Tool: This tool is part of the Project Editor. Use it to change
colours for the states of busbar and circuit breaker genies used in graphics pages.

Runtime Environment
The runtime environment is where the end user views system information. This
environment includes (from the information added in the design-time page) one-line
pages with interactive objects, alarm and event pages, and analysis pages (trends and
waveforms).

Supported Device Types and Protocols
When you install PowerLogic SCADA, you are prompted to choose the drivers that you
will use. A certain number of generic drivers are installed by default (including
PowerLogic device types), and you are not prompted for them. Device types and
protocols supported in PowerLogic SCADA are:
• Generic MODBUS (includes BCPM and any device, such as a PLC or UPS, that

communicates via MODBUS). When adding a controllable device in the Profile
Editor, such as a circuit breaker, use the “Controllable Device” driver; otherwise,
use the “Generic Power Device” driver.

• Sepam 20, 40, and 80 Range, 2000
• MicroLogic 5P and 6P, A, H
• CM4000 series

© 2011 Schneider Electric All Rights Reserved 11
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• PM800 series
• PM700 series
• ION 7650
• IEC 61850 protocol devices
• IEC 870-5-104 (requires extra purchase)
• DNP3
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System Requirements and Installation Instructions
See the PowerLogic SCADA Installation and Configuration Guide for a complete
discussion of system requirements and installation instructions. A PDF copy is on the
installation disk.

Uninstalling and Reinstalling PowerLogic SCADA
Use Add/Remove Programs in the Control Panel to uninstall these PowerLogic
SCADA programs:
• PowerLogic SCADA 7.20 (if you uninstall this, you also uninstall the Profile Editor

and the Project Color Change Tool)
• PowerLogic SCADA Profile Editor 7.20
• PowerLogic SCADA Project Color Change Tool
• Any additional PowerLogic SCADA programs, such as the WebServer, that you

installed

If you uninstall PowerLogic SCADA after you have already created projects, the project
data will not be deleted. It is in [Project Drive]\Documents and Settings\ All
Users\Application Data\Schneider Electric\PowerLogic SCADA 7.20 (for Vista
operating systems, it is [Project Drive]\ProgramData\Schneider
Electric\PowerLogic\PowerLogic SCADA 7.20). The first time you launch the
application after you re-install it, it will locate the project data and re-link it.

© 2011 Schneider Electric All Rights Reserved 13



Quick Start: Typical Workflow
The following is a brief description of the steps you will take when you create a
(Modbus or non-61850) PowerLogic SCADA system. Also, see Typical Workflow
Illustration on page 22 for a flow chart that illustrates the Profile Editor workflow.

1. Identify the equipment and devices to be used in the system: List all of the
device types that you will need.

2. Create a system architecture drawing: Indicate how all devices will interrelate.

3. Prepare the network addressing scheme: Define the Ethernet IP address for each
gateway/PLC/CM4000 and the MODBUS slave address devices.

4. Install the hardware: Install the devices and equipment for the system. Create all of
the communications connections that are necessary. Make sure that devices are
set up for the onboard alarms and waveform captures that you want to view from
graphics pages.

5. Set up device type categories and units/conversions in the Profile Editor: Use
the Setup Device Type Categories screen to add categories (an optional feature
that will make it easier to sort device types in the Profile Wizard). Also use the
Profile Editor to add unit conversions (e.g., watts/megawatts) that are used in
individual installations. Most typical conversions have already been added to
PowerLogic SCADA.

6. Add/edit device types in the Profile Editor: The device type includes all of the
details that define a device: real-time tags, alarm tags, trend tags, resets, and
controls. Use the Define Device Type Tags tab to add and edit device types, create
custom tags, and to assign tags to device types. Although the device type includes
all of the information we know about a device, the device profile (see step 8)
includes only the specific tags that are needed for that device in a customer’s
installation.

7. (optional) Edit tag addresses in the Profile Editor: As needed, add or edit the
address attributes of individual tags for a single device type. This includes such
items as the number of registers used by the tag, bitmasking, and logic code.

8. Create device profiles in the Profile Editor: The profile is a subset of the device
type’s functionality. Use the Create Device Profile tab to create a device profile;
select only the tags required for a customer. On this tab and the related Add/Edit
Device Profile screen, you also specify tags to be used for onboard waveform
captures, PC-based alarms, and trends.

9. Create and configure a project in Citect Explorer: From Citect Explorer, add a
new project. From the Project Editor page, add at least one cluster and network
address, and the servers that will be used (alarm, report, I/O, and trend). Set
'Publish Alarm properties' to TRUE when setting up the alarm server (expand the
screen by pressing F2). This must be set; otherwise you will not be able to edit
while in the setpoints page.

10.Create a corresponding project in the Profile Editor: In the Set Up Projects tab,
select the device profiles for the devices that are included in the project created in
the previous step. Add the project to the Profile Editor, using the same name you
created in the previous step. To view the list of projects created in PowerLogic
SCADA, click the Display Projects button (on the Add/Edit Project screen) :

Each profile will include all of the device attributes that you have set up in earlier
steps.

11.Export devices from the Profile Editor: From the Set Up Projects tab, choose a
single project and click Export Project to convert device tags into a format usable
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within PowerLogic SCADA, and to move them to the location where they can be
imported into PowerLogic SCADA.

12.Use the Profile Wizard to set up clusters and add devices to PowerLogic
SCADA: Use the Profile Wizard to set up clusters (created in step 9). See Adding a
Device to a PowerLogic SCADA Project on page 97 for additional information.

Use the Profile Wizard to add the exported devices, one at a time; or use the
Automation Interface (Adding Multiple Devices through the Automation Interface on
page 107)to add all of the devices from one page (example found in: Program
Files\Schneider Electric\PowerLogic SCADA 7.20\Bin\Example Automation.xls).
You will need device networking information for this step.

13.Compile and correct errors in PowerLogic SCADA: Note: It is always a good idea
to pack before you compile (Project Editor > File > Pack). To compile the project,
click Compile, located at the top of the Project Editor:

Then correct any errors and note any warnings.
14.Create graphics in the Citect Graphics Builder: Use the Graphics Builder (the

design time environment) to create one-line diagrams that incorporate icons and
objects for the user to read information from the system. You will use this feature to
add genies that, when launched from the runtime environment, provide real-time
system information.

15.Use the Menu Configuration tool to set up the appearance of the runtime
environment. The Menu Configuration tool creates/edits the pagemenu.dbf file,
which controlsthe appearance of tabs and menus for a specific project in the
runtime environment. Access it via the Citect Project Editor (System > Menu
Configuration). You can copy and paste the pagemenu.dbf file from the PLS_
Example project to your own project; or you can configure your own template from
scratch.

16.Add at least one user in the Citect Project Editor. From the Users window
(System > Users), add at least one user to the project.

17.Set colours for busbars and circuit breakers in the Project Color Change Tool
(Citect Project Editor): Click Tools > Project Color Change Tool to launch. Use the
Color Change Tool to add unique colours for different states of busbars and circuit
breakers. You can also add a second colour if you want the object to flash between
the two colours when it is in a particular state. (Each time you add a genie, after the
system is set up, you need to run the Project Color Change Tool again to ensure
that the colours are assigned to the new genie.)

18.Run the Computer SetupWizard. This wizard, located in Project Editor > Tools >
Computer Setup Wizard, customizes your computer for use with PowerLogic
SCADA. To run the wizard, click:

NOTE: When running the Computer Setup Wizard, do not change the startup page
(leave the ini settings as <default.>) Changing the startup page at this point will
result in navigation problems.

19.Compile (File > Compile), then run the project: Compile the project:

Then correct any errors and note any warnings. Run the project:
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Each time you add genies to a project, you need to associate them with devices,
and then compile and run again.

20.Test the system: Verify that the runtime environment objects all operate correctly,
that the system is recording data and that all alarms and waveforms function.
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IEC 61850 System Setup Workflow
These are the basic steps you need to follow to set up an IEC 61850 device in your
PowerLogic SCADA project.

1. List all of the SCL files (ICD, CID) for the IEC 61850 devices in your installation. ICD
files are preferred. Pay special attention to data concentrated devices (for example,
the G3200 with multiple devices communicating through it; see G3200 Device
Setup on page 62).

2. Import the first ICD file into the Profile Editor (see Importing SCL Files on page 76).

a. Create the device type.
b. Match or verify tags for PowerLogic SCADA.
c. Complete the import.

3. Create a device profile for the IEC 61850 device type (see Adding an IEC61850
Device to a PowerLogic SCADA Project on page 103).

a. If needed, add/edit datasets and report control blocks (see Editing IEC 61850
Datasets on page 57 and Editing IEC 61850 Report Control Blocks on page
58).

b. Select the appropriate tags for PowerLogic SCADA to monitor for this device.
4. Repeat steps 2 and 3 for additional ICD files.

5. Create a Profile Editor project, adding the device profiles. Configure as needed.

6. Export to PowerLogic SCADA, and to SCL.
— PowerLogic SCADA creates the equipment.profiles file for the Profile Wizard or

Automation Interface.
— SCL will create an IID file for the profile. If newly added datasets and/or report

control blocks are to be used, this IID file is required for step 7. Otherwise, you
can use the original ICD file.

7. Use the appropriate IEC 61850 configuration tool for the device to configure a CID
file from the ICD/IID file. Then download it to the device.

8. Create the PowerLogic SCADA project.

a. From within PowerLogic SCADA, add a new project.
b. Add the appropriate clusters, networks, and servers.

9. Using the Profile Wizard or Automation Interface, add your devices to PowerLogic
SCADA.

When you are prompted for the SCL file, use the CID file you created in step 7.

For more information, see Adding an IEC61850 Device to a PowerLogic SCADA
Project on page 103.

10.Compile and run the project.
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Getting More Information
For additional information, use one of these options:

Manuals on page 18

Help files on page 18

Customer support on page 18

Manuals
In addition to this System Integrator’s Guide, there are these additional documents that
may provide helpful information:
• PowerLogic Installation and Configuration Guide: a PDF copy is on the

installation disk
• Release Notes: located on the installation disk, this file includes information

specific to this release of the product
• Readme file: located on the installation disk, this file also includes late-breaking

information about this release

Help files
In addition to the help file released with PowerLogic SCADA, there are several
PowerLogic SCADA-specific help files. They are located in the PowerLogic SCADA
Bin folder: \Schneider Electric\PowerLogic SCADA 7.20\Bin).

Customer support
Americas: +1 250 544 3010 (24 hours, Monday-Friday)

Asia/Pacific: +852 2579 9568

Europe/Africa: +33 4 76 60 62 35

e-mail: Global-PMC-Tech-Support@Schneider-Electric.com

web support: www.powerlogic.com
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The Profile Editor
This section describes how to use the Profile Editor to create device type tags, and
then to use these tags as building blocks for device types. Secondly, there are
instructions for creating device profiles for unique devices. Finally, there are
instructions for creating projects for each installation or customer.

In this section, you will find these topics:

Overview of the Profile Editor on page 21

Typical Workflow Illustration on page 22

Launching the Profile Editor on page 26

Adding Engineering Unit Templates, Units, and Conversions on page 28

Defining Device Types and Tags on page 33

Device Type Screens and Workflow on page 33

Printing the .CSV File on page 39

Adding Custom Tags and Tag Addresses on page 42

Adding, Editing, or Deleting a Device Type on page 35

Editing Tag Addresses on page 46

Editing Tag Addresses, Generic on page 50

Editing Functional Addresses on page 41

Creating Device Profiles on page 51

Enabling Waveforms on page 51

Viewing Device Profiles on page 51

Adding, Editing, or Deleting a Device Profile on page 52

Adding a Device Profile on page 54

Editing a Device Profile on page 56

Deleting a Device Profile on page 56

Editing IEC 61850 Datasets on page 57

Editing IEC 61850 Report Control Blocks on page 58

IEC 61850 System Setup Workflow on page 17

G3200 Device Setup on page 62

Setting Up Projects in the Profile Editor on page 65

Project Screens and Workflow on page 65

The Set Up Projects Tab on page 66

Adding, Editing, or Deleting a Project on page 66

Creating a Composite Device Type

Editing and Deleting Information in a PowerLogic SCADA Project on page 68

Customizing Tag Names on page 68

Importing and Exporting Project Files on page 69

PowerLogic SCADA Export on page 69

Profile Editor Export on page 71

SCL Export on page 71

Importing Files into the Profile Editor on page 72

Using Import Templates on page 76

Understanding Tags on page 78
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Customizing Tag Names on page 68

IEC61850 Tag Construction on page 78

Defining an Enumeration on page 79

Format Code Definitions on page 80

Logic Codes on page 83
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Overview of the Profile Editor
The Profile Editor is a multiple-screen application that allows you to perform four basic
tasks: create device types, create device profiles, and set up projects.

Use the Define Device Type Tags tab and its screens to add and edit information for
real-time, onboard alarm, control and reset tags and to create and edit device types.
See Defining Device Types and Tags on page 33 for complete instructions.

Use the Create Device Profiles tab and its screens to add and edit individual profiles
for specific devices. A device profile is a subset of the possible variable tags, alarm
tags, and trend tags for a particular device type. See Creating Device Profiles on page
51 for complete instructions.

Use the Set Up Project tab and its screens to bring together all of the system attributes
for a single customer or installation. For example, the customer installation will include
a certain combination of device profiles (depending on the devices installed at the
site). The project allows a specific unit template to be applied, converting units (such as
watts) into units used by the customer (such as megawatts). This causes tags to display
in the converted format. Projects also allow you to rename tags to suit a customer’s
needs (for example, Current A could be renamed to Current Phase A). See Setting Up
Projects in the Profile Editor on page 65 for complete instructions.

PowerLogic SCADA uses the IEC61850 tag-naming convention to create tags that
measure device quantities. Although most of the tags you will use are already entered
into the system, you can add custom tags. For more information, see Understanding
Tags on page 78.
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Typical Workflow Illustration
The following four flow charts illustrate the use of the Profile Editor. The first illustration
provides an overview, and the following illustrations show:
• creating/editing a device type
• creating/editing a device profile
• creating/editing unit templates

Workflow Overview
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Create/Edit Device Type
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Create/Edit Device Profile
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Create/Edit Unit Templates
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Launching the Profile Editor
To launch the Profile Editor, click Start > Programs > Schneider Electric > PowerLogic
SCADA 7.20 > Config Tools > Profile Editor. The Profile Editor screen displays with the
Define Device Tags tab selected. There are two other tabs, used to create device type
profiles and projects.

Locked and Custom Icons

Two icons may appear to the right of the Add/Edit button on some screens: the locked
icon and the custom icon.

The Locked Icon :

This icon indicates that the selected file (e.g., device type, profile, or project) cannot be
edited. All standard device types (for example, Circuit Monitor 4000, MicroLogic Type
P, Power Meter 800) are automatically locked; they cannot be unlocked.

To lock a device type that you create, follow these steps:

1. From the Define Device Type Tags screen, click Add/Edit.
2. On the Add/Edit Device Type screen, you can choose Create New, Create From, or

Edit Existing.

3. Enter the new device information, or select the device to be edited.

4. To lock the device, check the box named Lock This Device Type.

5. Click Save & Exit to save the “lock” and exit the screen.

After you lock a device type, you cannot unlock it. However, you can restore it in this
manner: Copy the locked device type (Create From on the Add/Edit Device Type
screen), then save the copy with a new name.

The Custom Icon :

This icon indicates that a device type or profile is user-created. It may have been
created new, created from an existing device type or profile, or created by editing an
unlocked custom device type or profile.

Setting the Screen Resolution

Depending on the screen resolution you use, some of the Profile Editor screens may
take up the entire viewing area. We recommend that you use at least 1024 x 768
resolution.

Options are:

Setting Resolution (height x width)
VGA 640 x 480
SVGA 800 x 600
XGA 1024 x 768
SXGA 1280 x 1024
WUXGA 1920 x 1200
User user-defined height and width

You can also auto-hide the taskbar to provide more room.
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Main Menu Options
The main menu options (File and Settings) on each of the major tabs of the Profile
Editor are described below.

Field Name/Valid Entries Comments

File >Save Saves any current changes.

File >Create CSV file Creates .CSV file of basic tag data. Store the file in a folder you
designate. Can be viewed in Excel.

File >Print Tag Selections Displays a print preview of all of the tags for this device type. You can
then print the spreadsheet.

File > Import

You can import projects from other instances of the Profile Editor.
Thesemust be PLS or ICD files.

To begin importing, click File > Import. For ,more information, see
Importing and Exporting Project Files on page 69.

File > Export

You can export a PLS or ICD file to be used in another instance of the
Profile Editor, or to be used as a backup.

To begin exporting, click File > Import. For ,more information, see
Importing and Exporting Project Files on page 69

Settings >Display Advanced Properties Causes additional “advanced information” columns to display.

Settings > Remove Import Templates You can delete any import template that has been added to the project.
To add import templates, seeUsing Import Templates on page 76.

Settings >Set Up Custom Tags Displays the Add/Edit Custom Tags screen. SeeSetting UpCustom
Tags on page 42 for a description of this screen.

Settings >Set Up Device Type Categories Displays the Set Up Device Type Categories. SeeSetting UpDevice
Type Categories on page 39 for a description of this screen.

Settings >Set Up Engineering Unit
Templates

Displays the Set Up Engineering Unit Templates screen. Click Setting
Up Engineering Templates and Selecting Conversions on page 28 for a
description of this screen.

Settings >Set Up Trend Definitions Displays the Set Up Trend Definitions screen. Click Setting Up Trend
Intervals on page 57 for more information.
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Adding Engineering Unit Templates, Units, and Conversions
An engineering unit is a part of a tag. Use engineering unit templates to simplify the
conversion between base units and their conversions (such as inches to centimetres)
and to provide consistency in recording data in reports and on-screen viewing. For
example, in one project you might want to see amperes reported as kiloamps. In
another, you might want to see amperes as milliamps. You will use the Units screens to
determine the conversion for standard units and custom units (tied to custom tags) that
you create.

You can also create templates to organize user-created unit/conversion pairs. Each
template will include all of the predefined engineering units and conversions, as well
as the ones you assign to it. These templates can then be used in system projects (see
the Set Up Project tab for creating projects).

In this section, you can learn about:

Setting Up Engineering Templates and Selecting Conversions on page 28

Adding or Editing a Base Engineering Unit or Conversion on page 30

Setting Up Engineering Templates and Selecting Conversions
Use the Set Up Engineering Unit Templates screen to add, edit, or delete an
engineering unit template, and to begin adding, editing, or deleting templates,
engineering units, and conversions to the system. To view the Set Up Engineering
Units screen, click Settings > Set Up Engineering Unit Templates. The following table
describes the parts of the Set Up Engineering Unit Templates screen (it assumes that
Display ‘Advanced’ Fields is checked). Detailed instructions are after the table.

Field
Name Valid Entries Comments

Options box

Create New Click to begin creating a new engineering unit template.

Create From Click to create an engineering units template that is based on an
existing template.

Edit Existing
Only available if you have added a template.

Click to edit an engineering unit or its conversion.

Delete
Only available if you have added a template.

Click to begin deleting an engineering unit and its conversion. You
cannot delete a locked template.

Unit
Template to
Create
From

From the drop-downmenu,
select the template you wish
to copy, in order to create a
new template.

This field is live only whenCreate From is chosen as the option. The
new template will initially include all of the units/conversions of the
original; but you can add units and change the conversion settings.
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Field
Name Valid Entries Comments

Unit
Template
Name

This field is blank if you
selectedCreate New or
Create From; type the name
of the new template.
A name displays if you have
selected a template to edit;
you can change the name.
A name displays, but it is
greyed out if you selected a
template to delete.
Click Save to save the
changes youmake.

When creating a new template or creating from an existing template,
type the name of the new template.

To change the name of an existing template, choose it from theUnit
Template to Deletemenu, then change the name here.

Lock this
Template

Click to prevent the
template from being edited
in the future.

The only way to “edit” a locked template is to delete it, and add back
a new one with the edits entered.

Display
Associated
Projects

Live only when in “Edit”
mode. Displays all projects
that use this template.

You only need this if you want to delete a template that is associated
with a project. Note the projects that display in the list, then go to the
Set Up Project tab. For each project that you noted, change the unit
template.

Display
‘Advanced’
Fields

Check this box to display
additional columns of
information about the
template.

Unchecked: displays the unit and its abbreviation only. Checked:
displays also the conversion, and its abbreviation andmultiplier.

Selected
Unit n/a

Many standard units are pre-defined; they cannot be edited or
deleted. To add a unit or edit a user-created unit, seeAdding or
Editing a Base Engineering Unit or Conversion on page 30.

Abbreviation n/a
Added for the unit when the base unit was created. To edit a user-
created unit, seeAdding or Editing a Base Engineering Unit or
Conversion on page 30.

Selected
Unit

Click the down arrow to
display and select the
preferred conversion for the
unit.

Many conversions are pre-defined. To add or edit a conversion unit,
seeAdding or Editing a Base Engineering Unit or Conversion on
page 30.

Fahrenheit to Celsius temperature conversions must be handled by
editing Cicode (Citect.ini).

Abbreviation n/a This is abbreviation for the selected unit. When the Selected Unit is
changed, this field changes accordingly.

Multiplier n/a

Added for the unit and for the conversion when the base unit was
created. Pre-defined units/conversions cannot be changed. To edit
a user-created unit, seeAdding or Editing a Base Engineering Unit or
Conversion on page 30.

Add/Edit
Units button

Click to display theAdd/Edit
Units screen.

Use that screen to add units/conversions, or to edit user-created
units/conversions.

Creating or Editing an Engineering Unit Template

To create or edit a template:

1. From the Define Device Type Tags tab, click Settings > Set Up Engineering Unit
Templates.

2. Click Create New or Create From to begin adding a template. Click Edit Existing to
edit a template that you have added.

a. If you are creating a new template, type the name in the Unit Template Name
field.

b. If you are creating from an existing template or editing an existing template,
choose that template from the drop-down list. Type the new of the new template
in the Units Template Name field.
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c. If you are editing an existing template, choose that template from the drop-down
list.

3. Click Save to save a new or edited template, or click Save & Exit to save the
template and close the screen. See the next section, Choosing Conversions, to
change the unit conversions. To add new unit conversions, see Adding or Editing a
Base Engineering Unit or Conversion on page 30.

Selecting Conversions

Use this screen to select unit conversions. To add a conversion, see Adding or Editing
a Base Engineering Unit or Conversion on page 30.

To select a conversion:

1. From the main window of the Profile Editor, click Settings > Set Up Engineering Unit
Templates.

2. Click Edit Existing, then select the template for which you want to select unit
conversions.

3. Locate the first base unit you want to change. In the Selected Unit column, click the
down arrow to select the conversion you want to use. Fahrenheit to Celsius
temperature conversions must be handled by editing Cicode (Citect.ini file).

4. Repeat step 3 for all units that you want to change.

5. Click Save to save the change, or click Save & Exit to save changes and close the
screen.

Deleting a Template

You cannot delete either the Standard Template or a locked template.

To delete a template:

1. From the Define Device Type Tags tab, click Settings > Set Up Engineering Unit
Templates.

2. Click the Delete radio button, on the left, to delete a template.

3. Choose the template from the drop-down list.

4. Click Delete, on the right, to delete the selected template. At the Confirm Delete
prompt. click Yes.

Adding or Editing a Base Engineering Unit or Conversion
Use the Add/Edit Units screen to add, edit, or delete base units and conversion units
for custom tags. You cannot make any changes to predefined units (those that are
greyed out). At the Set Up Engineering Units screen, click Add/Edit Units. The following
table describes the fields of the Add/Edit Units screen. Detailed instructions are after
the table.

Field
Name Valid Entries Comments

Unit
Conversions

n/a for pre-defined
units/conversions (greyed
out)

Select user-created units
to begin edits.

All base engineering units and their conversions display. Greyed-out
items are predefined; they cannot be edited or deleted. Note that
predefined units can have custom conversions, which are editable.

Add Base Click to begin adding a new
base unit. The Base Unit and Base Unit Abbreviation fields become live.
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Field
Name Valid Entries Comments

Add
Conversion

Click to begin adding a
conversion to a base unit.

The Base Unit field displays the unit you highlighted; the Conversion
Unit, Conversion Abbreviation, andMultiplier fields become live.

Edit Unit/

Delete Unit

Click to either edit a
custom unit/conversion, or
to delete it.

These buttons are only live when you select a custom, unlocked,
unit.

Base Unit

When editing a
unit/conversion, select the
unit from this drop-down
menu.

When adding a new base
unit, type the name.

Used in the Profile Editor only; not passed to PowerLogic SCADA
projects for graphics viewing.

Base Unit
Abbreviation

Type the abbreviation for
the selected base unit.

If there is no conversion, this is passed to PowerLogic SCADA for
viewing graphics.

Conversion
Unit

Type the name of the
conversion unit,
e.g.,milliamps, when amps
is the base unit.

Used in the Profile Editor only; not passed to the PowerLogic SCADA
project for graphics viewing.

Conversion
Abbreviation

Type the abbreviation for
the conversion unit.

This is passed to the PowerLogic SCADA project for viewing
graphics.

Multiplier

Use this field to determine
the number of base units
that are in the conversion
unit.

Type themultiplier “M,”
where Conversion Unit x M
=Base Unit.

Example: There are 1,000 bytes in a kilobyte; so, the conversion unit
multiplier is 1000, If you have 17.3 kB,
17.3 x 1,000 =17300 bytes

Adding a Base Engineering Unit and Unit Conversion

To add an engineering unit and/or conversion:

1. Click Add Base.
2. In the Base Unit field, type a unique name for the new unit.

3.  In the Base Unit Abbreviation field, type an abbreviated name.

4. Click Save.

5. To add a conversion, highlight the name of the Unit, then click Add Conversion.

6. Type the name of the Conversion Unit.

7. Type the name of the Conversion Abbreviation.

Editing a Base Engineering Unit or Conversion

Changes are global, for all templates. You cannot change any predefined engineering
units/conversions (greyed out).

To edit a unit or conversion:

1. To edit the unit: With the base unit highlighted, click Edit Unit. You can edit the base
unit and base unit abbreviation. Click OK to save the changes.

2. To edit a conversion: With the conversion highlighted, click Edit Unit. You can edit
the conversion unit, abbreviation, and multiplier. Click Save to save the changes or
click Save & Exit to save the changes and close the screen.

Deleting a Base Engineering Unit or Conversion

Deletions are global, for all templates. You cannot delete units any predefined
units/conversions (greyed out).
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To delete a unit or conversion:

1. To delete a unit: With the base unit highlighted, click Delete Unit. At the Confirm
Delete prompt, click Yes. Click OK to close the screen.

2. To delete a conversion: With the conversion highlighted, click Delete Unit. At the
Confirm Delete prompt, click Yes. Click Save & Exit to save the changes and close
the screen.
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Defining Device Types and Tags
The Define Device Type Tags tab and its related screens are used to define device-
related data: custom tags, device types, and base units/conversions. You will use
several screens to add and manage this data.

To access these screens, click the Define Device Type Tags tab on the main Profile
Editor screen.

In this section, you can learn about:

Device Type Screens and Workflow on page 33

Using the Define Device Type Tags Tab on page 33

Adding, Editing, or Deleting a Device Type on page 35

Printing the .CSV File on page 39

Setting Up Device Type Categories on page 39

Editing Functional Addresses on page 41

Device Type Screens and Workflow
On the Define Device Type Tags tab, follow these general steps to add tags and
devices to your system:

1. To manage the units and unit conversions that you will use (such as amperes into
milliamperes), see Adding or Editing a Base Engineering Unit or Conversion on
page 30.

2. To manage the tags you will use, see Defining Device Types and Tags on page 33.

3. To add and edit custom tags, see Adding Custom Tags and Tag Addresses on
page 42.

4. To add or edit device types, see Adding, Editing, or Deleting a Device Type on
page 35.

5. To establish device type categories and subcategories, used in reporting, see
Printing the .CSV File on page 39.

6. To edit tag addresses, see Editing Tag Addresses on page 46.

The PowerLogic SCADA system uses the IEC61850 tag naming convention. For
information about the types of IEC61850 tags and their configuration, see
Understanding Tags on page 78.

Using the Define Device Type Tags Tab
The Define Device Type Tags tab displays device types and the tags that may be
associated each device type. This includes real-time, onboard alarm, control, and reset
tags. Most of the fields on this tab are read only (they can be changed on other
screens). The following table describes this tab. The tags listed assume that Advanced
Properties has been checked. Not all elements appear on every sub-tab.

Field Name/Valid Entries Comments

Device Type Name/Select the device type.
Each device type includes a different number of tag categories, which
also changes the list of tags that display.
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Field Name/Valid Entries Comments

The device list includes the default device types, as well as any that
have been created for this system.

Add/Edit button/Click to open the Add/Edit
Device Type screen.

Provides ameans of adding new device types and editing custom
device types (user-created device types that are not locked). Also
provides ameans of adding new custom tags and editing existing tags.

Locked/Custom icons:
Locked icon indicates that the list of selected tags cannot be edited.
Custom icon indicates that the device type was created by a user. See
Locked and Custom Icons on page 26 for complete information.

Tag groups (left-hand pane)

Select a tag group; the tags included in that
group display on the right.

Each tag belongs to a group. The group is determined when the device
is added to the system. For custom tags, this is on the Add/Edit
Custom Tags screen. Tags for standard device types are pre-
determined and cannot be changed.)

Note: If a tag group displays in red copy, there is at least one address
that is not valid for the tag to which it is assigned. To correct this issue,
click the tag group, ensure that Display Advanced Properties is
selected, then scroll down through the tags in the right-hand column.
The tags that have invalid addresses will have the “Edit...” displayed in
red. Click this field to open the Edit Address page; correct the errors in
the address.

Tag tabs: Real Time, OnBoard Alarm, Control, and Reset

Click a tab to view the tags of that type that are included for the selected device type.

If the device type is not locked, you can use the Add/Edit Device Type screen to edit the list of tags.

Tag Description (all tag types)/Display only
This is the tag name, hard-coded for standard tags. For custom tags:
The name is from the Tag Name field in the Add/Edit Custom Tags
screen.

Units/Display only Lists the abbreviation, added when creating the engineering unit
template.

IEC Tag Name/Display only Tag name that conforms to IEC61850 standard. SeeUnderstanding
Tags on page 78 for more information.

Type (Real Time only)/Display only Displays the data type chosen when the tag was created.

Address (not Control tags)/

To edit, click the Edit Address link.

Displays the address information for this tag, including elements such
as type of register, number of registers, and scaling and bitmasking
data. Understanding Tags on page 78 for a detailed description of
address construction.

Normally Closed (Control tags only)/

Check the box to invert the functionality of
the control. See description.

For a control with one command, writing a 1 to the tag will cause the
command to occur. (This option is greyed out.)

For a control with two commands that is either static or normally open,
writing a 1 to the tag will cause the first command to occur; writing a 0
will cause the second to occur. (Checkbox not checked.)

For a control with two commands that is normally closed, writing a 1 to
the tag will cause the second command to occur; writing a 0 will cause
the first command to occur. (Checkbox checked.)

Edit Addr/Click to display Edit Address
screen. (Real Time andOnboard Alarm only)

Provides themeans of changing the elements of an unlocked real-time
tag address (for example, the number of registers, their numbers, and
whether they are consecutive).

SeeEditing Tag Addresses on page 46. for detailed information.

Register 1/Display only (Real Time tags
only)

This field contains first register used to store this tag. If there are
additional registers, they are indicated in the address. The total number
of registers is listed in the Num Registers column. This field allows you
to verify and/or change the value of Register 1 without having to open
the Edit Address screen. Note: If you enter a number that is not
compatible with other address

settings, you are prompted to go to the Edit Address screen.
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Field Name/Valid Entries Comments

Num Registers/Display only (Real Time tags
only) Displays the number of registers used by this tag.

Formatting/Select the format type from the
drop-down list (Real Time tags only)

After you change formatting for a tag andmove the cursor to another
field, you are asked whether you want to open the Address Editor. If
you click No, the format is unchanged; if you click Yes, the Edit
Address screen opens for you to enter the appropriate changes for this
tag. SeeEditing Tag Addresses on page 46.

Scaling Register/View or enter the register
number (Real Time tags only)

This is entered in the Edit Address screen, but it can be edited here. It is
the register used to read the value for scaling. Note: If you enter a
number that is not compatible with other address settings, you are
prompted to go to the Edit Address screen.

Functional Address/Display only (Real Time,
Onboard Alarm, Control, and Reset tags)

If you have added a functional address for this tag, it displays here. To
add or edit this address, use the Edit Functional Address field.

Note: Functional addressing is described inAppendix 4: Glossary on
page 196.

Edit Functional Address/Add the code for the
address

Typically used for data concentrators, the functional address is a
means of entering the individual data points needed to definemultiple
addresses. Entered as a formula (must be in C#), it will contain the
variables the user must enter when the block is instantiated by the
ProfileWizard.

A simple example:

Address =

"T:MV;m:" + (startingpoint + 1005).ToString() + ";L:P:22"

You would then define "startingpoint" when instantiatiing the profile in
the ProfileWizard.

Tag ID/Display only/Display only Assigned by the system when the tag was created. If this is a custom
tag, it will be a negative number.

Category Type (real-time only)

Utility Type (real-time only)

Statistical Type (real-time only)

Quantity (real-time only)

Each of these types is a real-time filter, added when the tag was
created. SeeSetting UpCustom Tags on page 42 for more information.

Categorization (onboard alarm only)

Subcaategorization (onboard alarm only)

Alarm Type (onboard alarm only)

Alarm Group (onboard alarm only)

Alarm Level (onboard alarm only)

Each of these is an onboard alarm folder, added when the tag was
created. SeeSetting UpCustom Tags on page 42 for more information.

Adding, Editing, or Deleting a Device Type
Use the Add/Edit Device Type screen to begin adding, editing, or deleting a device
type from the system. To view this screen, click Add/Edit, to the right of the Device Type
Name field. The following table describes the parts of the Add/Edit Device Type screen.
Detailed instructions are after the table.

Field Name Valid Entries Comments

Create New Click to begin adding a new device type that is not based on an
existing type.

Create From Click to make a copy of any existing device type.

Edit Existing Click to edit an unlocked device type.
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Field Name Valid Entries Comments

Delete Existing Click to delete an unlocked device type that is not associated with
a profile.

Device Type (to Create
From/to Edit/ to Delete) select type Select the device type that you want to create from, edit, or

delete.

Copy Addressing

Active only when you choose Create From. Check this box if you
want to copy the addressing of the “from” device. This gives each
tag in the new device type the same address string as the
matching tag in the “from” device.

Device Type Name

Type or select
the name:

maximum 32
characters,

do not use \ / : *
? < > |

If creating a device type, type the name. If editing an existing
device type, the device type that was selected for editing displays
here. You can overwrite the name here to change it.

Lock this Device Type

Check to lock
device, so that it
cannot be
edited.

Once locked, you cannot edit a device type. If it is a standard, you
cannot edit or delete it. If you added the device type, you can
delete it, but not edit it.

Device Category
Choose the
category for this
device.

To create categories, seePrinting the .CSV File on page 39.
Categories are used in the Device CreationWizard.

Subcategory

Choose the
subcategory for
this device, if
needed.

As with categories, subcategories are created in thePrinting the
.CSV File screen.

Driver
Select the driver
for the device
type.

Predefined drivers have been created for all PowerLogic
compatible devices, though youmay need to use these drivers for
multiple device types. For example, you would use the CM4000
driver for a CM3000.

Use the Generic Power Device driver for third-party devices. The
Controllable Device driver is currently not used..

Display Associated Profiles

(Active only in
Edit mode)

Click to display a
list of profiles
that are
associated with
the selected
device type.

This list is ant when you want to delete a device type that is
associated with a profile. In Edit mode, select the device type you
want to delete; then note the profile(s) associated with the device
type.

Before you can delete the device type, go to the Add/Edit Device
Profile screen, locate each profile in the list. You cannot save an
empty profile. so youmust either select another device type for it
or delete the profile. Then you can delete the device type.

IEC Tags n/a

This list includes all tags that have been added to the system,
standard tags as well as custom tags that you have added. Tags
are listed in their groups (100ms, Onboard Alarm, Power Factors,
etc.).

Selected Tags

Select tags from
Tags; click the
right arrow to
move them to
this box.

You canmove single tags or entire tag groups. They must be
moved one at a time (cannot shift+click to select).

Note: You cannot deselect tags for a device type if that device is
associated with a device profile.

Add/Edit Custom Tags
Click to begin
adding a custom
tag.

Live when creating or editing a tag. Opens the Add/Edit Custom
Tags screen. SeeAdding Custom Tags and Tag Addresses on
page 42 for instructions.

If you add a custom tag here, you are prompted to save the
device type. After adding the tag, you have the option of adding
that tag to the device type.

Adding a Device Type

To add a device type:
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1. From the Define Device Type Tags tab, click Add/Edit.
2. In the Device Type Options box, click Create New or Create From.

If you are creating from another device type, choose it from the Device Type to
Create From drop-down list.

If you are creating from another device type, and you want to use the same
addressing, check Copy Addressing.

3. Type a Device Type Name for the new device type; maximum 32 characters.
Do not use \ / : * ? < > |

4. If you want to lock the device, preventing anyone from editing it, check Lock this
Device Type. This action cannot be undone. If you wish to edit a locked device, you
must use the Create From feature to add a new one, then delete the locked one.

5. From the Device Category drop-down list, choose the category to which this device
belongs. In addition to predefined categories, you can add custom categories. See
Setting Up Device Type Categories on page 39 for instructions. Categories are
used in the Device Creation wizard, and are a means of shortening the list of
devices you must view.

6. From the Subcategory drop-down list, choose a subcategory. As with categories,
subcategories are added in the Set Up Device Type Categories screen.

7. From the Driver drop-down list, choose the correct drivers for this device type.
Drivers have been added for all of the standard, PowerLogic-compatible, devices.

8. The Display Associated Profiles link displays a list of profiles to which a device type
has been added. You will use this link only when you want to delete a device type
that has been added to a profile.

A device type that is associated with a profile will not display in the “Delete Existing”
mode. So, to view associated devices, you need to switch to “Edit Existing” mode
and display the device type you want to delete; then click this link. You will see a list
of all profiles to which this device type has been added. Note all of the profiles.
Then, do the following:

Open the Create Device Profiles tab, choose the appropriate device profile, and
click Add/Edit.

Editing a Device Type

You cannot edit any locked device type. When a device type is locked, the locked icon
displays on the Define Device Type Tags tab:

If you want an edited version of a locked device type, you must create a new device
type from it and then delete the original device type. Certain “standard” device types
can be used to create new types, but they cannot be deleted. Examples: Circuit Monitor
4000, Power Meter 800, and Sepam S42.

There are two ways to edit device types:
• From the Define Device Type Tags tab, select a device type; make these changes:

Edit the functional address (see Editing Functional Addresses on page 41).

Real Time Tags sub-tab: you can edit the address (see Editing Tag Addresses on
page 46) and choose a different format.
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• From the Define Device Type Tags tab, select the device type you want to edit, then
click Add/Edit. Follow through the screens to edit additional information:

In the Device Type Options box, click Edit Existing.

Click the Device Type to Edit list to display the Select Device box. Select the device
type that you want to edit.

You can change the device type name, category, subcategory, and driver. You can
also lock the device.

Select tags and tag groups and move them into or out of the Selected Tags list.

If a device type is associated with a device profile, you cannot deselect tags.

After all of the appropriate changes are made, click Save to save your current
settings.

To create additional custom tags, click Add/Edit Custom Tags; otherwise, click Save
& Exit to save your settings and close the window.

If you add a tag to a group that is already included in a device type, you must then
individually add the tag to that device type.

Deleting a Device Type

You cannot delete any standard device type or any custom device type that is
associated with a device profile; those device types do not display in this option.

To view a list of profiles associated with a device type, switch to the Edit Existing view,
then select the device type you want to delete. Click List Profiles associated with this
Device Type to display all associated profiles. Before you can delete the device type,
return to the Add/Edit Device Profile screen for each profile in the list; either select a
new device type for the profile or delete the profile entirely.

To delete a device type:

1. From the Define Device Type Tags tab, click Add/Edit.
2. In the Device Type Options box, click Delete.

3. From the drop-down list, select the device type you want to delete (the list includes
only unlocked or custom device types; you cannot delete any of the “standard”
device types or custom device types that are associated with a profile.

4. Click Delete. At the Confirm prompt, click Yes.

Assigning Tags to Generic I/O Points

Device types have default tags that have the appropriate formatting and addressing
assigned for all the generic I/O points. It may be necessary to redefine a generic I/O
point by assigning it to a tag that has a specific meaning.

Example 1: The Branch Circuit Monitor 42 has been configured to read 42 current
channels. To assign channel 1 to Current A, follow these steps:

1. From the Branch Circuit Monitor 42 device type, choose the “Ch.01 Current tag.”
2. Note the addressing and formatting for the tag.

3. Locate and add the standard tag that you want to assign to this channel. In the
example above, you would add “Current A.”

4. Edit the address of the Current A tag to match the address of Channel 1.

Example 2: If the Sepam I11 / I12 have been configured to represent circuit breaker
position, you may choose to redefine the tag name. Follow these steps:
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1. From the Sepam 40 Series device type, choose tags “Input Status I11” / “Input
Status I12.”

2. Note the addressing and formatting for each tag.

3. Locate and add the standard tag that you want to assign to these I/’O points. In the
example above, you would add “Device Closed.”

4. Edit the address of the Device Closed tag. In order to create the “device closed”
functionality, you must combine inputs 11 and 12 into an enumerated status
(choose the Enumerated Status logic code for the indicated address for I11 and
I12),

Printing the .CSV File
For each device type, device profile, or project, you can create a .CSV file that includes
the following data:

Type of File Data Included

Device Type tag descriptions, IEC tag names, type, and address

Device Profile tag descriptions, IEC tag names

Project data profiles and custom tag names included in the project

Follow these steps to create the CSV file:

1. Display the device type, profile, or project for which you want the file. For example,
to create a CSV file for the Sepam 42 Full device profile, select the Create Device
Profiles tab and choose Sepam S42 Full from the drop-down list.

2. Click File > Create CSV File.

3. From the Save As window, choose a location for the file and rename it, if you wish.
Click Save.

4. The file is created in the location you specified.

5. For viewing and printing, open the file in Microsoft Excel.

Setting Up Device Type Categories
Use the Set Up Device Type Categories screen to add, edit, and delete categories.
These categories are used in the Profile Wizard to logically group the list of profiles that
display, and to make them easier to locate.

When you add device types in the Add/Edit Device Type screen, you associate a
category and subcategory with each device.

To view the Set Up Device Type Categories screen, click Settings > Set Up Device
Type Categories.

The following table describes the parts of this screen. Detailed instructions are after the
table.
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Field Name Valid Entries Comments

Categories
Options box

Create New Click to begin adding a new device type that is not based on an
existing type.

Edit Existing Click to begin editing the category or subcategory name.

Delete Existing Click to begin deleting a category. You cannot delete a category
that is associated with a device type.

Category Name

If new: Type the name.

If editing or deleting, select the name from the drop-downmenu.

Predefined categories do not display. Currently, there is one
predefined category: Schneider Electric.

Subcategories
Options box.

As with categories, you can
create new, edit existing, or
delete.

If new: Type the name.

If editing or deleting, select the name from the drop-downmenu.

You cannot delete a subcategory that is associated with a device
type.

Predefined subcategories do not display. Currently, the
predefined subcategories are: Protection Device, Monitoring
Device, and PLC.

Adding a Category or Subcategory

To add a category/subcategory:

1. Click Create New in the appropriate box (Categories or Subcategories).
2. In the Name field, type the name of the new category or subcategory.

3. Click OK to save the new entry and close the screen.

Editing a Category/Subcategory Name

To change the name of a category or subcategory:

1. From the appropriate box, click Edit Existing.
2. From the dropdown menu, select the category or subcategory that you want to edit.

3. Type the new name for this category or subcategory.

4. Click Save to make the change, or click Save & Exit to save changes and close the
screen.

Deleting a Category or Subcategory

Predefined categories/subcategories, or those associated with a device type, do not
display for deletion. To delete a device type associated with a category/subcategory,
change to the “Edit” view, select the category or subcategory, then click the List Device
Types... button. Note the device types and go to the Add/Edit Device Types screen.
Change the category/subcategory on that page. Then you can return to the Set Up
Device Type Categories screen to delete the category/subcategory.

To delete a category or subcategory:

1. From the appropriate box, click Delete Existing.
2. From the dropdown menu, select the category or subcategory that you want to

delete.

3. Click Delete.

4. At the Confirm prompt, click Yes.
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5. Click Save to save the change, or click Save & Exit to save changes and close the
screen.

Editing Functional Addresses
If you want to add variables to addressing, use this feature. You can re-use these
variables by copying/pasting parts of it into other addresses, then making changes to
the code for use in other tags. You will be prompted for these variables in the Profile
Wizard.

To access the Edit Functional Address screen, click the Edit Functional Address button
for a real time tag, onboard alarm tag, control tag, or reset tag. The fields on this screen
are used in this way:
1. Tag Name and Original Address: These fields display from the tag you selected;

you cannot edit this information.

2. Device Variables: Click New to begin adding new variable properties. The
following fields become live:

a. Name This name must be in format %NNN%, where NNN includes only letters
or underscores.

b. Description: This required field is free-form. It displays in the Profile Wizard and
will help you ensure that you have the correct information entered.

c. Regular Expression: You can use one of the pre-defined expressions, or you
can create your own

d. Test Value: This will become the default in Citect; use it here for testing the new
address.

e. Help: Use this optional field to add more definition to this address. It displays in
the Profile Wizard.

3. Code Body: Enter the code in C# to define the action you want to take place.

4. Return: Type the return statement that you want from C# code. It might look like:

string.Format("SomeString{0}SomeOtherString", someVariable)
5. Result: Click Test in the lower right corner of the screen. If there is a compile error,

check your C# code. Otherwise, the result displays. Verify that it is what you
wanted.
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Adding Custom Tags and Tag Addresses
PowerLogic SCADA comes with most of the tags that are needed for each device type.
However, you can create custom tags to assign to device types and device profiles.
You can also edit address attributes for any tag.

NOTE: To avoid potential communication errors, you should use the Profile Editor to
create all custom tags that will communicate with equipment.

In this section, you can learn about:

Setting Up Custom Tags

Editing Tag Addresses on page 46

Editing Tag Addresses

Setting Up Custom Tags
Use the Add/Edit Custom Tags screen to edit the information about a custom tag. To
view this screen, click Add/Edit Custom Tags at the bottom of the Add/Edit Device Type
screen; or, from the upper left of the Profile Editor screen, click Settings > Set Up
Custom Tags. Detailed instructions are after the table.

Field Name Valid Entries Comments

Custom TagOptions

Create New Click to begin adding a new tag.

Create From
Click to begin adding a new tag that is based on an existing
custom tag. For example, youmight want to change
metadata for another custom tag.

Edit Existing Click to edit the attributes of an existing tag.

Delete Existing Click to delete a tag (tag cannot be associated with a device
type).

Tag to Create From

Tag to Edit

Tag to Delete

From the drop-downmenu, select the tag you want to create
from, edit or delete.

Delete button
Live only when Delete Existing is selected. Click to delete
the tag. You can only delete custom tags not associated with
a device type.

Display Associated
Device Types

Click to display device
types that are
associated with this
tag.

Live only when in Edit mode. Click to list device types that
are associated with this custom tag. Note the device types
so that you can delete the tag from them (in the Add/Edit
 Device Type screen) before you delete the tag.
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Field Name Valid Entries Comments

Tag Name

Type the new tag
name; or type the
changed name for a
tag you are editing.

Maximum 32 characters; can include any alpha or numeric
character, as well underscore (_) and backslash (\). Must
begin with either an alpha character of underscore.

Display Name

Type the name that
you want to display
when selecting the tag
and in other displays.

Youmight use this field for additional information on the
Add/Edit Custom Tags screen. For example, you could
describe the data that it logs. It does not display anywhere
else in the system.

Group Select the group. Includes all of the real-time groups (100ms, controls,
currents, etc.) plus onboard alarms, resets, and controls.

Data Type Select the data type.

These are PowerLogic SCADA tag data types. They affect
the logic codes that are available for display in the Edit
Address screen. See Logic Codes on page 83 for the data
type that matches each logic code.

Eng. Units Select the base unit. These are the base engineering units for tags, from
Engineering Unit Setup.

Ignore Unit Conversion

Check to cause the
system to ignore any
conversions that were
added for this tag.

Causes reporting to be according to the base unit, rather than
the conversion that was chosen for this tag in the template
that is being used.

Add Eng Unit

Click to open the
Add/Edit Units screen,
to add a new
engineering unit and/or
conversion.

Provides a quicker means of adding an engineering unit that
had been overlooked.

Citect Format Select the numerical
format.

This is used in for display purposes in PowerLogic SCADA
graphics pages. It determines where the decimal displays.
For example, if you select #.##, the number 8.12579 would
be displayed as 8.12.

Polling Priority Low, Normal, or High

Indicates the level of priority PowerLogic SCADA uses when
reading data from devices.

Note: In the address field, a priority of 1 =High, 2 =Medium,
3 = Low.

Alarm On Text
For onboard alarms
only: enter the text for
when the alarm is On.

This text displays on the Create Device Profiles tab for the
onboard alarm tag, when it is selected for the device type in
the profile. It also displays in the Alarm Log.

Alarm Off Text
For onboard alarms
only: enter the text for
when the alarm is Off.

Display ‘Advanced’ filter
selections

Check to display
additional filter options
in the Real Time Filter
and Alarm Filter tabs

Displays several additional filter options on the two “Filter”
tabs. These options will be useful in the future for reporting
purposes.

You can include additional filters for either real time filters or alarm filters. Though not
currently used, these filters will provide metadata for later reporting. Standard tags have
some of these filters selected.

A typical usage for these filters might be: when creating a custom tag from an already
existing standard tag, you can create matching metadata by using the filters that have
been built in to the standard tag.

Real Time Filters tab (list is expanded when “Display ‘Advanced’ filter selections” is checked)

Category Type Select a category for
this tag.

This field provides metadata about the tag. It will be used in
future reports.

Utility Type Select a utility type. Metadata for future use in reporting.

Statistical Type Select a statistical
type. Metadata for future use in statistical reporting.

Quantity Select a quantity. Metadata for future use in statistical reporting.
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Field Name Valid Entries Comments

Alarm Filters tab (list is expanded when “Display ‘Advanced’ filter selections” is checked)

Categorization Select the alarm
category

Used for filtering and sorting alarm data. Alsometadata for
future use in statistical reporting.

Alarm Type Select the alarm type. Used for filtering and sorting alarm data. Alsometadata for
future use in statistical reporting.

Alarm Group Select the group. Used for filtering and sorting alarm data. Alsometadata for
future use in statistical reporting.

Subcategorization Select a subcategory. Used for filtering and sorting alarm data. Alsometadata for
future use in statistical reporting.

Alarm Level Select the severity
level of the alarm.

Used for filtering and sorting alarm data. Alsometadata for
future use in statistical reporting.

Adding a Custom Tag

Follow these steps to create a custom tag that is not already used by PowerLogic
compatible devices; for example, to create a tag for a third-party device.

To add a tag:

1. Open the Add/Edit Custom Tags screen (from the Add/Edit Device Type screen,
click Add/Edit Custom Tags).

2. In the Custom Tag Options box, click Create New or Create From.

If you are creating from custom another tag, choose it from the Tag to Create From
drop-down list.

3. Display Associated Device Types: Live only when in Edit mode. Click to list device
types that are associated with this custom tag. Note the device types so that you
can delete the tag from them (in the Add/Edit Device Type screen) before you
delete the tag. See Deleting a Custom Tag on page 45 for instructions on using this
button.

4. Tag Name: Type a descriptive name for the new tag (see table above for
limitations).

5. Display Name; Type the name you want to use when selecting the tag from lists, or
for seeing it in displays.

6. Group drop-down menu: Choose the group to which you are adding this tag. IEC
tags are organized into these groups. There are multiple groups for real-time tags,
and one group each for onboard alarms, controls, and resets.

7. Data Type drop-down menu: Choose the PowerLogic SCADA data type that
matches the logic code for this tag. See Logic Codes on page 83 for a list of all
logic codes with references to the correct data types.

8. Eng. Units drop-down menu: Choose the unit of measurement used for this tag.
These are the base units set up in the Units screens.

9. Ignore Unit Conversion: To report on the base unit for this tag, rather than the unit
conversion that has been added in the template you are using, check this box. All
reporting will use the base unit for the tag.

10.Add Eng. Unit: To add a unit that is not in the list, click this button.

11.Citect Format: Choose the reporting format, to be used in Citect, from ## to
#0.#####.

12.Polling Priority drop-down menu: Choose the priority that PowerLogic SCADA will
use when reading data from devices: high, normal, or low. In the address field, a
priority of 1 = High, 2 = Normal, 3 = Low.
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Real-Time Filters: (list is expanded when Display ‘Advanced’ Filter Selections is
checked)
13.Category Type drop-down menu: Choose the category or N/A. Category type

populates Custom 2.

14.Utility Type drop-down menu: Choose the type of utility or N/A. Utility type populates
Custom 4.

15.Statistical Type drop-down menu: Choose the statistical type or N/A. Statistical type
populates Custom 5.

16.Quantity drop-down menu: Choose a quantity or N/A. Quantities populates Custom
6.

Alarm Filters: (list is expanded when Display ‘Advanced’ Filter Selections is checked)
17.Categorization Type drop-down menu: Choose the type or N/A. This data is

currently used for filtering and sorting alarm data in PowerLogic SCADA. Category
type populates Custom 3. Metadata will be used in future reporting.

18.Alarm Type drop-down menu: Choose an alarm type or N/A. This data is currently
used for filtering and sorting alarm data in PowerLogic SCADA. Alarm type
populates Custom 4. Metadata will be used in future reporting.

19.Alarm Group drop-down menu: Choose a group or N/A. This data is currently used
for filtering and sorting alarm data in PowerLogic SCADA. Alarm group populates
Custom 5. Metadata will be used in future reporting.

20.Subcategorization drop-down menu: Choose a subcategory or N/A. This data is
currently used for filtering and sorting alarm data in PowerLogic SCADA.
Subcategorization populates Custom 6. Metadata will be used in future reporting.

21.Alarm Level drop-down menu: Choose the severity level of the alarm. This data is
currently used for filtering and sorting alarm data in PowerLogic SCADA. Alarm
level populates Custom 7. Metadata will be used in future reporting. This default
can be overridden when you are editing the device profile (see Adding, Editing, or
Deleting a Project on page 66)

22.Click Save to save changes, or click Save & Exit to save changes and close the
screen.

23. If you are adding the tag from with the Add/Edit Device Type window, the Select
Tag screen displays. Click Yes if you want to add this tag to the currently selected
device type; click No to not add it.

Editing a Custom Tag

You can edit any custom tag. To edit a tag:

1. Open the Add/Edit Custom Tags screen (from the Add/Edit Device Type screen,
click Add/Edit Custom Tags).

2. In the Custom Tag Options box, click Edit Existing.

3. You can change any of the tag attributes. (This does not change the tag’s
assignment status; if it is selected for a device type, it does not move back to the
IEC Tags list.)

4. Click Save to save changes, or click Save & Exit to save changes and close the
screen.

Deleting a Custom Tag

You can delete any custom tag that is not associated with a device type.

If the tag is associated with a device type, you must first deselect the tag:
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1. Change the option to Edit Existing and display the tag you want to delete.
2. Click Display Associated Device Types to display all device types that include this

tag. Make a note of the device types.

3. Return to the Add/Edit Device Type screen. For each device type listed, deselect
the tag that you want to delete.

Continue deleting the tag:

1. Open the Add/Edit Custom Tags screen.
2. In the Custom Tag Options box, click Delete Existing.

3. From the drop-down menu, choose the tag you want to delete.

4. Click Delete. At the Confirm prompt, click Yes.

5. Click Save to save the change, or click Save & Exit to save changes and close the
screen.

Editing Tag Addresses
Use the Edit Address screen to edit the attributes of a single tag address. If a device
type is locked, you cannot edit any of its tag addresses; they will be greyed out. A
thorough discussion of IEC61850 tags and their construction is included in
Understanding Tags on page 78 and Logic Codes on page 83.

NOTE: Case and order are critical in the tag address. Be careful to observe the exact
address order. For address order, see Logic Codes on page 83. Also, be sure you use
the correct case. For example, use M for register numbers in hexadecimal, and use m
for register numbers in decimal.

To view the Edit Address screen, open the Define Device Type Tags tab, choose the
device type, then click the Edit... field for the tag that you want to change. The Edit
Address screen is different for real-time and alarm tags. Each type of tag (real-time,
onboard alarm, reset, and control) is described separately in the following tables.

Real-Time Tag Addresses

The following table describes the fields of the Edit Address screen for real-time tags.
Detailed instructions are after the table.

Field Name Entry Comments

Data Type For display only You can edit this field in the Add/Edit Custom Tags screen.

Priority
High, Normal, or Low

Logic Code:
You can edit this field either here or in the Add/Edit Tag screen.

Logic Code Select the logic code for this
tag.

The logic code list depends on the Data Type for this tag. For
more information about logic codes, see Logic Codes on page
83.

Display
Registers in: hexadecimal/decimal Click the radio button for the way you want to view register

information.

Module Select module Choose the type of module in which the tag is used. Used for
Micrologic at this time.

Register Type Select register type Select the type of register that is to be written or read.

Number of
Registers

Select the total number of
registers for this address (1-
10).

Is Consecutive, check if the
registers are to be
consecutive (determined in
the logic code).

Enables for editing the appropriate registers in the lines below.
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Field Name Entry Comments

Fixed
Scale/Register
Scale

Click the radio button for the
correct type of scale.

A fixed scale is the actual value. of the scale. A register scale is
the register address where the scale is held.

The value will be scaled in this manner: Value x 10x

where X = the scale.

Scales can only be –10 to 10.

Conversion
Factor

Enter themultiplier to convert
the base units to the desired
conversion.

Conversion factors are used for straight multiplication with the
value. The conversion factor could also be changed in the
Add/Edit Units screen (Settings >Select Units >Add/Edit Units.

Conversion factors take this form:

####E##. For example,

123E-2 becomes 123x10-2

which becomes 1.23.

Offset y = ,x + b

y = the final value reported by PLSCADA
b = the offset
m = the conversion factor
x = the original value in themeter
b = rarely used, mainly in temperature conversion

The offset is added to the final value (after the conversion factor
is applied).

Register 1-4 Enter the register number. Be aware of whether you chose hexadecimal or decimal. Use the
same format here.

Bitmask for
Register 1-4

For digital input/output tags:
Set the bits to 1 or 0 tomatch
the pattern for “True” in the
device register.

When all bits match exactly the pattern in the register, the status
is True. When any one bit does not match the pattern in the
register, the status is False.

Note: On PM8s and CM4s, there is a device-specific format,
DIgIn and DigOut. In each case, youmust first specify the
indicator register (which becomes the first register). The second
register will have themask.

Invert Result Check this box to invert. Will turn False to True or vice versa; typically used for Normally
Open or Normally Closed.

Onboard Alarm Tag Addresses

The following table describes the fields of the Edit Address screen for onboard alarm
tags. Detailed instructions are after the table

Field Name Entry Comments

Tag Name For display only This is the tag name, which cannot be changed.

File Number Select the number. This is the file number for the alarm file on the device.(Sepam
has no file number; enter 0.)

Module Select themodule. Choose the type of module in which the tag is used. Used for
Micrologic at this time.

Unique ID Choose the identifier.

This unique identifier must be used to ensure that alarms will
annunciate correctly. For CM4, PM8, andMicrologic, the unique
ID must be decimal. For Sepam, the unique ID is the coil bit
address that indicates the alarm; it must be in hexadecimal.

Hexadecimal check box Check this box if you want to display the ID in hexadecimal,
rather than decimal.

Has Unique
Sub ID check box Check if this tag has a unique sub-identifier (Micrologic,

CM4000, and PM800 devices).

Unique Sub ID Enter the Sub ID. Enter the unique sub-identifier. Active only if Unique Sub ID box
is checked.

Reset Tag Addresses

NOTE: Once the tag is set up, writing a 1 to the tag will cause the “write” to occur.
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Standard device types include some pre-defined resets. These pre-defined commands
cause proprietary functions within the device. Do not edit these commands.

To add a custom reset that will operate by writing to a register, do the following:

1. From the Add/Edit Custom Tags screen, set the Group to Resets and the Data Type
as Digital. Save the tag.

2. Add the new tag(s) to the appropriate device type(s).

3. From the Define Device Type Tags tab, locate the tag and click Edit.

The following table describes the fields of the Edit Address screen for reset tags.
Detailed instructions are after the table.

Box Name Field Name Comments

Tag
Information

Command Type
The Command Type and Command to Edit are already selected.

Command to Edit

Data
Information
box

Data Type: for display only You can edit this field in the Add/Edit Custom Tags screen.

Priority: High (default) Cannot be edited.

Logic Code: Select the logic
code for this tag.

Choose the appropriate logic code for this tag. See Logic Codes
on page 83.

Device
Information
box

Display Registers in:
hexadecimal/decimal

Click the radio button for the way you want to view register
information.

Module Choose the type of module in which the tag is used. Used for
Micrologic at this time.

Register Type Select the type of register that is to be written or read.

Number of
Registers

There is only one register for
this address. Enables for editing the appropriate registers in the lines below.

Fixed
Scale/Register
Scale

n/a Not used for digital logic codes.

Conversion
Factor n/a Not used for digital logic codes.

Register 1 Enter the register number. Be aware of whether you chose hexadecimal or decimal. Use the
same format here.

Bitmask for
Register 1

For digital input/output tags:
Set the bits to 1 or 0 tomatch
the pattern for “True” in the
device register.

When all bits match exactly the pattern in the register, the status
is True. When any one bit does not match the pattern in the
register, the status is False.

Note: On PM8s and CM4s, there is a device-specific forma,
DIgIn and DigOut. In each case, youmust first specific the
indicator register (which becomes the first register). The second
register will have themask.

Invert Result n/a Not used for resets.

Control Tag Addresses

NOTE: For a control with one command, once the tag is set up, writing a 1 to the tag will
cause the “write” to occur. For a control with two commands that is either static or
normally open, writing a 1 to the tag will cause the first command (ON) to occur; writing
a 0 will cause the second (OFF) to occur. For a control with two commands that is
normally closed, writing a 1 to the tag will cause the second command (OFF) to occur;
writing a 0 will cause the first command (ON) to occur.

Standard device types include some pre-defined controls. For example, Operate
(ENERGIZE). These pre-defined commands cause proprietary functions within the
device. Do not edit these commands.

To add a custom control that will operate by writing to a register, do the following:
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1. From the Add/Edit Custom Tags screen, set the Group to Controls and the Data
Type as Digital. Save the tag.

2. Add the new tag(s) to the appropriate device type(s).

3. From the Define Device Type Tags tab, locate the tag and click Edit.

The following table describes the fields of the Edit Address screen for control tags.

Box Name Field Name Comments

Tag
Information

Command Type

For commands that have an opposite (such as On andOff),
choose Normally Open/Normally Closed or Static with Off
Command. For commands with only one action, choose Static
without Off Command.

Command to Edit If you are editing a command with two parts, use the Command
to Edit drop-downmenu to select the OnCommand.

Data
Information
box

Data Type: for display only You can edit this field in the Add/Edit Custom Tags screen.

Logic Code: Select the logic
code for this tag.

Choose the appropriate logic code for this tag. See Logic Codes
on page 83.

Device
Information
box

Display Registers in:
hexadecimal/decimal

Click the radio button for the way you want to view register
information.

Module Choose the type of module in which the tag is used. Used for
Micrologic at this time.

Register Type Select the type of register that is to be written or read.

Number of
Registers (1) n/a Enables for editing the appropriate registers in the lines below.

Fixed
Scale/Register
Scale

Click the radio button for the
correct type of scale.

A fixed scale is the actual value. of the scale. A register scale is
the register address where the scale is held.

The value will be scaled in this manner: Value x 10x

where X = the scale.

Scales can only be –10 to 10.

Conversion
Factor n/a Not used for digital controls.

Register 1 Enter the register number. Be aware of whether you chose hexadecimal or decimal. Use the
same format here.

Bitmask for
Register 1

For digital input/output tags:
Set the bits to 1 or 0 tomatch
the pattern for “True” in the
device register.

When all bits match exactly the pattern in the register, the status
is True. When any one bit does not match the pattern in the
register, the status is False.

Note: On PM8s and CM4s, there is a device-specific forma,
DIgIn and DigOut. In each case, youmust first specific the
indicator register (which becomes the first register). The second
register will have themask.

Invert Result n/a Not used for digital controls.

Editing Address Information

To edit address information for a real-time tag:

1. From the Define Device Type Tags tab, choose a device type (cannot be locked).
From the Real Time Tags sub-tab, highlight the tag whose address you want to edit.

2. In the Edit Address column, click “Edit” for the address you want to edit.

The Edit Address screen displays.
3. You can change any of the tag address attributes. See the preceding table for

descriptions of each field.

4. Click OK to save changes and close the screen.
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Adding a New Tag Address

You can also add a tag address, when none exists. As with editing addresses, click the
Edit Address column for a tag; then follow instructions in the table above.

Editing Tag Addresses, Generic
This screen displays when you click Edit for an address of a non-PowerLogic
compatible device type, such IEC 61850 or DNP3.

The variable tag properties used in this screen are described in a topic in the Citect
help file. See Variable Tag Properties for detailed information.

50 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 The Profile Editor
06/2011

citectscada.chm::/Variable_Tag_Properties.html
citectscada.chm::/Variable_Tag_Properties.html
citectscada.chm::/Variable_Tag_Properties.html


The Profile Editor 63220-100-200E1
06/2011

Creating Device Profiles
Use the Create Device Profiles screens to view and edit profiles for individual devices.
Profiles are predefined for the standard devices; you will mostly use this feature to add
third-party device profiles. Before you create profiles, you need to be sure that all of the
tags and device types that you need are created (see Defining Device Types and Tags
on page 33). Also make sure that you have added any new units/conversions and
device type categories/subcategories that are needed.

In this section, you can learn about:

Enabling Waveforms on page 51

Viewing Device Profiles on page 51

Adding, Editing, or Deleting a Device Profile on page 52

Selecting Trend Intervals on page 56

Setting Up Trend Intervals on page 57

Editing IEC 61850 Datasets on page 57

Editing IEC 61850 Report Control Blocks on page 58

IEC 61850 System Setup Workflow on page 17

Creating a Composite Device Type on page 60

G3200 Device Setup on page 62

IEC 60870-5-104 Protocol Support on page 63

DNP3 Protocol Support on page 63

Enabling Waveforms
On the Create Device Profiles tab, in the Onboard Alarm Tags sub-tab, there is a
Waveform checkbox. Check the box for each alarm tag for which you want to be able to
view waveforms. On the device, the alarm must also be set up for the waveform to be
captured on event and stored in one of the device’s data logs.

To acquire waveforms for Sepam, use the SFT manual. For PowerLogic devices,
reference the PMCU help file.

As device information is polled and received by PowerLogic SCADA, the waveform
becomes available for viewing. See Changing the Display Name in an Alarm or Event
Log on page 146 for information on viewing waveforms in the runtime environment.

Viewing Device Profiles
The Create Device Profiles tab displays all of the tags that are included in each device
type profile. It is the starting point for creating/editing device profiles for individual
devices. Most of the data on this screen displays for information only; however, to
enable waveforms, you need to check the Waveform box (see Enabling Waveforms on
page 51 for more information). To begin making changes, click Add/Edit. The following
table describes the fields on this tab. The tags listed assume that Advanced Properties
has been checked. Not all elements appear on every sub-tab. Detailed instructions are
after the table.

Field Name Valid Entry Comments

TagGroups (left-
hand pane)

Click a group to display the groups of
tags that have been selected for the
chosen device profile.

To associate tags and tag groups with a device type
(thus creating a device profile), click Add/Edit.
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Field Name Valid Entry Comments

Device Profile Choose the device for which you want
to view profile details.

Device Profiles are created on the Add/Edit Device
Profile screen (click Add/Edit).

Add/Edit button Click to display the Add/Edit Device
Profile screen.

Use that screen to add device profiles and to
associate PC-based alarms and trends.

Tag type sub-tabs
Click to display the selected tags for
each type of tag: real-time, trend, PC-
based alarm, onboard alarm, control,
or reset.

Organized according to tag groups.

Tag Description n/a This is the tag name used when adding the tag.

IEC Tag Name n/a This is the IEC61850-compatible name created
when the tag was added.

Waveform

(Onboard Alarm)

Check this box as part of the process
of enabling waveform viewing in
PowerLogic SCADA.

Youmust also set up the alarm and waveform
capture in the onboard files of the device.
Waveforms will then be viewable in the runtime
environment.

Category Type

(Real Time)
n/a

These are real-time filters. They providemetadata to
be used in future reporting.

Utility Type

(Real Time)
n/a

Statistical Type

(Real Time)
n/a

Quantity

(Real Time)
n/a

Categorization
(PC Based and
Onboard Alarm)

These are alarm filters. They can be used for filtering
and sorting alarm data in the runtime environment.
They also providemetadata to be used in future
reporting.

Subcategorization

(PC Based and
Onboard Alarm)

Alarm Type

(PC Based and
Onboard Alarm)

Alarm Group

(PC Based and
Onboard Alarm)

Alarm Level

(PC Based and
Onboard Alarm)

From the drop-down list, you can edit
the alarm level.

If PC-based and/or onboard alarms are set for this
profile, you can change their levels here.

To view profile information, select the device profile from the drop-down menu. Use the
tag tabs (real-time, trend, etc.) to view the tag groups included in this device profile.

To begin adding, editing, or deleting a profile, click Add/Edit.

Adding, Editing, or Deleting a Device Profile
Use the Add/Edit Device Profile screen to add device profiles to the system. To view
this screen, go to the Create Device Profiles tab.

Adding a Profile

Click Add/Edit. At the Add/Edit Device Profiles screen, check either Create New or
Create From. Click Next. See the tables below for detailed help.
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Editing a Profile

You can only edit unlocked profiles. Select the profile to be edited. Information about
the profile displays. If an address is incomplete for a device type in the profile, you will
see Device Type is incomplete beneath the Add/Edit button. Before you can proceed,
you need to complete all addressing for that device.

There are two ways to edit tags:
• From this first screen, you can select a profile and then:

— Trend Tags sub-tab: choose trend intervals (to create or edit intervals, see
Setting Up Trend Intervals on page 57).

— PC Based Alarms or Onboard Alarms sub-tabs: change alarm levels (this will
override the default that is set in Setting Up Custom Tags on page 42).

— Onboard Alarms sub-tab: enable waveform capture for on-board alarms (see
Enabling Waveforms for Onboard Alarms on page 126 for complete instructions
on enabling these waveform captures).

— Onboard Alarms sub-tab: add Alarm On and Alarm Off text. What you enter here
will override the default setting that comes from the custom tag (see Setting Up
Custom Tags on page 42 for more information).

— Parameters sub-tab: Edit parameters for IEC 61850 driver parameters (see
Editing Driver Parameters for more information).

• Click Add/Edit to progress through several screens to edit all aspects of the profile.
See the tables below for detailed instructions.

Deleting a Profile

You can only delete unlocked profiles. Select the profile to be deleted, and click
Add/Edit. The greyed-out Add/Edit Device Profile screen displays. Click Delete
Existing. Click Delete, then click Yes to the Confirm prompt.

Field
Name Valid Entries Comments

Profile Options

Device
Profile
Name

Type or select the
profile name:
maximum 32
characters

do not use \ / : * ? < > |

Description optional

This adds descriptive information for “tool tip” display. When you hover over
the name of the profile on the Create Device Profiles tab, the description
displays. It also displays with the profile name on the Selected Device
Profiles sub-tab on the Set Up Project tab.

Click Next to be able to select devices.

Available
Devices

Click the left and right
arrows to add
devices or remove
devices from the
profile.

You can add entire device groups (composite, monitoring, protection) or
individual devices form each group.

Click Next to select/edit tags for this profile:
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Field Name Valid
Entries Comments

Device Type
Tags

For each
device, choose
the tags you
want to include
in this profile.

Choose entire categories (Controls, Currents, Resets, etc.), or individual tags
from each category.

Override Tag
Name

Select the tag
name that you
want to use as
an override.

Highlight the tag, then click Override Tag Name.

From the Select Tag window, choose the tag you want. If necessary, enter a
search term, then click Search to display related tags.

Choose the tag, then click OK.

Is Device Tag

Check to read
data from the
physical
device, not the
composite
device.

Composite device types only: Example: if the same tag is in three devices, and
you set PC-based alarms for each device, you need to be able to determine
which device has a problem in runtime. To prevent confusion, check Is Device
Tag to cause PowerLogic SCADA to report the tag for its physical device,
rather than the composite device.

Click Next to select PC-based and Trend assignments.

Field Name Valid Entries Comments

PC-Based

Check to enable
PC-based alarming
for the highlighted
tag

When the project is added to the PowerLogic SCADA project, PC based alarms
are added to the Analog Alarms or Digital Alarms file.

Trend

Check to enable
PC-based alarming
for the highlighted
tag

When the project is added to the PowerLogic SCADA project, historical trends
are added to the Trend Tags file. Logging will automatically begin when the tag is
added to the PowerLogic SCADA project.

There are two different intervals for scanning trend tags. All selected tags are
scanned every 15minutes with FIFO storage of 12months. For the following
tags, there is an additional “short” scanning interval of 5-seconds, with FIFO
storage of two weeks:
Current A, Current B, Current C, Voltage A-B, Voltage B-C, Voltage C-A, Power
Factor Total, Apparent Power Total, Reactive Power Total, Real Power Total,
and Frequency.

For instructions on changing the “short” scan interval settings, see Trend Tag
Scan Intervals on page 134

Driver
Parameters

Check the
appropriate
parameters.

For some IEC 61850 device types, this column is populated with parameter
options. Select the approrpriate ones for this profile. The parameters allow you
to edit datasets and report control blocks. To edit existing datasets and report
control blocks, go to the Create Device Profiles tab. Click the Prameters sub-
tab. See .... for more information. seeEditing IEC 61850 Datasets on page
57andEditing IEC 61850 Report Control Blocks on page 58.

CloseWizard

Check to return to
the first page of the
Create Device
Profiles tab.

When you check this box and then check Finish, you return to the Create Device
Profiles tab. When this box is not checked, click Finish to the Add/Edit Device
Profile screen.

Click Finish to complete the profile.

Adding a Device Profile

To add a profile:

1. Open the Create Device Profiles tab (from the Create Device Profiles tab, click
Add/Edit).

2. In the Profile Options box, click Create New or Create From.

If you are creating from another device profile, choose it from the Device Profile to
Create From drop-down menu.

3. Click Next to make the name and description fields live.
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4. Type a unique Device Profile Name, maximum 32 characters;
do not use \ / : * ? < > |

5. If you want to lock this profile, preventing anyone from editing it, check the Lock this
Device Profile box. This action cannot be undone. If you wish to edit a locked
profile, you must use the Create From option to add a new one, then delete the
locked one.

6. (optional) Type a device description. This will display as a tool tip in later screens.

7. Click Next again to make the remaining fields live.

8. From the Available Devices list, highlight the first device or device group
(Protection, Monitoring, Composite) to be included in this profile. Click the right
arrow button to move it to the Selected Devices box. You must select and move
devices or device groups one at a time (no shift+click to select multiples).

9. If you will want to import this project into another instance of the Profile Editor, see
Adding Project Parameters.

10.When you have all of the devices you want, click Next.

11.From the Device Type Tags list on the left, select the tags you want to include in this
profile. You can select entire tag groups or individual tags from a group; but you
must select them one at a time.

12.After each addition, the tag or tag group displays in the Selected tags box. You can
override any tag name (typically for generic I/O devices with multiple tags, such as
inputs, for which names alone would not be intuitive in runtime. To override a tag,
select it, then click Override Tag Name. Choose the tag you want. Click OK. The
new tag will correctly display the value of the original tag, but will take the
appearance of the override tag (description, metadata, etc.).

13.The final column, Is Device Tag, displays only for composite devices. Check this
box to tie a tag back to its actual physical device. For example, if the same tag is in
three devices, and you set PC-based alarms for each device, you need to be able
to determine which device has a problem in runtime. To prevent confusion, check Is
Device Tag to cause PowerLogic SCADA to report the tag for its physical device,
rather than the composite device.

14.When you have selected all tags, click Next.

NOTE: If you have duplicate tags from multiple devices, you need to resolve this by
using an override for one of the tags.

15.On the next page, choose whether each tag will have a PC-based alarm and/or
trend associated with it.

When the project is added to the PowerLogic SCADA project, PC based alarms are
added to the Analog Alarms or Digital Alarms file.

When the project is added to the PowerLogic SCADA project, historical trends are
added to the Trend Tags file. Logging will automatically begin when the tag is
added to the PowerLogic SCADA project.

By default, there are two different intervals for scanning trend tags. All selected tags
are scanned every 15 minutes with FIFO storage of 12 months. For the following
tags, there is an additional “short” scanning interval of 5-seconds, with FIFO storage
of two weeks:

Current A, Current B, Current C, Voltage A-B, Voltage B-C, Voltage C-A, Power
Factor Total, Apparent Power Total, Reactive Power Total, Real Power Total, and
Frequency.

For instructions on changing the “short” scan interval settings, see Trend Tag Scan
Intervals on page 134.
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To change a trend interval for a tag, see Selecting Trend Intervals on page 56To
add additional trend tags, see Setting Up Trend Intervals on page 57.

16.The Driver Parameters box contains options that you can check for IEC61850
devices. If a device includes datasets and report control blocks, you can edit the
information on the Editing IEC 61850 Datasets on page 57 and Editing IEC 61850
Report Control Blocks on page 58 screens.

17.Check the Close Wizard box, and click Finish to return to Create Device Profiles
tab/ Or, leave it unchecked, and click Finish to return to the Add/Edit Device Profile
screen.

Editing a Device Profile

Only unlocked profiles are available for editing.

To edit a profile:

1. Open the Create Device Profiles tab (from the Create Device Profiles tab, click
Add/Edit).

2. In the Profile Options box, click Edit Existing.

3. From the drop-down menu, choose the profile you want to edit.

4. You can change any of the attributes that have been selected for this profile.

5. Click Save to save the change, or click Save & Exit to save changes and close the
screen.

Deleting a Device Profile

You cannot delete standard profiles or custom profiles that have been associated with
projects. To delete a custom profile that is associated with a project, you need to go to
the Set Up Project tab.

To delete a profile:

1. Open the Create Device Profiles tab (from the Create Device Profiles tab, click
Add/Edit).

2. In the Profile Options box, click the Delete Existing radio button.

3. From the drop-down menu, highlight the profile you want to delete.

4. Click Delete.

5. At the Confirm prompt, click Yes.

6. Click Save to delete the profile, or click Save & Exit to delete the profile and close
the screen.

Selecting Trend Intervals
Use the Select Trend Intervals screen to edit settings for existing trends for specific
device profile/tag combinations. To create new trends, see Setting Up Trend Intervals
on page 57.

To change a trend interval, follow these steps:

1. On the Create Device Profiles tab, choose the device profile, then click the Trend
Tags sub-tab.

2. Locate the tag for which you want to change the trend. Click Edit.

3. At the Select Trend Intervals screen, you can select one or all of the interval
options.

4. Click OK.
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Setting Up Trend Intervals
For any of the trend definitions that are in the system, you can add or edit trend
intervals.

To add a trend interval:

1. Access the screen: Click Settings > Set Up Trend Definitions.
2. From the Set Up Trend Definitions screen:

a. Click New to begin adding a new trend
b. Select a trend, then click Copy to create a new trend from an existing trend.

3. Type a name: must begin with either an alpha character (A-Z or a-z) or the
underscore character (_). Any following characters must be either alpha characters
(A-Z or a-z), digit characters (0 - 9), backslash characters (\), or underscore
characters (_).

4. Type the appropriate information in the following fields. See Trend Tag Properties
in the CitectScada.chm help file for details on each field.

5. Click OK to save the new trend definition, which displays in the left-hand box.

To edit a trend interval:

1. From the Set Up Trend Definitions screen, select the trend name, then click Edit.
2. You can edit any of the fields except the trend name.

To delete a trend interval:

1. From the Set Up Trend Definitions screen, highlight the name of the trend to be
deleted.

2. Click Delete, then click Yes when you are asked to confirm.

Editing IEC 61850 Datasets
Use this screen to add and edit IEC 61850 tag datasets to a profile. To access this
screen, display the Create Device Profiles tab for a device that includes ICD files. Click
the Parameters sub-tab, then click Edit on the DataSets line.

NOTE: Not all ICD files allow you to add, edit, or delete datasets. If all fields are greyed
out, you will not be able to change the set.

In the upper left corner are the device profile name and device type names that come
from an imported ICD file. All of the entry fields are initially greyed out. The device type
datasets (upper box) are resident in the ICD. The device profile datasets (lower box)
have been created or copied from other datasets in the device type or device profile.

Creating a New DataSet

1. To begin creating a dataset, click Create New beside the Device Profile DataSets
box.

The fields on the right side of the screen become live.
2. Type a name and description for the new dataset. These are free-form fields, but

they must comply with IEC 61850 standards.
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3. Choose the appropriate logical device, then choose the logical node for that
device.

4. Choose the functional constraint for the content. This will filter the display of device
type objects/topics in the box below.

When you choose All, you must then choose an object that already has a functional
constraint in it. If you choose a specific constraint, the list of available objects is
filtered to display only those that include that constraint.

5. From the Device Type Objects, choose the appropriate objects for this profile.

6. Click OK.

The new dataset is added in the lower left, to the Device Profile list.

Creating a DataSet from an Existing DataSet

You can create a new dataset either from one that resides in the ICD (from the device
type) or from the device profile.

1. To begin creating a dataset from another block, click the dataset (either device type
or device profile) to be used as the starting point for the new dataset. Click Create
From.

2. Make the appropriate changes. You must change the name. All datasets in a single
profile must have unique names.

3. Click OK.

The new name displays under the Device Profile List.

Copying a DataSet to a Device Type

This feature will not typically be used. If, however, you delete a dataset from the device
type, but later decide you want to add it back, follow this procedure. (You cannot delete
datasets that are used by a report control block.)

1. From the Device Type DataSets box, highlight the dataset you want to add back.
2. Click Copy To.

The dataset displays under the Device Type list in the Device Profile DataSets.

Editing and Deleting DataSets

You cannot edit or delete datasets that are being used by a report control block or
those that belong to the device type.

To edit a dataset, highlight its name, then click Edit. Make the desired changes, then
click OK.

To delete a dataset, highlight its name. Click Delete, then click OK.

Editing IEC 61850 Report Control Blocks
Use this screen to edit report control blocks for device type information that comes from
imported ICD files. To access this screen, display the Create Device Profiles tab for a
device that includes ICD files. Click the Parameters sub-tab, then click Edit on the
Report Control Blocks line.
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NOTE: Not all ICD files allow you to add, edit, or delete report control blocks. If all fields
are greyed out, you will not be able to change the set.

In the upper left corner are the device profile name and device type names that come
from an imported ICD file. All of the entry fields are initially greyed out. The device type
report control blocks (upper box) are resident in the imported ICD file. The device
profile report control blocks (lower box) have been created or are copied from report
control blocks in the device type or device profile.

Creating a New Report Control Block

1. To begin creating a new report control block, click Create New beside the Device
Profile Report Control Blocks box.

The fields on the right side of the screen become live.
2. Type a name and description for the new report control block, conforming to the IEC

61850 naming conventions.

3. Choose the appropriate dataset for this block. Datasets are added/edited in the
Add/Edit DataSets screen, accessed from the Parameters sub-tab on the Create
Device Profiles tab.

4. Type a report ID, again conforming to the IEC 61850 convention.

5. ConfRev determines the version number of the report control block.

6. If this is a buffered block (BRCB), check Buffered and enter the time and integrity
period. (Indexing is currently unavailable in PowerLogic SCADA).

7. Check the appropriate boxes for trigger conditions and report content.

8. Click OK.

The new report control block is added in the lower left, to the Device Profile list.

Creating a Report Control Block from an Existing Report Control Block

You can create a new report control block either from a block that resides in the ICD
(from the device type) or from the device profile.

1. To begin creating a block from another block, click the report control block (either
device type or device profile) to be used as the starting point for the new block.
 Click Create From.

2. Make the appropriate changes. You must change the name. All report control
blocks in a single profile must have unique names.

3. Click OK.

The new name displays under the Device Profile List.

Copying a Report Control Block to a Device Type

This feature will not typically be used. If, however, you delete a report control block
from the device type, but later decide you want to add it back, follow this procedure.

1. From the Device Type Report Control Blocks box, highlight the block you want to
add back.

2. Click Copy To.
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The report control block displays under the Device Type list in the Device Profile
Report Control Blocks.

Editing and Deleting Report Control Blocks

You cannot edit or delete datasets that belong to the device type.

To edit a report control block, highlight its name, then click Edit. Make the desired
changes, then click OK.

To delete a report control block, highlight its name. Click Delete, then click OK.

Creating a Composite Device Type
A composite device is a device profile that includes more than one device type. Each
device type can use its own protocol for communication.

With the composite device type, the user can use two devices for a single monitoring
point. For example, a circuit breaker and a monitoring device can provide data to this
single point. Because PowerLogic SCADA combines the functionality of the multiple
devices, end users only need to consider a single device when analysing a location in
their system.

Follow these steps to create the composite device type:
1. From the Create Device Profiles tab, click Add/Edit.

2. At the Add/Edit Device Profile screen, choose whether you are creating a new
device or creating from an existing device. If you are creating from a device type,
select it. Click Next.

3. Still on the Ad/Edit Device Profile screen, give the composite device type a name.
Optionally, add a description (which will become a tool tip display in later screens).
Click Next.

4. Choose the device types to be in the composite. Click Next.

The Add/Edit Device Profile displays with only device type tags available for
selection.

5. Add the tags you need for each device type listed on the left. To add all of the tags
for a device type, highlight the device type name and click the right green arrow.

You may find, especially when dealing with generic I/O, that the tag name is not
descriptive enough to determine what it is when reading data in runtime mode.
Thus, you may want to override the generic name with something more meaningful.

For example, .a device may have ten inputs: Ind1, Ind2, Ind3, etc. Using those
names, you have no idea what each input is reading. If you override the tag, the
tag's value will still come from the original tag (it still keeps the addressing from the
device); however the tag's appearance (name, metadata, display name, etc.) will be
taken from the new tag.

6. To override a tag:

a. Highlight the tag, then click Override Tag Name.
b. From the Select Tag window, choose the tag you want. If necessary, enter a

search term, then click Search to display related tags.
c. Choose the tag, then click OK.
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Only for composite devices, the Is Device Tag check box displays. Use this box to
tie a tag back to its actual physical device. For example, you might have the same
tag in each of three devices, and you want to set PC-based alarms for each one.
Normally, the composite device would generate a single alarm, but you would not
be able to specify which physical device has the problem. To prevent confusion,
you would check the Is Device Tag, which will cause PowerLogic SCADA to report
this tag for its physical device.

7. Check Is Device Tag to read this tag as specific to the physical device, not the
entire profile..

8. Click Next to begin selecting tags for PC-based alarms and trends.

9. For each tag in the profile, determine whether it should have a PC-based alarm
and/or trend associated with it. Check the boxes as appropriate.

When the project is added to the PowerLogic SCADA project, PC based alarms are
added to the Analog Alarms or Digital Alarms file.

When the project is added to the PowerLogic SCADA project, historical trends are
added to the Trend Tags file. Logging will automatically begin when the tag is
added to the PowerLogic SCADA project.

There are two different intervals for scanning trend tags. All selected tags are
scanned every 15 minutes with FIFO storage of 12 months. For the following tags,
there is an additional “short” scanning interval of 5-seconds, with FIFO storage of
two weeks:
Current A, Current B, Current C, Voltage A-B, Voltage B-C, Voltage C-A, Power
Factor Total, Apparent Power Total, Reactive Power Total, Real Power Total, and
Frequency.

For instructions on changing the “short” scan interval settings, see Trend Tag Scan
Intervals on page 134.

10.The Driver Parameters box allows you to specify certain parameters to be attached
to device profiles. Currently used in IEC61850 devices, the available parameters
will automatically populate this box. See the illustration below for an example.

In this example, Device 2 has two parameters, DataSets and Report Control Blocks.
11.Check the parameter(s) that you want to include in this profile.

To edit, this parameter, return to the Create Device Profiles tab, and click the
Parameters sub-tab. See ..... for information on editing parameters.

12.Check the Close Wizard box, and click Finish to return to Create Device Profiles
tab/ Or, leave it unchecked, and click Finish to return to the Add/Edit Device Profile
screen.
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G3200 Device Setup
Use these instructions to set up a G3200 gateway in PowerLogic SCADA.

For use with multiple devices

Before you begin, create the ICD files for each unique device type that will
communicate via the G3200.

In the Profile Editor

1. Import each unique ICD file.
2. Create the profiles for each device.

3. Modify existing profiles, as needed (adding/modifying tags, etc.)

4. Create the project that will include the GS3200 (mark profiles under the G3200 as
data concentrated devices).

a. Ensure that "Add As Default" is not checked for the project.
b. Add the first device profile.
c. At the Select Profiles screen, enter the Configured Name, and check the "Data

Is Concentrated" box.
d. Continue with steps "b" and "c" for additional device profiles.

5. Run the PowerLogic SCADA and to SCL exports.

In SFT850

Create the CID file for the G3200 gateway.

In PowerLogic SCADA

1. Open the Profile Wizard.
2. To the System Devices, add an IEC 61850 data concentrator for the G3200.

a. From the Enter instance information screen, select the BRCBs that you need.
b. Select the CID file you created in SFT850.
c. Complete the remaining steps in the Profile Wizard.

3. Add a new device for each device under the G3200.

a. From the Enter instance information screen, change the logical device as
needed. Select the unit name of the G3200 device for the data concentrator.

For use with a single device

Although we recommend that you add individual G3200 devices as described in the
section above, you can also do it this way:

Before you begin, create the ICD files for the device type that will communicate via the
G3200.
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In the Profile Editor

1. Import the ICD file.
2. Create the device profile.

3. Modify the profile as needed

4. Create the project, but do not mark it as Data Concentrated Devices.

In SFT850

Create the CID file for the G3200 gateway.

In PowerLogic SCADA

1. Open the Profile Wizard.
2. Add the device.

a. From the Enter instance information screen, select the BRCBs that you need.
b. Change the logical device as needed.
c. Select the CID file you created in SFT850.
d. Complete the remaining steps in the Profile Wizard.

IEC 60870-5-104 Protocol Support
NOTE: PLS_Include and genies may not be completely compatible with IEC 60870-5-
104 devices. Be sure to properly test your system when using the IEC 60870-5-104
driver.

PowerLogic SCADA does not include IEC 60870-5-104 support in its install. However,
you can add this protocol to a project. To include the IEC 60870-5-104 driver in your
project, you must obtain and add a license, install the driver, and run a support utility to
enable Profile Editor support. Follow these steps:

1. To obtain the license key, contact your local sales representative. Add the license
to the dongle. If you need more information, see CiUSAFE dialog properties in the
citectscada.chm help file.

2. The IEC 60870-5-104 driver is included in the install executable:
 Extras\Drivers\Specialty Drivers\IEC870-5-104.

3. Run the Profile Editor support utility. The .exe file is in the Program file directory:
Profile Editor\v7.20\Add IEC 104 Driver Support.exe.

You can now use the IEC 60870-5-104 protocol. In the Profile Editor, you can enter
addresses (though the Profile Editor will not verify that the format is correct).

DNP3 Protocol Support
You can create device types and profiles that use the DNP3 protocol. See Adding a
DNP3_TCP Device on page 101 or Adding a Serial Device to a PowerLogic SCADA
 Project on page 99 for more information.

You will then be able to enter DNP3 addresses, although the Profile Editor will not
verify that the address has an allowed format.
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The Profile Editor will include device types, and will include profiles for ION 7650,
which natively supports DNP3. The Profile Editor will include device types for Sepam
20, 40, and 80 that have the ACE969TP module (which supports DNP3).
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Setting Up Projects in the Profile Editor
The Set Up Projects tab and screen are used to create separate projects for each
customer or installation. This tab makes it easy to select only the devices that are used
at that site. Project data is exported to PowerLogic SCADA for use in the Device
Creation Wizard.

To access these screens, click the Set Up Projects tab on the main Profile Editor
screen.

In this section, you can learn about:

Project Screens and Workflow on page 65

The Set Up Projects Tab on page 66

Adding, Editing, or Deleting a Project on page 66

Creating a Composite Device Type on page 60

Editing and Deleting Information in a PowerLogic SCADA Project on page 68

Customizing Tag Names on page 68

Project Screens and Workflow
This section contains two screens:

The Set Up Project tab has three sub-tabs:
• The Selected Device Profiles tab displays all of profiles that are included in the

Project that is displayed in the drop-down menu.
• The Customize Tag Names sub-tab provides a means of customizing individual tag

names.
• The Project Parameters sub-tab allows you to add optional lines of information

about this project. This information will be exported and can be used for verification
or identification when you want to import the project (for example, you might add a
version number or creator name).

You can click Export Project to create an .XML file that contains all of the project data
necessary for use in the Profile Wizard. If PowerLogic SCADA is installed and the
corresponding PowerLogic SCADA project has been created, this also copies the file
that is used by the Device Creation Wizard to the PowerLogic SCADA project.

On the Add/Edit Project screen, you can add, edit, or delete projects.

Typical Workflow

To create a project file, you must first have established tags, device types, and device
profiles. Additionally, you need to set up at least one base unit/conversion template.
After these files are created, follow these steps:

1. Open the Add/Edit Project screen.
2. Add a new project, or copy and edit an existing project.

3. Select the device profiles that you want to use for this installation.

4. If a device profile has multiple drivers, choose the driver, and determine whether
the individual device types will use functional addresses and act as data
concentrators.

5. Save the project and close the Add/Edit Project screen.

6. To customize tag names: From the Set Up Project tab, click the Customize Tag
Names sub-tab. Change the name of any tag. For example, the customer might
need “Current A” to read “Current Phase A.” The customized tag name will be used
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in all device profiles in the project for which you have created the customized tag.
For this change to be in the PowerLogic SCADA project: you need to delete the
device profile from the PowerLogic SCADA project and then re-export it.

7. To add optional project information: From the Set Up Project tab, click the Project
Parameters sub-tab. You can add optional information that will help verify or
identify this project later. You could, for example, the version or the creator's name.
This information will be available when you import this project at a later date.

8. To refresh tags: From the Set Up Project tab, click the Selected Device Profiles sub-
tab. Click the Refresh Tags button for any profile. You are prompted to confirm that
you want to update changes you have made to this tag for the selected profile. For
this change to be in the PowerLogic SCADA project: you need to remove the
device profile from the PowerLogic SCADA project and then re-add it.

9. Click Export Project to create an Equipment.Profiles file of all of the profiles
included in the project. To view Equipment.Profiles, click the folder button, to the
right of the Export button:

The Set Up Projects Tab
Use the Set Up Project tab to begin adding, editing, or deleting projects. A project
includes all of the tags that belong to the device profiles that you have created and
added to the project. From this screen you also export individual projects to the .XML
file format that can be added to PowerLogic SCADA (using the Profile Wizard).

This screen includes three tabs:
• Selected Device Profiles: (read only) You can view all of the profiles that are

included in each project in the system. Profiles are listed with their descriptions.
• Customize Tag Names: You can customize tag names (for example, instead of

Current A, you might need to use Current Phase A) within a single project. See
Customizing Tag Names on page 68.

• Project Parameters: You can add optional information to be associated with the
export. This information can help you identify the correct project when you are
importing. See Adding Project Parameters.

To add or edit project information, click Add/Edit. The Add/Edit Project screen displays.
See Adding, Editing, or Deleting a Project on page 66 for more information.

To export a project, select it from the Project drop-down menu, choose the export
option you want (File > Export), then click Export. See PowerLogic SCADA Export on
page 69 for more information.

To specify a tag to be used for onboard waveform captures, click the Onboard Alarm
Tags sub-tab. Locate the tag and check the Waveform box.

To view the most recently exported project, click the folder button to the right of the
Export button:

Adding, Editing, or Deleting a Project
Use the Add/Edit Project screen to begin adding, editing, or deleting projects. A project
includes all of the tags that belong to the device profiles that you have created and
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added to the project. From this screen you also export individual projects to the format
that can be added to PowerLogic SCADA (using the Profile Wizard).

Adding a Project

To add a project:

1. First ensure that you have set up the tags, device types, and device profiles that you
want to include. Also, add at least one unit template.

2. Click the Set Up Projects tab, and click Add/Edit.

3. In the Project Options box, click Create New or Create From.

If you are creating from another project, choose it from the Project to Create From
drop-down list.

4. Type a Project Name: maximum 32 characters; name must be alpha-numeric only,
must begin with an alpha character, no punctuation allowed. Do not use:

\ / : * ? < > |
5. To view a list of projects that have already been added to PowerLogic SCADA, click

the Display Projects button:

A list displays with the projects that have been added to PowerLogic SCADA
(greyed out if there are no projects yet or if the Profile Editor is not on the same
computer as the server). To open a project for editing, select it and click OK.

6. If you want to lock the project, preventing anyone from editing it, check the Lock this
Project box. This action cannot be undone. If you wish to edit a locked project, you
must use the Create From feature to add a new one, then delete the locked one.

7. Type a Description for the project. This description displays as a tool tip when you
hover over the project name on the main Set Up Project tab.

8. Select a Unit Template from the drop-down list. Unit templates are created on the
Units screens. See Setting Up Engineering Templates and Selecting Conversions
on page 28 for instructions on creating templates.

To add a new unit template, click Set Up Eng. Unit Templates. The Set Up
Engineering Unit Templates page displays. See Adding or Editing a Base
Engineering Unit or Conversion on page 30 for help.

9. From the Device Profiles box, select the first profile you want to include in this
project.

If this device profile will NOT have functional addressing or data concentration,
check the "Add As Default" box at the bottom of the screen. (For a description of
functional addressing, see the Functional Addressing entry in Appendix 4: Glossary
on page 196.)

Click to move the device profile to the Selected Device Profiles box.
If the Select Profile Drivers screen displays, one of the following is true.
— You did not check the "Add As Default" box for a device type, so the system

does not know how to use the functional address/data concentrator option.
Check the appropriate box to turn the related option "on."

— At least one of the device types in this profile includes multiple drivers. For each
multiple-driver device type listed, choose the driver that you want to use in this
project. Additionally, you can check either of the Functional Address or Data Is
Concentrated boxes to enable those features.
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10.Give the device type a Configured Name. This name might indicate its status (which
driver it uses, whether it has a functional address, etc.) in future project references.

11.When all profiles are added, click Save to save the changes, or click Save & Exit to
save changes and close the screen.

Editing a Project

You can only edit projects that are unlocked.

To edit a project:

1. Open the Add/Edit Project tab (from the Set Up Project tab, click Add/Edit).
2. In the Project Options box: Select the project to be edited from the drop-down list,

then click Edit Existing.

3. You can change any attribute of the project.

4. Click Save to save the change, or click Save & Exit to save changes and close the
screen.

Deleting a Project

You can only delete unlocked projects.

To delete a project:

1. Open the Add/Edit Project tab (from the Set Up Project tab, click Add/Edit).
2. In the Project Options box: Select the project to be deleted from the drop-down list,

then click Delete Existing.

3. Click Delete.

Editing and Deleting Information in a PowerLogic SCADA Project
After you have exported a project to a PowerLogic SCADA project, you still need to use
the Device Creation Wizard to add system information to a PowerLogic SCADA project.
See Before You Use the Profile Wizard on page 93 for information about this process.

Customizing Tag Names
From the Set Up Project tab, click the Customize Tag Names sub-tab. You can add a
custom name for any tag in the system, predefined and custom tags. The customized
name will be used anywhere the original name would be used, but only for the project
that is selected in the drop-down menu. When you use the Export option, it will be used
by the Profile Wizard.
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Importing and Exporting Project Files
In the Profile Editor, you can import and export these files:
• Export all of the tags and devices from a Profile Editor project into a PowerLogic

SCADA project; see PowerLogic SCADA Export on page 69.
• Export SCL files, which allows you to export IID files that have been previously

imported from an SCL file. The IID file can then be imported into other instances of
the Profile Editor. See SCL Export on page 71.

• Export a Profile Editor project. This makes a backup copy, which you can later
import into a different instance of the Profile Editor. This is useful when you want to
share custom tags and devices. See Profile Editor Export on page 71.

• Import a project from another instance of the Profile Editor.
• Import SCL files. This allows you to import from the profile data of IEC61850-

compliant devices and create device types. These files can be exported as an IID
profile or as a PowerLogic SCADA profile.

The import process works the same for each type of import. The only exception is
that you cannot import profiles when you are importing SCL files. See Importing
Files into the Profile Editor on page 72.

When importing data, you will need to reconcile the import information with the
information that exists in the Profile Editor.

You can also use templates, both in exporting and importing. See Using Import
Templates on page 76.

PowerLogic SCADA Export
Use this feature to export a project from the Profile Editor into PowerLogic SCADA.

If the Profile Editor is on the same computer with PowerLogic SCADA, and if you have
created a matching project in the PowerLogic SCADA project, this process will copy all
project data—device tags, device types, and device profiles—into the PowerLogic
SCADA project. If the Profile Editor is not on a computer with PowerLogic SCADA, you
need to manually move the exported file to the PowerLogic SCADA server. See
Moving Files if the Profile Editor is not with the Server, below.

Before you export

If you are exporting a project for the first time to the PowerLogic SCADA project, you
need to create a matching project in PowerLogic SCADA. To do this:

1. Launch the instance of PowerLogic SCADA to which you will be exporting data:
Click Start > Programs > Schneider Electric > PowerLogic SCADA 7.20 >
PowerLogic SCADA Explorer.

2. From the Citect Explorer window, click File > New Project.

3. In the New Project Window, add the project . Be sure that Template Resolution is
SXGA.

If you have questions about any of the fields, click Help.
4. Add your project to the Profile Editor, ensuring that the name matches exactly the

one that you added in PowerLogic SCADA (to ensure that it correctly exports to its
matching project).

To export a Profile Editor project to the PowerLogic SCADA project:
1. Open the Set Up Projects tab.
2. From the Project list, select the project to be exported.

3. Click File > Export; then check the PowerLogic SCADA Export option. (The selected
export(s) are indicated beneath the Export Project button.)
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4. Click Export Project.

NOTE: If you have added custom tags to devices, but the tag addressing is
incomplete, a message displays with the name(s) of the device profile(s) that
contain the tag(s). Return to the Define Device Type Tags tab. Locate any tags for
which “Edit...” is red. Click Edit... to open the Edit Address screen. Make the
necessary changes. From the Set Up Project tab, refresh the tags for those profiles.
Then try exporting again.

A progress bar displays while the various profiles are saved, The resulting files are
exported to these locations in the Profile Editor (assuming that you accepted the
default locations during installation):
— Each Project file, used by the Profile Editor, is stored in Documents and

Settings\All Users\Application Data\Schneider Electric\Profile
Editor\v7.20\Projects (for Vista operating systems, it is ProgramData\Schneider
Electric\Profile Editor\v7.20\Projects).

— Each Profile Wizard profile file is stored in Documents and Settings\All
Users\Application Data\Schneider Electric\Profile
Editor\v7.20\WizardProfiles\[project name] (for Vista operating systems, it is
ProgramData\Schneider Electric\Profile Editor\v7.20\WizardProfiles\[project
name]). A single file for each included profile.

— The Equipment.Profiles file (contains all of the Profile Wizard profile information
and the base profile information used by the Profile Wizard) is stored in
Program Files\Schneider Electric\Profile Editor\v7.20\WizardProfiles\[project
name]\Profile Wizard.

Both the Application Data directory (on Windows XP) and the ProgramData
directory (on Vista) are hidden folders by default.

In PowerLogic SCADA, files are located in the following folders:
— DeviceProfiles contains .XML files for every profile (these are used by the

Profile Editor).
— DeviceTypes contains .XML files for all device types (these are used by the

Profile Editor).
— Projects contains all .XML files for all projects (these are used by the Profile

Editor).
— DeviceWizardProfiles contains the exported device profiles and equipment

profiles files, organized by project (these are used by the Profile Wizard).
5. On the Project Editor window, use the Profile Editor to add device information.

Moving Files if the Profile Editor is not with the Server (Reusing a Project)

When the Profile Editor is not on the same computer as the PowerLogic SCADA server,
you need to move the export file to the server computer. Follow these steps:

1. Export the project from the Profile Editor.
2. Click the folder icon beside the Export link:

3. Copy the file (Equipment.profiles) that displays and move it to a portable drive.

4. On the PowerLogic SCADA server computer, paste Equipment.profiles in this
location:

[Drive Letter]:\Documents and Settings\All Users\Application Data\Schneider
Electric\PowerLogic SCADA 7.20\User\[Project] (for Vista operating systems: [Drive
Letter]:\ProgramData\Schneider Electric\PowerLogic SCADA 7.20\User\[Project])

where:

[Drive Letter]: is the drive on which you installed the PowerLogic SCADA server
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the Application Data and ProgramData folders cannot be hidden (set the folder
view for “view hidden folders”)

[Project] is the name of the project you are creating; you must have already added
this project to PowerLogic SCADA (see Before You Export, above).

5. From the Citect Project Editor, click Tools > Profile Wizard to begin adding device
information to the PowerLogic SCADA project.

Profile Editor Export
To back up a PowerLogic SCADA project file, see PowerLogic SCADA Backup on
page 129.

Use this procedure when you want export (back up) a Profile Editor project for re-use in
another instance of the Profile Editor. This is useful when you have custom tags and
custom devices that you want to share in other projects. After you export the project,
you can use the Import feature to apply this project to another version 7.20 Profile
Editor project.

1. From within the Profile Editor, click the Set Up Projects tab.
2. From the Project drop down box, select the project you want to back up.

3. Click File > Export, then ensure that the Profile Editor Export option is checked.

4. See Customizing Tag Names on page 68 and Adding Project Parameters for the
information you need to make the changes that you want.

5. Click Export Project.

Exported projects will include, in addition to the project data:
• a unique project name, the date of the export
• the name of the computer to which it was saved
• the (optional) description added when the source project was created.

The project (which will be named YOUR PROJECT.pls) is exported to the following
location:

C:\Documents and Settings\All Users\Application Data\Schneider Electric\Profile
Editor\v7.20\WizardProfiles\YourProjectName\Profile Editor
Export\YourProjectName.pls.

SCL Export
Use this feature to export IID files (previously imported from an SCL file). The IID file
can then be imported into other instances of the Profile Editor.

This process does not correct any errors in the files. If the imported file was an IID file
from a different instance of the Profile Editor, it will contain the same configuration and
communication information as the original. If the imported file was a Gateway SCL file
with multiple devices, you can export each device as a separate IID file (the
configuration and communication information is taken directly from the Gateway SCL
file).

The only ways you can edit these files are:
• You can delete data sets, and then add new ones.
• You can edit report control blocks (buffered or unbuffered).

Perform these edits in the device profile before you export, and they will be exported to
the IID file.

© 2011 Schneider Electric All Rights Reserved 71

../../../../../Content/PwrSCADA/Adding_Project_Parameters.htm
../../../../../Content/PwrSCADA/Adding_Project_Parameters.htm
../../../../../Content/PwrSCADA/Adding_Project_Parameters.htm


Exporting the File

Follow these steps to export IID files:

1. From the Set Up Projects tab, select the project from which you want to export. (The
project must have devices that include ICD files.)

2. Click File > Export; then check the SCL Export box.

NOTE: The export(s) that you select display beneath the Export Project button, on
the right side of the screen.

3. Click Export Project.

The Export Summary displays with the results of the export. When the export displays
under the Success topic,the listed files were exported. When the export displays under
the Warnings topic, the reason for the failure to export is listed for the device types
shown.

The exported files, listed according to their device types, will be saved in:

C:\Documents and Settings\All Users\Application Data\Schneider Electric\Profile
Editor\v7.20\WizardProfiles\<project name>\SCL Export\sclFileName.iid).

Importing Files into the Profile Editor
Use this feature to import either an existing project or SCL files into the Profile Editor.
This is commonly used to share project information by importing custom tags and
devices from another instance of the Profile Editor; but you can also import SCL files
from an IEC 61850 device.

For specific information about importing SCL files, see Importing SCL Files on page 76

For Profile Editor projects, you can import tags, device types, and profile. For SCL
imports, you cannot import profiles.

NOTE: You cannot complete the import until you match, merge, or reject every item.

Follow these steps to import data into the Profile Editor:

1. Before you begin, consider the source of the information you want to import. We
strongly recommend that you use a master PC from which you draw this
information. This will ensure that you are using a single source. Also, back up your
data folder before you start. This gives you data to revert to, in case you
accidentally lose data.

2. Note the location of the project file or SCL files that you want to import.

3. From the Profile Editor, click File > Import.

4. At the Import File Selection window, click the browse button ( ), then navigate
to the location of the file you want to import.

The Import Properties box displays the _ProjectName, _Description, _DateTime,
and _ComputerName information. These lines were automatically generated for
this file. Any additional lines will be information that you added on the Project
Parameters sub-tab when you created or exported the project.

Use this information to verify that you are about to import the files that you want.
5. If desired, select an import template from the drop down list. (To create a template,

see Creating a New Template During Import in Using Import Templates on page 76
.) If you select a template, the import will accept default properties from the
template. For example, if the template has alarm settings from a device, and you
are importing tags for that device, the import will use those alarm settings.
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6. When you are sure you have the correct file, click Start Import.

The system analyses the import and attempts to match imported items with existing
items on the local machine. The Reconcile Import Screen displays, allowing you to
begin the process of importing or rejecting individual tags.

See Import Reconciliation Screen (Search) on page 73 for a description of the parts
of this screen.

7. As you view the Import Reconciliation screen, you work through the items in the left-
hand tree. You respond to each item according to your preference for it. You must
match, merge, or reject first units, then tags, and finally the device type.

8. For each item in the left-hand pane, when you match it with a local item, the right-
hand pane changes to allow you to edit how you want the match to take place.

NOTE: You can click Unmatch at any point, to undo a match that you have made,
but not saved.

See Import Reconciliation Screen (Merging-Matching) on page 74 for instructions
on responding to each type of tag.

9. After you have matched. merged. or rejected all items in the import list, the
Complete Import button becomes live. Click Complete Import.
After the import is saved, the Save Import Template dialog displays. See Using
Import Templates on page 76 for instructions on creating, using, and deleting
import templates.

Import Reconciliation Screen (Search)
Use the Reconcile Import Screen in Search mode to begin finding matches for the
items you are importing. The following image illustrates an import with exact matches (

), partial matches ( ), and no matches ( ):

The parts of this screen are:

Left-hand pane:
• The tree view presents the imported file's hierarchy: device profiles, device types,

tags, and units. Each item has an icon to its left, indicating the system's initial
assumption about how this item is matched. You can accept or override these
assumptions.
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• The Show Profiles box controls whether the tree view lists device profiles (it is
possible that device profiles will be discarded during the import).

• At the bottom of the page, the four buttons control how the tree navigates. (Each
individual item also has one of these icons beside it, indicating its status.) You can
select the items singly or in combination (click Ctrl +). The buttons are:

: exact match; item is either a perfect match to a local item, or you accepted
a merge for it.

: partial match; item is a partial match to a local item.

: no match; item does not match any local item.

: ignore this item; you chose to ignore this item in this import.
• Cancel: Click to back out of the import without saving any of your selections.

Right-hand pane:
• Up and Down arrows: Use to navigate through the list of items in the left-hand

pane, based on the button selected. For example, if you highlight the "no match"
icon, and then click the down arrow, the selection in the left-hand pane will move
down to the next "not match" item.

• Search box: When you select an item from the left-hand pane, type a search term
(such as "power") to display a list of possible matches.

• Search results: The large box is populated with the possible matches, determined
by the search word(s) you enter. They are listed in descending order of how well
they match the attributes of the item.

• New: Click this button to add the selected import item into the project. It will keep all
of its attributes, and it will be changed in the tree view to show it is an exact match.

• Force Edit: When all of the data is present for the item, but you still want to edit it,
check this box to open the window required to edit it (e.g., Create Device Type
window).

• Select: Click to match an import item with a selected item in the search results.

Editing the Item

If you have checked Force Edit, a screen displays for you to edit the item's information.
This allows you to make changes to an item, even though it may be an exact match
with a local item. This new information will be applied to the item after you complete the
import.

Completing the Import of an Item

When you make a match—exact or partial—between an imported item and a local
item, the right pane of the screen displays information about the match. See Import
Reconciliation Screen (Merging-Matching) on page 74 for more information.

Import Reconciliation Screen (Merging-Matching)
The right-hand pane of the Import Reconciliation screen changes after you match an
import item with a local item.

The following example illustrates the screen when there is a partial match:
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The parts of this window are:
• Title: Indicates which of the three "states" the import item is in: matched (the item

name displays), partially matched (you will need to merge the two items or accept
the match that is in the final column), or merging (the system assumes a match in
the final column, but you can edit each attribute). These actions to take for these
three states are described below.

• The columns describe the imported vs local items:

Property: The property for which the other columns provide definitions

Imported: The value of the item in the import file

Local: The closest local match for the imported item

Result: The item as it will be added in this import
• Unmatch: Removes the match for the item; if you were merging, the merge grid

goes back to its original state for you to either reject it, find a match, or import as
new.

• Merge: When the import item is matched with an unlocked item, click here to begin
merging their attributes. The "Merging" heading displays, and you can begin
choosing the setting to be used for each attribute.

The shaded items are the ones assumed by the system; by default, each one will
be the Local setting. To change an item from local to import, double-click the item
name in the Imported column. Notice how the Result column changes to reflect the
name change. To toggle back to the Local setting, simply double-click the name in
the Local column.

• Match: Accepts the attributes of the local item for the new imported item (item will
turn to a green check). You can use this to accept an item without changing it or
after merging its attributes.
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• Complete Import: This button becomes live only after you have matched,
merged, or rejected all items in the left-hand pane.It first alerts you that this
operation cannot be undone. If you accept that, the import is final; new data is
saved to the local computer. This is permanent; you cannot undo it.

Importing SCL Files
You can import SCL files from individual devices, provided the files conform to
IEC61850 specifications. You can also import an individual device from a Gateway
SCL file that contains multiple devices.

NOTE: You can only import SCL files that meet the schema requirements for Ed 1.4 of
IEC61850. If an SCL file does not meet these requirements, an error message will
display, telling you that the scheme must validate against the scheme of Ed. 1.4. The
Profile Editor will accept SCL files that use either Ed. 1 or Ed. 2 data structures; but it
will apply data structures only as defined in Ed. 2.

During this import, you will need to reconcile mismatches; and data will be available for
creating SCADA device types, device profiles, and projects. If you import an SCL for a
PM700, note that all tags for date and time are excluded by default.

You can save the information in one of two ways:
• IID file. This IID file will maintain all of the configuration and communication

information that comes from its device. The only items you can change are:
— You can delete datasets and control blocks, and add new ones.
— You can edit buffered and unbuffered control blocks (provided you have created

them in the Profile Editor).

• PowerLogic SCADA profile. The data will then follow the normal rules for the
profiles in this project.

See Importing Files into the Profile Editor on page 72 for instructions on importing.

Using Import Templates
You can create, edit, and apply templates when you import files. You can also delete
import templates. A template will include tags that you import into the Profile Editor from
a project in another instance of the Profile Editor, or it will contain ICD files from an IEC
61850 device.

You will want to create a template for custom situations, like when you are importing
SCL files or adding custom tags and devices.

Creating a New Template During Import

To create a new template:

1. From the either type of import (Profile Editor or SCL), choose the file (.pls or .icd)
that you want to import.

2. Complete the matching for the items.

3. Click Complete Import.

4. At the Save Import Template prompt, click Yes.

5. Click the New radio button, then type a name for the new template. The name must
begin with a letter. It can contain alpha-numeric characters, as well as dashes and
spaces. Click OK to save it.
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In future imports, you will be able to apply this template. When you do, the system will
automatically match, where appropriate, the import items with the local items.

Applying a Template During Import

In this procedure, you will import files, and you will either create a new import template,
or you will edit an existing one.

NOTE: Be careful when applying a template: you will overwrite an existing template on
the local computer with the information that you choose during matching. Once
completed, you cannot undo this.

To apply an existing template:

1. From the Set Up Projects tab, select a project for which you want to import data.
2. Click File > Import, then choose the file (.pls or .icd) that you want to import.

3. From the Import Template drop down list, choose the template you want to use. This
is just a starting point for this import to make it quicker to match items. You will apply
the template in step 7.

4. Click Start Import.

After the import completes, the Import Reconciliation screen displays. The list in the
left-hand pane should have some exact and partial matches.

5. As you work through the items, you must either designate that each a match or
ignored.

6. When all items are completed, click Complete Import.

7. At the Save Import Template dialog, click No to import without applying a template.
Or click Yes to either save a new template or edit the one you chose in step 3:
— To create a new template for this import, click New, then type an Import

Template Name.
— To edit a template, click Edit, then select the template from the drop down menu.

This will edit the template by adding the changes you made during matching.
This cannot be undone after you click OK.

8. Click OK.

The import is completed, and the new template is created, or the existing template is
edited to include the changes you made during matching.

Deleting a Template

You can delete any import template, even if it was applied during a previous import.

To do this:

1. Click Settings > Remove Import Templates.
2. At the Import Templates dialog, select the template you want to delete, then click

Delete.

The template is deleted.
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Understanding Tags
PowerLogic SCADA includes a variety of tag types: real-time, alarm, and trend. Most of
the tags that you will need are already added. However, you can add custom tags to
suit special needs. This section describes how tags are constructed and provides
further specific information about the construction of format codes, logic codes, and
addresses.

In this section, you can learn about:

IEC61850 Tag Construction on page 78

Defining an Enumeration on page 79

Format Code Definitions on page 80

Logic Codes on page 83

Using Block Writes on page 90

IEC61850 Tag Construction
IEC61850 tags have a great deal of flexibility, which allows them to specify the way that
functions are implemented in devices. The IEC61850 tag was developed for medium-
voltage and high-voltage applications, such as monitoring, control, and substation
automation.

Some of our devices include data and functionality that are not yet covered by
IEC61850. For these devices, the general IEC61850 formatting was followed when
creating tags.

If you are writing Cicode (see Using Cicode to Customize a Project on page 132). You
will need to know the IEC61850 tag name that you added to the device profile for that
device. You can print the .csv file to view tag names (see Printing the .CSV File on
page 39). Apart from that, you would only need to add tags if you are installing a third-
party device that is not standard to PowerLogic SCADA. If you do need to add tags,
create any category you wish, and follow the format shown below.

Tags shall be no longer than 29 characters. Use a backslash as a separator between
tag parts. Tags are constructed in this manner:

EquipmentName\Logical_Node\Data Object\Data Attribute (may have more than one)

The following table lists the main categories for the common logical nodes. After the
table, the most commonly used category (Mxxx: metering and measurement) is
described.

Category
Name Description

Axxx automatic control; e.g., ATCC (tap changer), AVCO (voltage control)

Cxxx supervisory control; e.g., CILO (interlocking), CSWI (switch control)

Gxxx generic functions; e.g., GGIO (generic I/O)

Ixxx interfacing/archiving; e.g., IARC (archive), IHMI (HMI)

Lxxx system logical nodes; e.g., LLNO (common), LPHD (physical device)

Mxxx metering andmeasurement; e.g., MMXU (measurement), MMTR (metering), MSTA (metering
statistics), MSQI (sequence and imbalance), MHAI (harmonics and interharmonics)

Pxxx protection; e.g., PDIF (differential), PIOC (instantaneous overcurrent or rate of rise.), PDIS
(distance), PTOV (time-overvoltage)

Rxxx protection related; e.g., RREC (auto reclosing), RDRE (disturbance)

Sxxx sensors, monitoring; e.g., SARC (arcs), SPDC (partial discharge)
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Category
Name Description

Txxx instrument transformer; e.g., TCTR (current), TVTR (voltage)

Xxxx switchgear; e.g., XCBR (circuit breaker), XCSW (switch)

Zxxx other equipment; e.g., ZCAP (cap control), ZMOT (motor)

The following example illustrates the IEC61850 tag for current A:

EquipmentName\MMXU1\A\PhsA

where:

M = the category

MXU = measurement of currents, voltages, power, and impedances

1 = the instance (there could be multiple MMXU tags)

A = the data object, current

PhsA = the attribute that further defines the data object, phase A

All of the tags that are currently used in the system can be viewed from the Profile
Editor, Define Device Type Tags tab. Click Settings > Display Advanced Properties to
display the full tag names.

Defining an Enumeration
An enumeration is a single value (0-15) that is used to define a condition that is
determined by multiple-bit input. You will add enumerations to handle scenarios that
are more complicated than simply true-false, to allow for dynamic contingencies. For
example, when you need to use multiple bits to describe the position of a circuit
breaker, you might do the following:

Bit y (closed) | Bit x (open). Note that the least significant bit is register 1.

Bit x | Bit y Status Circuit Breaker Position Returned
Value

0 | 0 Indeterminate Circuit breaker is neither open nor closed 0

0 | 1 Open Circuit breaker is open. 1

1 | 0 Closed Circuit breaker is closed. 2

1 | 1 Error
Circuit breaker is reporting both open and closed condition.

Possible device/wiring error
3

Using the enumerated status, we place the register and bitmask for the open position
in register 1 (least significant) and the register and bitmask for the closed position in
register 2 (most significant).

Using Special Tags to Control Circuit Breaker Status
When you want to include a device that does not have a pre-defined device profile
(such as a third-party circuit breaker), you must identify the registers that the device
uses for the operations you want, then choose the correct tags and tag addresses to
write to these registers. Finally, when creating the one-line on the graphics page, you
will choose the appropriate genie:
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1. Determine the device registers used for the open and close operations on the
circuit breaker.

2. In the Profile Editor, choose the tag needed for each operation.

3. Ensure that tag address references the correct action and register(s). See Editing
Tag Addresses on page 46 for instructions on editing the address,

4. When adding a genie for the circuit breaker on the graphics page, choose from the
default library (see Appendix 1: Default Genie Library on page 163), or create a
custom genie (see Creating and Editing Genies on page 123).

Format Code Definitions
The address field is part of the tag. It includes a variety of attributes, some of which are
required, and some optional. The following tables list the attributes, whether they are
required, and their possible modifiers. All parts of a tag are case sensitive. The order of
the fields is fixed; and all fields are separated by semi-colons. See Logic Codes on
page 83 for templates of constructed tags.
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Real-Time Format Code Definitions

Attributes Modifiers Comments

T (type)

Required

SS = single status

DS =double status
enumeration

ST = string

UT =UTC time

MV =measured value
(float)

CM =complex
measured value (float)

BC =binary counter
(integer)

Temporarily, this may return a string; when PowerLogic
SCADA is upgraded to handle large integers, this will change.

D (module—
Micrologic devices)

B = BCM

P= PM

M = MM

C = CCM

M/m/S/s/C/c/I/i
(register type)

M = holding registers in
hexadecimal

m = holding registers in
decimal

S = input coil (status
register) in hexadecimal

s = input coil (status
register) in decimal

C = output coil (writable
only) in hexadecimal

c = output coil (writable
only) in decimal

I = input register (read
only) in hexadecimal

i = input register (read
only) in decimal

Register Number
Modifiers (register
number from 1–4)

u## =## registers are
unsigned, ## is a
decimal

s## = ## registers are
signed; ## is a decimal

After themodifier, theremay be a number indicating scaling
factor. See “V,” below in this table. Used for conversion to SI
units, this number will be:

RegisterValue x scale

For SS and DS: theremust be a 1U default; themodifier will be
a bitmask:

- Themask must use hex only, 16 bits/register

- Attach the ones, then the zeromask, to the register; if you
only have ones masks, just attach them

- Only one register cases can be inverted. Add :I after the
masks for inversion.

N (scale) numerical entries; range
is -10 to 10

N defines a constant scale; the logic code knows how to use
it.

R (scale register) the register number in
decimal

R defines the holding register where the scale is held; the logic
code knows how to use it.

E (priority)

single digit: 1, 2, or 3;
default 2 is used if this is
not included

(1 = high, 2 = normal, 3 =
low)

Defines the priority PowerLogic SCADA uses in processing
data.

V (conversion factor) Use scientific notation
without the decimal.

Examples: 354E-3 = 0.354

354E1 =3540
Will bemultiplied before the value is returned.
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Attributes Modifiers Comments

L:P (logic code)

Required The number that is used
comes from the Logic
Codes table.

L:P is the logic code for PowerLogic. Other codes may follow,
such a L:I for ION.

For logic code descriptions, see Logic Codes on page 83

Alarm Format Code Definitions

Attributes Modifiers Comments

T (type)

Required
ALM =alarm

D (module—optional for Micrologic
devices)

B =BCM

P=PM

M =MM

C =CCM

BCM is straight addressing, and
therefore, optional.

F (file)

Required
File number will be in decimal, up
to 5 digits

Q (unique ID)

Required
Unique ID will be in decimal. This number can be huge.

Control Format Code Definitions Rules of Operation

These rules are true for predefined and custom codes:

Address structure Result

C:N;(action) If 1, perform action. If 0, undefined.

C:N;(action1);(action2)

C:NO;(action1);(action2)
If 1, perform action1. If 0, perform action 2.

C:NC;(action1);(action2) If 1, perform action2. If 0, perform action1

Predefined Control Format Codes

Attributes Modifiers Comments

C (command)

Required

NO=normally open

NC =normally closed

N =normal operation Normal operation does not have a closed/open status.

OPERATE (command word) n/a Two required for NO and NC.

Predefined Reset Format Codes

Attributes Modifiers Comments

Reset (command word) n/a Entering a one to this tag causes the reset to take place.
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Custom Control and Reset Format Codes

Attributes Modifiers Comments

C (command)

Required

NO=normally open

NC =normal closed

N =normal operation Normal operation does not have a
closed/open status.

Followed by one or two entire “write” addresses; used only for logic codes 101, 102, 103. For logic code
descriptions, see Logic Codes on page 83.

Write Address format: T:SS;m:##:#;L.:P:101

Example: C:NO;T:SS;m:1234:1;L:P101;T:SS;m:3456:1;L:P101

Logic Codes
Logic codes tell the SCADA program how to mathematically operate on the values in
device registers to give users the desired values. The following table lists each logic
code with its related information.
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Logic
Code

IEC
Type

PowerLogic
SCADA
Data Type

Register
Definition

Scaled
Required?
(register
or fixed)

Device
Specific? Notes

READS

Invalid Block

(L:P:0)

IB LONG
Up to 1,000
sequential
registers

No Generic only Defines invalid blocks of memory in the device. The
driver does not include these registers in block reads.

Date / Time
(L:P:1)
(3 register)

UT LONG 3 sequential
registers No Generic – if it

fits

Register N:
High byte =Month 1–12
Low byte =Day 1–31

Register N+1:
High byte =Year 0–199 (+1900)

Low byte =Hour 0–23

Register N+2:
High byte =minutes 0–59
Low byte = seconds 0–59

Date / Time
(L:P:2)
(6 register)

UT LONG 6 sequential
registers No

Generic

- if it fits

Register N: Seconds 0–59
Register N+1: Minutes 0–59
Register N+2: Hours 0–23
Register N+3: Day 1–31
Register N+4: Month 1–12
Register N+5: Year 0–199 (+1900)

Date / Time
(L:P:3)
(3 or 4
register --
Circuit
Monitor/
Power
Meter)

UT LONG
3 or 4
sequential
registers

No CM/PM

Register N:
High byte =Month 1–12,
Low byte =Day 1–31

Register N+1:
High byte =Year 0–199 (+1900)

Low byte =Hour 0–23

Register N+2:
High byte =minutes 0–59
Low byte = seconds 0–59

Register N+3:
msec = 0–999 (unused)

Date / Time
(L:P:4)
(3 or 4
registers
SEPAM)

UT LONG
3 or 4
sequential
registers

No SEPAM

Register N:
Bits 0–6 =Year: 0 –70 (2000– 2070)

71 – 99 (1971–1999)

Register N+1:
Bits 8-11 =Month

Bits 0-4 =Day

Register N+2:
Bits 8-12 =Hour

Bits 0-5 =Minutes

Register N+3: msec = 0-59,999
(seconds arems/1000)

Date/Time

(L:P:5)

3-register
Micrologic

UT LONG 3 sequential
registers No micro

Register N:
High byte =Month 1–12,
Low byte =Day 1–31

Register N+1:
High byte =Year 0–69 (+2000), Year 70–99 (+1900)

Low byte =Hour 0–23

Register N+2:
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Logic
Code

IEC
Type

PowerLogic
SCADA
Data Type

Register
Definition

Scaled
Required?
(register
or fixed)

Device
Specific? Notes

High byte =minutes 0–59
Low byte = seconds 0–59

Date/Time

(L:P:6)

4-register
Micrologic

UT LONG 4 sequential
registers No micro

Register N:
High byte =Month 1–12,
Low byte =Day 1–31

Register N+1:
High byte =Year 0–69 (+2000), Year 70–99 (+1900)

Low byte =Hour 0–23

Register N+2:
High byte =minutes 0–59
Low byte = seconds 0–59

Register N+3:
msec = 0–999 (unused)

Date/Time

(L:P:7)

2-register
Argos

UT LONG 2 sequential
registers No Argos

The number of seconds since 01/01/2000 (00:00:00)

register 1 =MSB

register 2 = LSB

Modulo 10k
(L:P:10) BC STRING Up to 4

registers No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999,999

Each register has a range of 0 to 9,999

Result is:
– R4*10,000^3 +R3*10,000^2 +R2*10,000 +R1

Modulo 10k
Val

(L:P:11)
BC REAL Up to 4

registers No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999,999

Each register has a range of 0 to 9,999

Result is:
– R4*10,000^3 +R3*10,000^2 +R2*10,000 +R1

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Modulo 10k
Energy

(L:P:12)
BC STRING Up to 4

registers No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999.9

Each register has a range of 0 to 9,999

Result is
– (R4*10,000^3 +R3*10,000^2 +R2*10,000 +R1)/1000

Modulo 10k
Energy Val

(L:P:13)
BC REAL Up to 4

registers No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999.9

Each register has a range of 0 to 9,999

Result is
– (R4*10,000^3 +R3*10,000^2 +R2*10,000 +R1)/1000

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

© 2011 Schneider Electric All Rights Reserved 85



Logic
Code

IEC
Type

PowerLogic
SCADA
Data Type

Register
Definition

Scaled
Required?
(register
or fixed)

Device
Specific? Notes

PLDigital
Input SS

(L:P:20)
SS LONG 2 registers No CM/PM

First register (100–199 inclusive) indicates that this is a
digital input register.

Second register is masked to test for either one 1 or one
0.

Result is: 0 = off and 1 =on.

This result can be inverted.

PL Digital
Input DS

(L:P:21)
DS LONG 2 registers No CM/PM

Same as PLDigital Input SS except:

Result is 0 = intermediate, 1 = off, 2 = on, 3 = bad-state.

Inversion will invert only off and on states.

PL Digital
Input TF

(L:P:22)
SS DIGITAL 2 registers No CM/PM

Same as PLDigital Input SS except:

Result is: 0 = false and 1 = true.

This result can be inverted.

PL Digital
Output SS

(L:P:23)
SS LONG 2 registers No CM/PM

First register (200–299 inclusive) indicates that this is a
digital output register.

Second register is masked to test for either one 1 or one
0.

Result is: 0 = off and 1 =on.

This result can be inverted.

PL Digital
Output DS

(L:P:24)
DS LONG 2 registers No CM/PM

Same as PLDigital Output SS, except:

Result is:
0 = intermediate, 1 = off, 2 = on, 3 = bad-state.

Inversion will invert only off and on states.

PL Digital
Output TF

(L:P:25)
SS DIGITAL 2 registers No CM/PM

Same as PLDigital Output SS except:

Result is: 0 = false and 1 = true.

This result can be inverted.

Status SS
(L:P:26) SS LONG Up to 4

registers No Generic

Each register is compared to a ones’ mask. Optionally it
can be compared to a zeros’ mask. (Use the Edit
Address screen in the Profile Editor to createmasks for
the user.)

Result is: 0 = off and 1 =on.

If there is only one register, the result can be inverted.

Status OR
SS

(L:P:226)
SS LONG 2 to 4

registers No Generic

Each register is compared to a ones’ mask. These
results are OR’ed together. Optionally, it can be
compared to a zeros’ mask. (Use the Edit Address
screen in the Profile Editor to createmasks for the user.)

Result is: 0 = off and 1 =on.

Status DS
(L:P:27) DS LONG Up to 4

registers No Generic

Same as Status SS except:

Result is: 0 = intermediate, 1 = off, 2 = on, 3 = bad-state.

Inversion will invert only off and on states.

Status OR
DS

(L:P:227)
DS LONG 2 to 4

registers No Generic
Same as Status OR SS except:

Result is: 0 = intermediate, 1 = off, 2 = on, 3 = bad-state.

Status TF
(L:P:28) SS DIGITAL Up to 4

registers No Generic

Same as Status SS except:

Result is: 0 = false and 1 = true.

This result can be inverted.

Status OR
TF

(L:P:228)
SS DIGITAL 2 to 4

registers No Generic
Same as Status OR SS except:

Result is: 0 = false and 1 = true.

Status Int
(L:P:29) BC LONG 1 register No CM/PM

One register is bit anded with onemask. The result will
be an integer that can be used to choose the appropriate
enumeration.
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Logic
Code

IEC
Type

PowerLogic
SCADA
Data Type

Register
Definition

Scaled
Required?
(register
or fixed)

Device
Specific? Notes

Status
Enumeration

(L:P:229)
EN LONG 1 to 4

registers No Generic

Each register is compared to a ones’ mask. Optionally it
can be compared to a zeros’ mask. (Use the Edit
Address screen in the Profile Editor to createmasks for
the user.)

Result is a combination of the results for each register,
using this formula:

result for register 1 * 2^0 + result for register 2 * 2^1 +
result for register 3 * 2^2 + result for register 4 * 2^3

PL Analog
Input

(L:P:30)
MV/CM REAL 3 registers No CM/PM

First register (300–399 inclusive) indicates that this is a
analog input register.

Second register is treated as a signed value.

Third register can contain a value from –3 to 3 and will be
used to scale the second register (R2*10^R3).

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

PL Analog
Output

(L:P:31)
MV/CM REAL 2 registers No CM/PM

First register (400–499 inclusive) indicates that this is a
analog output register.

Second register is treated as a signed value.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Scaled
Register
Signed

(L:P:32)

MV/CM REAL 1 or 2
registers

Either

(optional)
Generic

For a single register: treated as a signed value from
–32,767 to +32,767. (-32768 will result in a NA)

For two registers: the registers will be concatenated
together, the first register filling bits 16–32 and the
second register filling bits 0–15. Values will range from

–2,147,483,648 to –2,147,483,647.

Values can be scaled using a fixed scale or a scale
register.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Scaled
Register
Unsigned

(L:P:33)

MV/CM REAL 1 to 4
registers

Either

(optional)
Generic

For a single register: treated as an unsigned value from
0 to 65,535.

For two registers: the registers will be concatenated
together, the first register filling bits 16–32 and the
second register filling bits 0–15. Values will range from

0 to 4,294,967,295.

Values can be scaled using a fixed scale or a scale
register.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Scaled
Register
Signed No
NA

(L:P:34)

MV/CM REAL 1 or 2
registers

Either

(optional)
Generic

Same as Scaled Register except that a single register
with value -32768 is acceptable and will be reported as
such.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Scaled
Register
Signed
SEPAM A

(L:P:35)

MV/CM REAL 2 registers
Either

(optional)
Generic

Same as Scaled Register except that 0xFFFFFFFF or
0x00007FFF will be NA.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.
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Register
Definition

Scaled
Required?
(register
or fixed)

Device
Specific? Notes

Scaled
Register
Signed
SEPAM B

(L:P:36)

MV/CM REAL 2 registers
Either

(optional)
Generic

Same as Scaled Register except that 0xFFFFFFFF will
be NA.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

IEEE 32
Real

(L:P:37)
MV/CM REAL 2 sequential

registers No Generic

Uses the IEEE standard for floating-point arithmetic
(IEEE 754);

register 1 is MSB, register 2 is LSB

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Scaled
Register
Signed
SEPAM
2000 Format
B

(L:P:38)

MV/CM REAL 1 register
Either

(optional)
Generic

For a single register: treated as a signed value from
–32,767 to +32,767:

From the value of the unsigned register, subtract 32768;
then apply the scale.

0000 or FFFF will be NA.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

PL String
(L:P:39) ST STRING

1 to 10
sequential
registers

No Generic Each register can represent up to two ASCII characters.

Sum
Registers
(L:P:40)

MV/CM REAL 1 to 4
registers

Either

(required)
Generic

Result is:

R1 +…+Rn * 10^scale

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Divide
Registers

(L:P:41)
MV/CM REAL 3 registers

Either

(required)
Generic

Result is:

R1/R2 * R3 * 10^scale

If R2 is zero, result will be #COM

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Multiply
Registers

(L:P:42)
MV/CM REAL 1 to 4

registers
Either

(required)
Generic

Result is:

R1 * … * Rn * 10^scale

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Average
Registers

(L:P:43)
MV/CM REAL 1 to 4

registers
Either

(required)
Generic

Result is:

Avg(R1…Rn) * 10^scale

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Average
Registers
WF

(L:P:44)

MV/CM REAL 2 to 4
registers

Either

(required)
Generic

Result is:

Avg(R1…Rn-1) * Rn * 10^scale

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Sum with
Scale

(L:P:45)
MV/CM REAL 2 registers

Either

(required)
CM/PM

Result is:

(R1 * 10^scale) +R2

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.
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Logic
Code

IEC
Type

PowerLogic
SCADA
Data Type

Register
Definition

Scaled
Required?
(register
or fixed)

Device
Specific? Notes

Sum with
Scale
Unsigned
(L:P:46)

MV/CM REAL 2 registers
Either

(required)
CM/PM

Result is same as above, except unsigned.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Vector Math

(L:P:47)
MV/CM REAL 2 registers Either

(required) Generic

Result is:

sqrt (R1^2 +R2^2) x scale

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Vector Math
IEEE

(L:P:48)
MV/CM REAL 4 registers Either

(required) Generic

Result is:

sqrt ([R1 R2]^2 + [R3 R4]^2) x scale

where [ ] indicates IEEE32 representation

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

CM4 Power
Factor IEEE

(L:P:50)
MV/CM REAL 1 register No CM4 Returns the IEEE power factor.

PM8 Power
Factor IEEE

(L:P:51)
MV/CM REAL 1 register No PM8

Returns the IEEE power factor (converted from IEC
mode as necessary).

The devicemay be in IEEE or IEC mode if the device
firmware version is 11.6 or higher. If the device firmware
version is below 11.6, IEC mode is not supported.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

SP40 Power
Factor IEEE

(L:P:52)
MV/CM REAL 1 register No SEPAM 40

Returns the IEEE power factor (converted from IEC
mode).

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

ML Power
Factor IEEE

(L:P:53)
MV/CM REAL 2 registers No ML

Returns the IEEE power factor (converted from IEC
mode as necessary).

The second input register must be the associated
Reactive Power for the Power Factor requested.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Generic
Power
Factor

(L:P:54)

MV/CM REAL 2 registers No Generic

R2/sqrt (R2^2 +R1^2)

where:

R2 = real power
R1 = reactive power

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Generic
Power
Factor -
IEEE32
variation

(L:P:55)

MV/CM READ 4 registers No Generic

[R3 R4]/

sqrt ([R3 R4]^2 + [R1 R2]^2)

where:

R3 = real power IEEE32MSR

R4 = real power IEEE32 LSR
R1 = reactive power IEEE32 MSR

R2 = reactive power IEEE32 LSR
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Device
Specific? Notes

SP2000
Power
Factor IEEE

(L:P:56)

MV/CM REAL 1 register No SEPAM 2000

Returns the IEEE power factor (converted from IEC
mode).

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

WRITES (these are write-only; see below for Read/Write codes)

NOTE: If the device is capable of preventing (blocking) writes to its registers, verify that the "block" feature is disabled before you implement the write.

Status Write
Register

(L:P:101)
SS LONG 1 register No Generic If you input 1 to this tag it will write theMASK value to

the register.

Status Write
Register
AND

(L:P:102)

SS LONG 1 register No Generic
If you input 1 to this tag it will read the register andAND
theMASK with the register (This puts a 0 whereever
there is a 1 in themask and leaves the rest alone).

Status Write
Register OR

(L:P:103)
SS LONG 1 register No Generic

If you input 1 to this tag it will read the register andOR
theMASK with the register (This puts a 1 whereever
there is a 1 in themask and leaves the rest alone).

Write
Register
Unsigned

(L:P:110)

MV/CM REAL 1 register Either Generic

This will take the input value read in and divide out the
scale factor and the conversion factor. It will then round
to the nearest whole number and if it is a value from 0 to
65535 it will put this value in the register.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

Write
Register
Signed

(L:P:111)

MV/CM REAL 1 register Either Generic

This will take the input value read in and divide out the
scale factor and the conversion factor. It will then round
to the nearest whole number and convert the signed
value to an unsigned value from 0 to 65535. It will put
this value in the register.

NOTE: This logic code (and all REAL logic codes) has
an accuracy of seven digits. Anything longer than seven
digits should not be considered accurate.

READ/WRITES

Read/Write
Holding
Register

(L:P:120)

MV/CM LONG 1 register No Generic You can write any value from 0 to 65535 and read an
unsigned value from the same register.

Read/Write
Coil
Register

(L:P:121)

SS DIGITAL 1 register No Generic You can write 0 or 1 and read a value from the same
register.

Using Block Writes
Block writes represent blocks of registers that are updated in a single write operation.
There are two types of block writes:
• fixed: fully specified and compiled before run time. Writing the value of ‘1’ to such a

variable tag causes the specified fixed values to be written to the specified
registers.
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• variable: specified on the fly. The registers and the values to be written are not
fixed; they are specified during run time by the user.

Fixed block writes have the following format:

T:BWF;[D:{B|C|M|P};]S:<start_register>,<values>

where

B, C, M, or P are applicable only to Micrologic devices (otherwise the D: section
is omitted) and is the module (manager) identifier (Circuit Breaker, Chassis,
Metering, Protection).

<start_register> is the first register number for a contiguous block of registers.

<values> is a comma-separated list of up to 10 values that will be written to the
registers starting from <start_register>.

For example:
T:BWF;S:100,1,2,3,4,-5

Variable block writes have the following format:
where

B, or C, or M, or P is applicable only to Micrologic devices (otherwise the D:
section is omitted altogether) and is the module (manager) identifier (Circuit
Breaker, Chassis, Metering, Protection)

For example:
T:BWV;

The start register and the values to be written follow exactly the same rules and syntax
as the definition for the Fixed Block Write, however, these are specified at the time the
write operation is performed. For example, specifying “S:100,1,2,3,4,-5” as the
write value for the tag “T:BWV;“ would write values 1,2,3,4, and -5 to the registers 100,
101, 102, 103, and 104.
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The Profile Wizard
This chapter discusses how to use the Profile Wizard to add an individual device
profile to, or remove it from, a PowerLogic SCADA project. From the Profile Editor, you
export profile data into a file that is available to be imported into a PowerLogic SCADA
project. From there, use the Profile Wizard to add the device profile into the
PowerLogic SCADA project. Real-time tags, control tags, and alarm tags in the Profile
Editor become variable tags in PowerLogic SCADA. Alarm tags will also have a
second tag in time-stamped digital alarms or time-stamped analog alarms, depending
on whether they are on-board or PC-based.

To add a small number of profiles to the PowerLogic SCADA project, it makes sense to
use the Profile Wizard. However, when you want to add a very large number of profiles,
use the Automation Interface to save time. This feature allows you to add multiple
devices in a single step. For information, see Adding Multiple Devices through the
Automation Interface on page 107 for information.

Throughout the Profile Wizard, there are fields that will only accept a valid entry. They
are marked with a red asterisk (!). The asterisk remains there until you enter a
response that is of the correct length or includes only the acceptable characters. The
asterisk disappears when you have entered a valid response.

In this section, you will find these topics:

Before You Use the Profile Wizard on page 93

Adding the Cluster, Network Address, and Servers on page 93

When Setting Up More than two I/O Servers per Cluster on page 95

Using the Wizard to Add and Remove Devices on page 97

Adding a Device to a PowerLogic SCADA Project on page 97

Adding a TCP Device to a PowerLogic SCADA Project on page 97

Adding a Serial Device to a PowerLogic SCADA Project on page 99

Adding a DNP3_TCP Device on page 101

Adding an IEC61850 Device to a PowerLogic SCADA Project on page 103

Naming Ports on page 105

Removing a Device From the PowerLogic SCADA Project on page 106

Editing Devices in a PowerLogic SCADA Project on page 105

Adding Multiple Devices through the Automation Interface on page 107

Using the OLE Automation Interface to Add and Remove Devices on page 109

Examples on page 109

Command Line Interface on page 110

Interface Workflow on page 110
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Before You Use the Profile Wizard
Before you can add device profiles, you need to establish the folder structure and
network addresses in the PowerLogic SCADA project: Launch the PowerLogic SCADA
software: click Start > Programs > Schneider Electric > PowerLogic SCADA 7.20 >
PowerLogic SCADA Explorer. Three windows display:
• Citect Project Editor
• Citect Explorer
• Citect Graphics Builder

Have a copy of each device’s connection information: communications protocol and IP
address. You will enter this information when you add the devices.

In Citect Explorer, add a project that has the same name as the one set up in the Profile
Editor (File > New Project). Then add the following configuration records in the Project
Editor (Servers):
• at least one cluster; A cluster is a group of alarms servers, trends servers, reports

servers, and I/O servers. For additional information about clusters, see Clustering in
the CitectSCADA.chm help file (Start > Programs > Schneider Electric >
PowerLogic SCADA 7.20 > PowerLogic SCADA Help).

• a network server address for each cluster: The name added here is linked to the
IP address. This is the address to be used by all of the servers in the cluster. When
using the host computer as the server, you can use the IP loopback address:
127.0.0.1.

• at least one of each relevant type of server: There are four types of server: alarm,
report, trend, and IO.

NOTE: When naming these servers, do not use the following names: IO_Server,
Report_Server, Alarm_Server, Trend_Server, and Client. These names are used in
Citect. Adding them here will cause a compilation error.

An alarm server monitors all alarms and displays an alarm on the appropriate
client(s) when an alarm condition becomes active.

A reports server controls report processing; you can request reports at any time or
when specific events occur.

A trends server controls the accumulation and logging of trend information; this
information provides a current and historical view of the system, and can be
processed for display on a graphics page or printed in a report.

AnI/O server is a dedicated communications server that exchanges data between
I/O devices and PowerLogic SCADA Control Clients.

• a project to PowerLogic SCADA: Then compile and correct any errors. After the first
compile, run the Computer Setup Wizard (Project Editor > Tools > Computer Setup
Wizard. This wizard prepares the computer for use with PowerLogic SCADA.

NOTE: When running the Computer Setup Wizard, do not change the startup page
(leave the ini settings as <default>). Changing the startup page at this point will
result in navigation problems. To change the startup page, see Setting a New Page
as the Project Startup Page on page 118.

Adding the Cluster, Network Address, and Servers
Follow these steps to add the network address, which consists of at least one cluster,
servers, and the related IP address. Each project must have at least one cluster, a
network address, and one of each type of server that will be used. Clusters are used to
logically and/or physically separate the servers in a system. Having multiple clusters
on a large project (called scaleability) will help maintain system performance.

1. From the Citect Explorer screen, display the project: In the upper left corner of the
screen, choose the project from the drop-down menu.
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2. From the Project Editor screen, click Servers > Clusters.

3. At the Cluster screen, type the cluster name.

For the cluster to be able to communicate with system devices, its name must be
between two and 16 characters, no spaces. It must be unique to the project.

If there is only one cluster, the system will always automatically choose it for a
project. If there are multiple clusters, you will always have to select the one that you
want.

4. If desired, type a description in the Comment field.

This field can be used for translation purposes. See Entering Copy for Translation
on page 96 for more information.

5. Click Add.

The new cluster name displays in the window.
6. Close the Cluster window.

If a cluster already exists, you can add a new one: with the existing name
displayed, click Replace to create a duplicate of the existing one; overwrite the
name of the one you just added; finally click Add to save the name that you just
typed. Both clusters will be in the system. To view all of the clusters added to this
project, use the scroll bar on right side of the window.

7. Still on the Citect Explorer screen, click Servers > Network Addresses.

Adding network servers enables you to handle data from large installations, and to
use multiple servers.

8. At the Network Addresses screen, type a name for the network server; then enter
the IP address for this server. This is the address that all of the servers in this
project will use. If the servers are on the local machine, you can use the loopback
address (127.0.0.1).

The Comment field can be used for translation purposes. See Entering Copy for
Translation on page 96 for more information.

9. Click Add, then exit the screen to save the server name.

10.Note the name so that you can re-use it for the remaining servers.

11.To add an alarm server, click Servers > Alarm Servers.

12.At the Alarm Servers screen, follow these steps:
— At the Cluster Name screen, choose the cluster you will use for this server.
— At the Network Addresses field, choose the network name that you added for

this system.
— In the Mode field, you can specify whether this server is primary or standby. The

standby server will act as a backup, providing redundancy in case the primary
server goes down.

— In the Port field, select whether this is a primary or standby server (default:
primary). You can have one primary and one standby server for each cluster.
An additional set of prompts displays when you “expand” the screen. To
expand, click F2 when the Alarm Servers screen is active. In the Publish Alarm
Properties, choose whether alarm properties will be viewable as variable tags
(default = false). If you set it to true, the alarm server monitors the port you
specify as if it were an I/O connector.

— Click add to save the new alarm server. Exit the window.
13.Repeat steps 11 and 12 for all other server types that you need to add.

NOTE: When you delete a cluster, you need to also click File > Pack to completely
delete it from the system.

14.Click File > Compile.

15. If there are errors and/or warnings after the page is compiled, do the following:
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a. At each error, click GoTo, which opens the location where the error has
occurred.

b. Using the information in the error message, correct the error.
c. After all errors are addressed, re-compile to verify that the errors have been

removed.

For additional information, click Help at the error screen.

When Setting Up More than two I/O Servers per Cluster
If you need to add more than two I/O servers to a cluster, you need to define a
redundant I/O device called NetworkTagsDev for each of the servers. If you do not do
this, you can lose device status information during runtime.

If the cluster includes only one or two I/O servers, the I/O devices are automatically
added when you add the cluster during Profile Wizard configuration (see Adding the
Cluster, Network Address, and Servers on page 93). If a system has more than two I/O
servers in a cluster, you must manually add the NetworkTagsDev I/O device for the
remaining servers (after the first pair).

To create the board, port, and NetworkTagsDev I/O device, ensure the following in
PowerLogic SCADA:
• all redundant NetworkTagsDev I/O devices have the same number
• the Startup Mode field is set to Standby; do this for all standby NetworkTagsDev I/O

devices, including the one created by the Profile Wizard
• the Equipment field is set to <Cluster>_NetworkTagsDev

The field values for the forms in each of the I/O servers should be:

Boards Form
Board Name: <any unique name> (suggestion: BOARDy_SVRz)
Board Type: DISKXML
Address: 0
Leave everything else blank.

Ports Form
Port Name: <any unique name> (suggestion: PORTx_BOARDy_SVRz)
Port Number: <any unique number within the I/O server> (suggestion: x)
Board Name: <use the board name defined above>
Leave everything else blank.

I/O Devices Form
Name: NetworkTagsDev
Number: <same number as the one defined in the corresponding device>
Address: NetworkTagsDev
Protocol: DISKXML
Port Name: <use the port name defined above>
Startup Mode: Standby
Equipment: <Cluster> _NetworkTagsDev
Leave everything else blank.

Notes:
• Startup Mode is only visible when in extended form mode (press F2 to toggle

between simple form mode and extended form mode, while in the I/O device form).
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• The Equipment field is hidden by default. To change it to visible, open units.dbf (in
the project folder) in Excel.

• If the system has one or two I/O servers per cluster, the startup mode of the standby
NetworkTagsDev I/O device could be set to StandbyWrite in the Profile Wizard. If
the system has more than two I/O servers per cluster, the startup mode of all
standby NetworkTagsDev I/O devices must be set to Standby.

One side effect of this is that, when the system "fails over to a redundant I/O server,"
affected devices will momentarily be in communication failure as the system
transitions to the redundant server.

• If the primary and redundant alarms servers are synchronizing, data will be slow to
display in the Alarm Log and Events Log.

Entering Copy for Translation
There are several “description” or “comment” fields throughout this tool. These fields
can be used to create copy for translation purposes. If you type a Comment in this
format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerLogic SCADA
7.20\User\[your project](for Vista operating systems: ProgramData\Schneider
Electric\PowerLogic SCADA 7.20\User\[your project]). English.dbf contains terms that
will be translated from English.

To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the project
folder when you compile. You can then enter the translated text in the LOCAL field of
the file. Repeat this same step for each additional language file you want in this
project.

After translation, there will be an additional .dbf file for each translated language. At
runtime, the user will be able to choose the .dbf file that is to be used in the display,
thus changing the language used in the display.
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Using the Wizard to Add and Remove Devices
This section describes how to use the Profile Wizard to manage device information in a
PowerLogic SCADA project. Before you begin adding devices, make sure you have
completed the tasks described in Before You Use the Profile Wizard on page 93.

You will use these procedures to add remove, or edit device data:

Adding a Device to a PowerLogic SCADA Project on page 97

Adding a TCP Device to a PowerLogic SCADA Project on page 97

Adding a Serial Device to a PowerLogic SCADA Project on page 99

Adding a DNP3_TCP Device on page 101

Adding an IEC61850 Device to a PowerLogic SCADA Project on page 103

Naming Ports on page 105

Removing a Device From the PowerLogic SCADA Project on page 106

Editing Devices in a PowerLogic SCADA Project on page 105

Adding Multiple Devices through the Automation Interface on page 107

Adding a Device to a PowerLogic SCADA Project
The Profile Wizard allows you to add one device at a time. To add more than one
device at a time, you can use the Automation Interface. See Adding Multiple Devices
through the Automation Interface on page 107 for instructions.

Click one of the following links to display instructions for each type of protocol:

Adding a TCP Device to a PowerLogic SCADA Project on page 97

Adding a Serial Device to a PowerLogic SCADA Project on page 99

Adding a DNP3_TCP Device on page 101

Adding an IEC61850 Device to a PowerLogic SCADA Project on page 103

Adding a TCP Device to a PowerLogic SCADA Project
Use this procedure when you want to add a generic TCP or Modbus TCP device to a
PowerLogic SCADA project. Note that these instructions assume that you have two I/O
servers, and that you will be renaming ports.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Adding the Cluster, Network Address, and
Servers on page 93).

Then, make sure that you have set up each of these clusters in the Profile Wizard:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerLogic
SCADA before you do this):

1. From the Profile Wizard, under System Devices, click Cluster Setup. Click Next.
2. At the Enter Instance Information screen, a cluster name displays. Click Next.

3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster
you want to set up. Click Next.
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4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.
Check Supports Redundancy and select the I/O servers to which you want to add
the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen Setting Up More than two I/O Servers per Cluster).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3a through 3e for each
cluster.

When you are finished adding clusters and I/O servers, you return to the Profile
Wizard welcome screen.

Adding the TCP Device

Follow these steps to add TCP devices:

1. From the Citect Explorer screen, display the project to which you want to add the
devices: In the upper left corner of the screen, choose the project from the drop-
down menu.

2. From the Citect Project Editor, click Tools > Profile Wizard.

The Profile Wizard welcome screen displays.
3. Click Create an I/O Device in the project, then click Next.

4. At the Choose profile screen, select the first device profile that you want to use to
add a device to the PowerLogic SCADA project. Click Next.

5. At the Enter instance information screen, type a descriptive profile name, for
example: CM4Bay1Circuit1 (no spaces or punctuation; to allow space in
PowerLogic SCADA, the preferred limit is 16 characters). The Comment field is
stored in the equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the
PowerLogic SCADA product. These fields can be used to create copy for
translation purposes. If you type a Comment in this format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerLogic SCADA
7.20\User\[your project](for Vista operating systems: ProgramData\Schneider
Electric\PowerLogic SCADA 7.20\User\[your project]). English.dbf contains terms
that will be translated from English.

To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

Click Next.
6. At the Select I/O servers screen, choose the primary and standby servers. You can

only set the standby server if you check the "Supports Redundancy" box. Click
Next.

7. At the Configure Sub-Profile Communications Method screen, choose the
communications method used for the first sub-profile in this project. Click Next.

98 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 The ProfileWizard
06/2011



The ProfileWizard 63220-100-200E1
06/2011

8. At the Communications Settings screen, type the gateway address and station
address for each of the servers. If you check the "Same as Primary" box for standby,
you will use the same addresses for the primary and standby. Click Next.

9. At the Port Settings screen, you can rename each of the ports. A new port will be
generated for each new name. Click Next. (See more information about naming
ports in Naming Ports on page 105.)

10.Repeat steps 6 through 8 for each of the sub-profiles in this project.

11.At the Ready to perform action screen, click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.

To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
8.

12.When you have finished adding devices, uncheck the Add/remove more equipment
option, then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the Profile Wizard closes. If you checked
the Add/remove ... box, the Welcome screen displays again.

13.From any of the three PowerLogic SCADA screens, compile the project.

14.When all errors are corrected, click File > Run to view the runtime environment.

Adding a Serial Device to a PowerLogic SCADA Project
Use this procedure when you want to add a generic serial or DNP3 via serial device to
a PowerLogic SCADA project. Note that these instructions assume that you have two
I/O servers, and that you will be renaming ports.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Adding the Cluster, Network Address, and
Servers on page 93).

Then, make sure that you have set up each of these clusters in the Profile Wizard:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerLogic
SCADA before you do this):

1. From the Profile Wizard, under System Devices, click Cluster Setup. Click Next.
2. At the Enter Instance Information screen, a cluster name displays. Click Next.

3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster
you want to set up. Click Next.

4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.
Check Supports Redundancy and select the I/O servers to which you want to add
the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen Setting Up More than two I/O Servers per Cluster).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3a through 3e for each
cluster.

When you are finished adding clusters and I/O servers, you return to the Profile
Wizard welcome screen.
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Adding the Serial Device

Follow these steps to add serial devices.

1. From the Citect Explorer screen, display the project to which you want to add the
device: In the upper left corner of the screen, choose the project from the drop-
down menu.

2. From the Citect Project Editor, click Tools > Profile Wizard.

The Profile Wizard welcome screen displays.

Click Create an I/O Device in the project, then click Next.
3. At the Choose profile screen, select the first device profile that you want to use to

add a device to the PowerLogic SCADA project. Click Next.

4. At the Enter instance information screen, type a descriptive profile name, for
example: CM4Bay1Circuit1 (no spaces or punctuation; to allow space in
PowerLogic SCADA, the preferred limit is 16 characters). The Comment field is
stored in the equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the
PowerLogic SCADA product. These fields can be used to create copy for
translation purposes. If you type a Comment in this format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerLogic SCADA
7.20\User\[your project](for Vista operating systems: ProgramData\Schneider
Electric\PowerLogic SCADA 7.20\User\[your project]). English.dbf contains terms
that will be translated from English.

To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

Click Next.
5. At the Select I/O servers screen, choose the primary and standby servers. You can

add information for the standby server if you check the "Supports Redundancy"
box. Click Next.

6. At the Configure Sub-Profile Communications Method screen, choose the
communications method used for the first sub-profile in this project. Click Next.

7. At the Communications Settings screen, type all of the information for each server
(com port, baud rate, etc.). If you check the "Same as Primary" box for standby, you
will use the same addresses for the primary and standby. Click Next.

8. At the Port Settings screen, you can rename each of the ports. (See more
information about naming ports in Naming Ports on page 105.)

9. Repeat steps 6 through 8 for the remaining sub-profiles.

10.When you finish adding the last sub-profile, the Ready to perform action screen
displays Click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.
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To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
8.

11.When you have finished adding devices, click Finish at the Project updated
successfully screen.

If you checked the View audit ... box, the list displays.

The Profile Wizard closes.
12.From any of the three PowerLogic SCADA screens, compile the project.

13.When all errors are corrected, click File > Run to view the runtime environment.

Adding a DNP3_TCP Device
Use this procedure when you want to add a DNP3_TCP device to a PowerLogic
SCADA project. Note that these instructions assume that you have two I/O servers, and
that you will be renaming ports.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Adding the Cluster, Network Address, and
Servers on page 93).

Then, make sure that you have set up each of these clusters in the Profile Wizard:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerLogic
SCADA before you do this):

1. From the Profile Wizard, under System Devices, click Cluster Setup. Click Next.
2. At the Enter Instance Information screen, a cluster name displays. Click Next.

3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster
you want to set up. Click Next.

4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.
Check Supports Redundancy and select the I/O servers to which you want to add
the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen Setting Up More than two I/O Servers per Cluster).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3a through 3e for each
cluster.

When you are finished adding clusters and I/O servers, you return to the Profile
Wizard welcome screen.

Adding the DNP3_TCP Device

Follow these steps to add TCP devices:

1. From the Citect Explorer screen, display the project to which you want to add the
devices: In the upper left corner of the screen, choose the project from the drop-
down menu.

2. From the Citect Project Editor, click Tools > Profile Wizard.

The Profile Wizard welcome screen displays.

Click Create an I/O Device in the project, then click Next.
3. At the Choose profile screen, select the first device profile that you want to use to

add a device to the PowerLogic SCADA project. Click Next.
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4. At the Enter instance information screen, type a descriptive profile name, for
example: CM4Bay1Circuit1 (no spaces or punctuation; to allow space in
PowerLogic SCADA, the preferred limit is 16 characters). The Comment field is
stored in the equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the
PowerLogic SCADA product. These fields can be used to create copy for
translation purposes. If you type a Comment in this format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerLogic SCADA
7.20\User\[your project](for Vista operating systems: ProgramData\Schneider
Electric\PowerLogic SCADA 7.20\User\[your project]). English.dbf contains terms
that will be translated from English.

To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

Click Next.
5. At the Select I/O servers screen, choose the primary and standby servers. You can

only set the standby server if you check the "Supports Redundancy" box. Click
Next.

6. At the Configure Sub-Profile Communications Method screen, choose the
communications method used for the first sub-profile in this project. Click Next.

7. At the Communications Settings screen, type the IP address, port number, and
device address for each of the servers.

NOTE: The DNP3 port number is by definition 20000. You must type 20000 here in
order for communications to work correctly.

If you check the "Same as Primary" box for standby, you will use the same
addresses for the primary and standby. Click Next.

8. At the Port Settings screen, you can rename each of the ports. A new port will be
generated for each new name. Click Next. (See more information about naming
ports in Naming Ports on page 105.)

9. Repeat steps 6 through 8 for each of the sub-profiles in this project.

10.At the Ready to perform action screen, click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.

To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
8.

11.When you have finished adding devices, uncheck the Add/remove more equipment
option, then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the Profile Wizard closes. If you checked
the Add/remove ... box, the Welcome screen displays again.
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12.From any of the three PowerLogic SCADA screens, compile the project.

13.When all errors are corrected, click File > Run to view the runtime environment.

Adding an IEC61850 Device to a PowerLogic SCADA Project
Use this procedure when you want to add an IEC61850 device to a PowerLogic
SCADA project. Note that these instructions assume that you have two I/O servers, and
that you will be renaming ports.

There will be an additional .dbf file for each translated language. At runtime, the user
will be able to choose the .dbf file that they want to use in the display. This changes the
language in the display.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Adding the Cluster, Network Address, and
Servers on page 93.

Then, make sure that you have set up each of these clusters in the Profile Wizard:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerLogic
SCADA before you do this):

1. From the Profile Wizard, under System Devices, click Cluster Setup. Click Next.
2. At the Enter Instance Information screen, a cluster name displays. Click Next.

3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster
you want to set up. Click Next.

4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.
Check Supports Redundancy and select the I/O servers to which you want to add
the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen Setting Up More than two I/O Servers per Cluster
on page 95).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3a through 3e for each
cluster.

When you are finished adding clusters and I/O servers, you return to the Profile
Wizard welcome screen.

Adding the IEC 61850 Device

1. From the Citect Explorer screen, display the project to which you want to add the
devices: In the upper left corner of the screen, choose the project from the drop-
down menu.

2. From the Citect Project Editor, click Tools > Profile Wizard.

The Profile Wizard welcome screen displays.

Click Create an I/O Device in the project, then click Next.
3. At the Choose profile screen, select the first device profile that you want to use to

add a device to the PowerLogic SCADA project. Click Next.

4. At the Enter instance information screen, type a descriptive profile name, for
example: Bay1Circuit1 (no spaces or punctuation; to allow space in PowerLogic
SCADA, the preferred limit is 16 characters). The Comment field is stored in the
equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the
PowerLogic SCADA product. These fields can be used to create copy for
translation purposes. If you type a Comment in this format:
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@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerLogic SCADA
7.20\User\[your project](for Vista operating systems: ProgramData\Schneider
Electric\PowerLogic SCADA 7.20\User\[your project]). English.dbf contains terms
that will be translated from English.

To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

LDName

In the Additional Information section at the bottom, you can change the original
logical device names for the IED. This is required only if the logical device name
was changed in the SCL file that was imported into the Profile Editor.

BRCBs and URCBs

In the Additional Information, you can also enter BRCB or URCB information.
BRCBs (buffered report control blocks) and URCBs (unbuffered report control
blocks) can be used to return data in blocks rather than in individual tags. To enter
either one, you need to have downloaded an SCL file for the device in question.
When you click the line to add data, you must browse to the SCL file and select the
BRCB/URCB you want. You will need the logical device, logical node, and RCB
names. The Help column gives examples of the formatting that is required.

Click Next.
5. At the Communications Settings screen, browse to the location where you have

saved the SCL file. If there is only one IED, it displays automatically; otherwise,
choose the correct device. Click Next.

6. At the Ready to perform action screen, click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.

To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
6.

7. When you have finished adding devices, uncheck the Add/remove more equipment
option, then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the Profile Wizard closes. If you checked
the Add/remove ... box, the Welcome screen displays again.

8. From any of the three PowerLogic SCADA screens, compile the project.

9. When all errors are corrected, click File > Run to view the runtime environment.
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Naming Ports
The Profile Wizard does not take into account that multiple projects might be 'linked
together' via a global include project. For instance, it does not allow you to specify a
unique port name and port number, such that they will not conflict with other projects.

There are three possibilities:
• Protocols that support port name changes: includes Generic TCP and MODBUS

TCP
• Protocols that support re-use of ports only: see the table below for protocols and

settings that need to match
• Protocols that do not support port name changes: all protocols not mentioned

above

The table below shows the settings that must match between the protocols for that
column. For example, if you combine two generic serial protocols or a generic serial
with a DNP3 via serial, all of the checked items need to match between them.

Generic Serial,
DNP3 via Serial

MODBUS RTU
via Serial

DNP3 via TCP/IP,
IEC 60870-5-104
via TCP/IP,
MODBUS RTU via
Gateway

Board Type X X X

I/O Server Name X X X

Port Number X X

Baud Rate X X

Data Bits X X

Stop Bits X X

Parity X X

IP Address X

Network Port Number X

All attached I/O devices must use the
same protocol. X X

Using the Port Settings page in the Profile Wizard, you can name ports. See Adding a
Device to a PowerLogic SCADA Project on page 97 for more information.

Editing Devices in a PowerLogic SCADA Project

Editing a Profile and Adding it Back to the Project

This feature works only if the device was added in version 7.20. You cannot update
devices that were added in version 7.10.

After you have added devices to the PowerLogic SCADA project, and you make
changes to the device in the Profile Editor (e.g., add a large number of tags),you can
use the Profile Wizard to bring the changes in the PowerLogic SCADA project.

NOTE: If you have made manual changes to the profile in PowerLogic SCADA (Citect),
do not use this process: you could corrupt your data. You must delete the device from
the PowerLogic SCADA project, re-export it from the Profile Editor, and add it back to
Citect via the Profile Wizard.

To use this method of importing changes:
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1. Make the changes in the Profile Editor. Make sure you refresh the tags before you
continue.

2. Export the project from the Set Up Projects tab.

3. From the Citect Project Editor, click Tools > Profile Wizard.

4. At the Welcome screen, check Update one or more I/O Device(s) in the project.
Click Next.

5. At the choose update type screen, check whether you want to update all instances
in a profile, or just one instance. Click Next.

6. Note the two possibilities:

a. If you selected all instances, choose the profile, and click Next.
b. If you selected "one instance," the Update profile instance screen displays.

From the drop down list, choose the instance you want to update.
7. At the Ready to perform action screen, note the instance(s) you are about to

update. If you want to change your choice, click Back.

To compress the project files in PowerLogic SCADA, check "Pack databases after
update."

When you have made the update choice you want, click Next.

When the update is finished, the Project updated successfully screen displays. You
can view an audit log of changes that have been made, process more changes, or
click Finish to leave the Profile Wizard.

Editing a Device in PowerLogic SCADA Only

If, when you added the device to the PowerLogic SCADA project, you entered incorrect
information (e.g. wrong IP address), do the following:

1. Delete the device from the PowerLogic SCADA project: Use the “Remove a device
from the project” feature in the Profile Wizard.

2. In the Profile Wizard, add the device back to the PowerLogic SCADA project.

Adding Device Data in PowerLogic SCADA Only

If you need to add a small amount of data to a device that is in the PowerLogic SCADA
project (e.g., add a single tag), add it directly in PowerLogic SCADA. Be sure that you
also add it to the device in the Profile Editor so that it is available for other devices in
the future.

Removing a Device From the PowerLogic SCADA Project
1. From the Citect Explorer screen, display the project from which you want to remove

the device: In the upper left corner of the screen, choose the project from the drop-
down menu.

2. From the Citect Project Editor, click Tools > Profile Wizard.

The Profile Wizard welcome screen displays.
3. Click Remove a device from the project, then click Next.

4. At the Remove a device screen, click the dropdown menu to display the equipment
names that were used when the device profiles were added in the Profile Wizard.
From this list, select the device that you want to remove. Click Next.

5. At the Ready to perform action:

To compress the project files after removing this profile, click Pack databases.

Click Next.
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After the device is deleted, a screen displays telling you that the project was
updated successfully.

To view a detailed list of devices that you have added or deleted, check the View
audit log box. The list will show all of the device data that has been added, as well
as the data that has been removed in this session. The list displays after you click
Finish.

6. To continue removing devices, check Add/remove more devices, then click Next.
Repeat steps 4 and 5.

7. When you have finished removing devices, uncheck Add/remove more devices,
then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the Profile Wizard closes. If you checked
the Add/remove ... box, the Welcome screen displays again.

Adding Multiple Devices through the Automation Interface
The Automation Interface allows you to add multiple devices at a time, instead of using
the Profile Wizard, which only adds one device at a time. Follow these instructions to
add large quantities of devices into the PowerLogic SCADA project. (This example is
for MODBUS TCP. See the table at the end of these instructions for other comms
methods.)

NOTE: If you install PowerLogic SCADA on a computer that does not have Microsoft
Excel installed, you will not be able to run the Automation Interface. To ensure proper
Microsoft COM registration with Excel, you must install Excel before you install
PowerLogic SCADA. If Excel is installed after PowerLogic SCADA, you will see an "out
of memory" message when you try to run the macro. The solution is to uninstall both
PowerLogic SCADA and Excel. After that, first reinstall Excel, then reinstall PowerLogic
SCADA.

1. For an existing project: Before you begin, make a backup copy of your project. See
PowerLogic SCADA Backup on page 129 for instructions.

For a new project: In the Citect Explorer, add a new project. From the Project Editor,
define a cluster; and add alarm, trend, and I/O servers (see Before You Use the
Profile Wizard on page 93).

2. In the Profile Editor, create a project that includes the devices included in this
installation. Give the project the same name you used in step 1.

3. Open Excel 2003 or Excel 2007 and enable macros (Click the Developer tab, then
Macro security. Click Enable all Macros).

4. In Excel, open Example Automation.xls (Program Files\Schneider
Electric\PowerLogic SCADA 7.20\Bin). This sample spreadsheet can be edited to
include the communications methods you will use. Then, enter the devices that you
want to add to the PowerLogic SCADA project in the spreadsheet.

5. From the Setup worksheet at the bottom of the spreadsheet, make these changes:

a. Cell B2: Enter the path to Citect.ini:
For Windows XP: Documents and Settings\All Users\Application
Data\Schneider Electric\PowerLogic SCADA 7.20\Config.
Vista operating systems: ProgramDataSchneider Electric\PowerLogic SCADA
7.20\Config.

b. Cell B3: Type the project name.
c. Cell B4: Enter the path to the location of equipment.profiles:

For Windows XP: Documents and Settings\All Users\Application
Data\Schneider Electric\PowerLogic SCADA 7.20\User\ProjectName).
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For Vista operating systems: ProgramData\Schneider Electric\PowerLogic
SCADA 7.20\User\ProjectName).

6. From the Input worksheet at the bottom of the spreadsheet, enter the following
information for each device that you want to add:

a. Profile Name: Type the complete name (to view exact addresses, open
equipment.profiles in Notepad), e.g.:
SchneiderElectric.Protection Device.Sepam S42 Full

b. Name: Enter the device name (no spaces or punctuation, limit of 32 characters).
This becomes the equipment name in the PowerLogic SCADA project. You will
use this when adding genies to drawings.

c. Cluster: Type the cluster name from step 1.
d. Primary IO Server Name: Type the I/O server added in step 1. It becomes the

primary server.
e. CommsMethod: Type the communications protocol being used, e.g.,

MODBUS/RTU via Gateway. See table below for alternate communication
connections.

f. Additional Prompts will display, depending on the communication connection
being used. See the table below for a list of data required for each comms
method.

g. EquipmentAddress: Type the device address (required only for MODBUS/RTU
and MODBUS/RTU via Gateway; optional for other comms methods).

7. Close Citect Explorer if it is open.

8. In Example Automation.xls, click Tools > Macro > Macros. Highlight the macro
called ThisWorkbook.AddDevices, then click Run.

Devices are created, according to the information you added. When device creation
is complete, a message displays.

NOTE: For large systems, this can take quite a long time. While the macro is
running, there is no feedback on the screen.

9. Launch PowerLogic SCADA and verify communication for all of the devices listed
in the spreadsheet.

If Example Automation.xls does not include a communications connection that you
want to use, you can add the new connection. The following table lists connections and
the required information for each.

CommsMethod ComPort Baud
Rate DataBits StopBits Parity IP

Address
Equipment
Address

Generic Serial 1 X X X X X X 2

MODBUS/RTU X X X X X X

Generic TCP X X 2

MODBUS/RTU via
Gateway X X

MODBUS/TCP X X 2

1 Generic Serial comms must be set up via Gateway in this release.

2 Optional
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Using the OLE Automation Interface to Add and Remove Devices
In this section, you will find these topics:

Examples on page 109

Command Line Interface on page 110

Interface Workflow on page 110

There is also an OLE Automation interface that allows you to add and remove devices
from a project. The interface can be used by VB, .NET, and by C++ clients. It is the
building block for building a bulk interface based on Excel.

IEquipmentAutomation. The equipment automation interface facilitates reading
equipment profiles, selecting a profile by name, setting the required information and
saving the profile to a project.

INameValueCollection. The INameValueCollection interface provides the means to
set the attributes and comms properties. The interface provides the method SetValue
for setting a named value for the currently selected profile. If the name is not
recognised, the method will return false and errors will be handled by the current error
output method. In the case where an error has occurred, the GetErrorMessages may
be called on the EquipmentAutomation interface to get more information about what
went wrong.

Examples

C#

After a C# project is created, a reference to the EquipmentAutomation.dll should be
established.

Using the equipment automation will be made easier by using the correct namespace
as shown:

using Citect.CitectSCADA.Equipment.Automation;

The following is an example of some typical C# code that will select a profile, set it up
and save it.

EquipmentAutomation myAuto = new EquipmentAutomation();
myAuto.IniFile =
@"C:\Documents and Settings\All Users\Application Data\Schneider
Electric\PowerLogic SCADA 7.20\Config\citect.ini";

myAuto.ReadProfiles(
@"C:\Documents and Settings\All Users\Application Data\Schneider
Electric\PowerLogic SCADA 7.20\User\TestProfiles\equipment.profiles");

string profileName = "Schneider Electric.Protection Device.Branch Circuit Monitor Full";

if (myAuto.SelectProfile(profileName))
{

If (myAuto.SelectProfile(profileName))

{
NameValueCollection myAttributes = myAuto.ProfileAttributes;
myAttributes.SetValue("NAME", "yourEquipName");
myAttributes.SetValue("CLUSTER", "yourCluster");
myAuto.ServerNamePrimary = "PrimaryServer";
myAuto.SetCommsMethod("Modbus/RTU via Gateway");
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INameValueCollection myCommsProperties =
myAuto.CommsMethodPropertiesPrimary;
myCommsProperties.SetValue("IPAddress", "10.0.0.1");
myCommsProperties.SetValue("EquipmentAddress", "1");
equipmentAutomation.SaveProfile("TestProfiles");

}

}

Excel VBA

An example spreadsheet, called “Example Automation.xls,” is provided in the bin
directory. This spreadsheet has a “Setup” and an “Input” sheet. The Setup sheet
contains information about the ini file location, the project name, and the profile that is
used. The Input page contains information that is used by the macro to select a profile,
set the attributes, set the IO server name, select the comms method and set the
appropriate comms properties.

Command Line Interface
The Device Wizard allows the wizard to be launched from the command line. It uses
the flag /i to specify the location of the Power SCADA Ini file (usually found in the config
directory of the user/data directory), and the flag /p to specify the project name. The
arguments to these flags must immediately follow the flag without a space. It is
recommended to use quotes around the ini filename.

In addition to launching the wizard, the Device Wizard allows a merge of a device
profile XML file with the current PowerLogic SCADA “master” device profile XML file.
The given file must conform to the profiles schema.

Additional help may be obtained by using the /h flag.

EquipmentWizard.exe /?
EquipmentWizard.exe /p”ProjectName” /i”iniFile”
EquipmentWizard.exe /p”ProjectName” /i”iniFile” /m”MergeProfileName”

Interface Workflow
The general workflow, when adding devices via the automation interface, is illustrated
in the following flowchart. Success values can be checked at each step in the process
by checking the Boolean return value or by checking the engine errors.
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Prerequisite information

Before creating a profile in a project, key information about the profile and the project in
which it is being added should be established. This information can be established by
examining the profile definition in the equipment.profiles file for the project. Attribute
names and the supported comms methods must be known in order to know what
needs to be set. The cluster and the IO server names from the project that the
equipment is being added to should also be established.

Error messages can also provide useful feedback, and a way of discovery for what is
required. The profile will not be saved until all required information is determined to be
valid and complete.
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Interface

The automation interface is designed to lead the developer through the workflow,
providing useful feedback along the way in the form of error messages as to what was
missing or incorrect. The interface is a COM automation interface that allows multiple
profiles to be saved to a project.

IniFile [Property] — The equipment engine relies on the location of the ini file to
determine where projects are stored and for validating that a profile can be
successfully imported into the selected project.

ReadProfiles—The equipment engine reads the given profile file into memory and
ensures that it is matches the expected schema.

SelectProfile— Selecting a profile initialises the engine for a specific profile. A profile
is selected by referring to the qualified name. The qualified name is made up of the
categories that contain the profile separated by a ‘.’.

ProfileAttributes [Property]— Attributes are set by first retrieving an
INameValueCollection from the ProfileAttributes property. The
INameValueCollection provides an interface method to set a named value. This will
set the attribute with the given name for the selected profile in the equipment engine.
SetValue returns a Boolean value indicating success.

ServerNamePrimary and ServerNameStandby [Properties]— The name of the
primary IO server is required to be set (ServerNamePrimary) before saving a profile. A
standby server name may also be optionally specified (ServerNameStandby). The
server names must be valid server names in the project that the profile is being
imported into.

SetCommsMethod— Each profile specifies which comms methods it supports. Setting
the comms method requires that the currently selected profile supports the comms
method specified.

CommsMethodPropertiesPrimary and
CommsMethodPropertiesStandby[Properties]—Comms properties are also set via
INameValueCollection which is returned when calling
commsMethodPropertiesPrimary or commsMethodPropertiesStandby. If a standby
server was specified, the comms properties for the standby server are required to be
set. The comms properties required depend on the comms method selected. Below is
a table listing the comms properties required for each of the comms methods.

CommsMethod ComPort Baud
Rate DataBits StopBits Parity IP

Address
Equipment
Address

Generic Serial1 X X X X X X 2

MODBUS/RTU X X X X X X

Generic TCP X X 2

MODBUS/RTU via
Gateway X X

MODBUS/TCP X X 2

1 Generic Serial comms must be set up via Gateway in this release.
2 Optional

SaveProfile— SaveProfile takes the name of the project to which the profile is being
saved. Saving a profile involves writing all output values defined in the profile definition
to the specified project. A two-phase commit process is used to ensure that data is
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valid before committing changes permanently. Saving profiles to a different project will
result in an automatic cleanup of the first project. See CleanupProject for more
information.

ResetSelectedProfile— A call to ResetSelectedProfile will clear data associated with
the selected profile, as well as clearing any accumulated errors. After saving a profile
successfully, this method will be called automatically to allow the next profile to be
saved.

DeleteEquipment—DeleteEquipment requires the project name that the equipment is
to be deleted from as well as the name of the equipment that is being deleted. It will
scan through the project looking for records that were added for a specific piece of
equipment and will remove them accordingly. Removal of file outputs which were
defined in the profile from which the equipment was added is not performed as these
files may contain sensitive data that has since been added to these files. Additionally,
those dbf entries in the profile under dbf-file that do not have an equip field are not
removed, as there is no way of determining if they are exclusively used by this piece of
equipment.

CleanupProject—CleanupProject performs operations such as re-indexing of dbf
files and packing dbf files. Errors detected by this phase are reported as warnings and
do not trigger a rollback. This operation should be called after all save operations have
been performed on a project.

NoErrors [Property]— This is a Boolean property that can be used to determine if any
errors have been collected.

GetErrorMessages—Detailed error messages may be obtained by calling
GetErrorMessages, which returns a string with errors and warnings on multiple lines.

ErrorOutput [Property]— The error handling approach be set with the ErrorOutput
property. Error Handling.

The values used for the error output are:
• None = 1
• Dialog = 2 [default]
• Console (silent if run from excel) = 4

Error Handling— Each interface method returns a Boolean indicating the success of
that operation. Accumulated errors will prevent progression through the workflow and
as such, this return state should be examined at each stage. A call to
ResetSelectedProfile will clear accumulated errors, but it is recommended that errors
are addressed before you proceed.

Information about errors and warnings can be obtained through a call to
GetErrorMessages. By default, a dialog will display with error information at each step
of the workflow, but this can be controlled with the ErrorOutput property.
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Graphics: Using the Design Time Environment
This chapter discusses how to use genies to create one-line diagrams for customers. In
this section, you will find these topics:

Typical Workflow on page 115

The PowerLogic SCADA Pages on page 116

Creating a PowerLogic SCADA Project on page 117

Reusing Projects Created in the Profile Editor on page 117

Adding a New Graphics Page on page 118

Creating a One-Line on a Graphics Page on page 119

Using Menu Configuration to Edit Pagemenu.dbf (Changing the Graphics Page
Appearance) on page 121Using Menu Configuration to Edit Pagemenu.dbf
(Changing the Graphics Page Appearance)

Creating and Editing Genies on page 123

Deleting Information from PowerLogic SCADA on page 124

Working with Alarms on page 125

Alarms Overview on page 125

Adding Setpoints and Delays on page 125

Making a PC-Based Alarm Digital

Setting Up an Alarm Based on an Enumeration on page 126

Changing an Alarm Severity on page 126

Enabling Waveforms for Onboard Alarms on page 126

Setting Parameters for Event Log Length and Historical Logging of Events on page
126

Adding an Onboard Alarm Tag on page 128

Setting Up Audible Alarms on page 128

Restoring and Backing Up Projects on page 129

Restoring a Project on page 129

PowerLogic SCADA Backup on page 129

The Project Color Change Tool on page 130

Adding a Custom Genie for Use in the Color Change Tool on page 130

Changing the Colours of Busbars and Circuit Breakers on page 130

Using Cicode to Customize a Project on page 132
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Typical Workflow
When creating a graphics page, these are the steps you will usually follow:

1. Before you begin, make sure you have:

a. created a project in the Profile Editor
b. added a project with the same name to PowerLogic SCADA; added at least one

cluster, network address, and server
c. exported the project from the Profile Editor
d. used the Profile Wizard to add devices to PowerLogic SCADA

2. From the Graphics Builder window, add a new page, using the style and page
template you prefer. Instructions assume that you will use the default template; but if
you create your own template, use the Menu Configuration tool to add menu
headings that will display on the one-line in runtime. (See Using Menu
Configuration to Edit Pagemenu.dbf (Changing the Graphics Page Appearance) on
page 121 for more information about changing the appearance of the graphics
page.)

3. Add genies to the page to create the one-line drawing.

4. Compile and run the project. Note any errors and warnings; correct all errors.
Review warnings for problems such as missing tags.

5. Run the project to view the graphics page in the runtime environment.
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The PowerLogic SCADA Pages
When you launch PowerLogic SCADA (Start > Programs > Schneider Electric >
PowerLogic SCADA Explorer), three windows are opened:
• Citect Explorer: Use this application to explore and add projects. PowerLogic

SCADA is shipped with a project that has example page configuration. Project
names are listed in the left-hand pane.

• Citect Project Editor: Use this application to edit the SCADA configuration. For
example, use it to add clusters, network addresses, and servers; and to launch the
Profile Wizard and the Project Color Change tool.

• Citect Graphics Builder: Use this application to build graphic display pages for a
project. A standard PowerLogic library of genies are provided. The genies contain
logic such as control outputs and rack-in/rack-out. Once assembled and opened in
the runtime environment, they provide an interactive view of an installation’s power
system.

116 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 Graphics: Using the Design Time Environment
06/2011



Graphics: Using the Design Time Environment 63220-100-200E1
06/2011

Creating a PowerLogic SCADA Project
The information in this section is based on the Normal template from the PLS_Style_1
library. The Normal template includes all of the tabs and buttons that are described in
the topics here. If you want to edit selections on the tabs and buttons, use the Menu
Configuration tool. For instructions on editing templates with the Menu Configuration
tool, see Using Menu Configuration to Edit Pagemenu.dbf (Changing the Graphics
Page Appearance) on page 121.

When you modify the template or create a completely new template, the information
provided here for creating graphics pages may only apply as a guide.

When you rename a project (using the .Project Properties option in Citect), you will see
error messages when you try to add new projects. To fix this problem, just shut down
and then restart PowerLogic SCADA.

In this section, you will find these topics:

Reusing Projects Created in the Profile Editor on page 117

Adding a New Graphics Page on page 118

Setting a New Page as the Project Startup Page on page 118

Creating a One-Line on a Graphics Page on page 119

Using Menu Configuration to Edit Pagemenu.dbf (Changing the Graphics Page
Appearance) on page 121

Creating and Editing Genies on page 123

Deleting Information from PowerLogic SCADA on page 124

Reusing Projects Created in the Profile Editor
You may want to create a “standard” project that can be reused for different
installations. For instructions on saving and then reusing projects, follow these steps:

1. Export the project from the Set Up Project tab of the Profile Editor.
2. Click the folder icon beside the Export link:

3. Copy the file (Equipment.profiles) that displays. If you need to use this file to
another computer, you can move it to a portable drive.

4. On the PowerLogic SCADA server computer, paste Equipment.profiles in this
location:

Windows XP: Documents and Settings\All Users\Application Data\Schneider
Electric\PowerLogic SCADA 7.20\User\[Project]

Vista operating systems: [Drive Letter]:\ProgramData\Schneider
Electric\PowerLogic SCADA 7.20\User\[Project]

where:

[Drive Letter]: is the drive on which you installed the PowerLogic SCADA server

the Application Data and Program Data folders are not hidden (set the folder view
for “view hidden folders”)

[Project] is the name of the project you are creating; you must have already added
this project to PowerLogic SCADA (see Before You Export, above).

5. Be sure you have created the files described in Before You Begin on page 118.
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Before You Begin
Before you start adding data in the PowerLogic SCADA project, make sure that you
have:
• used the Profile Editor to add all of the device types, device profiles, and projects
• from Citect Explorer, created a project in PowerLogic SCADA; from the Citect

Editor, added clusters, network addresses, and servers
• exported devices from the Profile Editor
• added devices into the PowerLogic SCADA project, using the Profile Wizard

Adding a New Graphics Page
You need to add a project in two places before you add pages. First add the project to
PowerLogic SCADA, from the Citect Explorer screen (see steps below). Then add it to
the Profile Editor. SeeAdding, Editing, or Deleting a Project on page 66 for instructions.

1. From the Citect Explorer screen, choose the project for which you will create a
graphic.

2. On the Graphics Builder screen, click File > New > Page.

3. On the Use Template popup, set the resolution to SXGA (or default), and uncheck
the Title Bar option. Select the page template (for example, normal). Click OK.

NOTE: If you use any style that is not preceded by “pls,” the PowerLogic SCADA
graphics features will not be included. If you want to change the attributes of the
default style, copy pls_style_1 and paste it in your project; rename it, and make the
desired changes. The new template can then be used for your pages.

The graphics page displays in design-time mode.
4. To make changes to the menus and tabs that display on the screen, use Menu

Configuration tool. See Using Menu Configuration to Edit Pagemenu.dbf
(Changing the Graphics Page Appearance) on page 121 for instructions on making
these changes.

5. Save the graphics page, giving it the desired name and selecting the project that
you have just added.

Setting a New Page as the Project Startup Page
After you add a new page, follow these steps to make it be the system starting page. If
you do not make these settings correctly, the system will not properly execute the
startup routine, and the browser navigation buttons will not work.

1. Open the Parameters dialog (Project Editor > System > Parameters).
a. In the Section Name field, type MultiMonitors.
b. In the Name field, type StartupPage.
c. In the Value field, type the name of the new page.
d. If you intend to use multiple monitors, and want to use a different startup page

for a particular monitor, you can specify it by adding another parameter with the
name of StartupPage<n>, where <n> is the monitor number (for example,
StartupPage2, for startup page on the second monitor).

2. In the Computer Setup Wizard (General Options Page), leave the ini settings as
<default>.
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Creating a One-Line on a Graphics Page
You will build a one-line by adding genies to the new page. For more information
about genies, see Genies and Super Genies in the CitectSCADA.chm help file (Start >
Programs > Schneider Electric > PowerLogic SCADA 7.20 > PowerLogic SCADA
Help).

To begin creating a one-line, start adding genies to the page:

1. Click the “genie” icon on the toolbar:

2. From the Paste Genie screen, choose a library (to ensure that all PowerLogic
SCADA features are available, choose a library that begins with “pls”). If you want
to edit a genie or create a new one, see Creating and Editing Genies on page 123
for instructions.

3. From the available icons in the selected library, select a genie; click OK to paste the
genie on the graphics page.

4. A popup window displays for you to enter genie properties. Enter the requested
information (descriptions below for circuit breakers, switchgear, and busbars only):

Circuit breakers, both ANSI-type and IEC-type

NOTE: Type 1 genies are of two styles: NC (no control) and C (control). The NC
genies have no open/close control buttons; the C genies have open/close buttons.

NOTE: If you choose to resize a circuit breaker genie after you paste it into a page,
you must keep the relative dimensions (proportions) the same. Otherwise, the
racked in/racked out animation will not display correctly.

a. Equipment: From the drop-down list, choose the name of equipment
represented by the genie (this is an equipment name that you entered in the
Profile Wizard or the Automation Interface, e.g., CM4Main). To view the
equipment you can use for this page, you must have the project selected in the
Citect Explorer window.

b. Busbar Connections: Where you are connecting to busbars, type the numbers
for the connection source and destination. These are arbitrary, and only indicate
how the genies in the one-line fit together on the page. Busbar numbers can be
from 0 to 74. Numbers must be unique within each page. We recommend that
they be consistent across pages for future compatibility.

c. Label (currently, labels are only available on Type 2 circuit breakers): Type 2
circuit breakers have two label fields, upper (incomer) and lower.Type the name
you want to appear for each label. Note: If you type too many characters to the
upper label, it will overlap the earth switch, and will not be readable.

d. Value Type: From the drop-down list, select the tag you want to use for this
genie. This information displays in the lower left corner of the genie in run time.
The tag you choose here causes real-time data (for example, “currents”) to
display on the runtime environment of the Graphics page. If you do not select a
tag here, the status screen will have a blank in that spot. This tag also
determines what displays in the popup (volt, amp, watts, etc.) See Using the
Equipment Pop-Up Page on page 150 for more information.

e. Units: From the drop-down list, select the unit (created in the Profile Editor).
Units will display beneath the Value Type on the run time screen.

f. Multiplier: Enter the multiplier you want to use for the units in this graphic.

Switchgear
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a. Busbar Connections: Where you are connecting to busbars, type the numbers
for the connection source and destination. These are arbitrary, and only indicate
how the genies in the one-line fit together on the page. Busbar numbers can be
from 1 to 100. Numbers must be unique within each page. We recommend that
they be consistent across pages for future compatibility.

b. Label (currently, labels are only available on larger circuit breakers): Type the
name you want to appear on upper left corner of the page in the runtime
environment.

c. Equipment: From the drop-down list, choose the name of equipment
represented by the genie (this is an equipment name that you entered in the
Profile Wizard or the Automation Interface, e.g., CM4Main). To view the
equipment you can use for this page, you must have the project selected in the
Citect Explorer.

Busbars

a. Busbar Number: Use busbar numbers to associate devices within the drawing;
they are also an aid to help you set up animation for genies in the drawing. The
busbar number you enter here is also used on the associated device. We
recommend that they be consistent across pages for future compatibility.

b. Busbar Voltage: Type the number for the busbar’s voltage level, determined by
the standard used in this installation. (Colours for busbar voltage levels are
determined in the Project Color Change tool. See Changing the Colours of
Busbars and Circuit Breakers on page 130 for more information.) To ensure that
the Project Color Change tool operates correctly, voltages need to be consistent
across the project.
Do not connect two busbars with different voltage levels. The single line
drawing will not display information correctly.

c. Line Active: From the drop-down menu, select the tag for the incoming voltage
for device specified in the connected equipment. This can also be a Cicode
function of expression (such as MyTag1 > 0).
As an expression, use Line Active to link multiple-page drawings: on the
incoming busbar on page 2, enter a line active statement that is equal to the tag
used for the last device on page 1.

NOTE: If a field condition is available that can be used to indicate the actual busbar
active state, it should be entered in the Line Active field.
Also, if there are transformers in the one-line, the busbar may not change colour
smoothly after state changes. To minimize any delay in colouring busbars, you
should, if possible, enter a valid expression in the Line Active field. For example, if
you choose phase A voltage for line active of “MYCM4,” and the incoming voltage
is 440V, Line Active might read: MYCM4\MMXU1\PhV\phsA > 400. It is especially
important to enter a line active expression for busbars that are directly upstream
from the transformer.

5. Click OK to save the genie to the page.

6. If a message displays telling you that variable tags are not found, and asking if you
want to add the unknown tags, this is not a problem. The genie is expecting to see
a variable, but one may not exist in the equipment (for example, it could be looking
for a “racked out” variable in a Sepam). Click No to this message.

NOTE: To disable this message, go to the Project Editor page. Click Tools >
Options. From the Options window, de-select “Prompt on tag not exist.”

The genie is added to the page.
7. Continue adding the genies to make up the graphics page.

After you create the graphics page, you need to compile it. You can run the page to
review its elements and correct any errors.

NOTE: Do not drag genies off of the page. They will disappear.
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8. On the Graphics Page, click File > Compile.

While the page is being compiled, the PowerLogic SCADA Compiler displays each
file name as it is being compiled. A message then displays, telling you that
compilation was successful.

9. If there are errors and/or warnings after the page is compiled, a message box
displays, telling you the number of errors and warnings. You must understand all
warnings and correct all of the errors. To begin, do the following:

a. Click OK at the PowerLogic SCADA Compiler message.
The Compile Errors window displays the first error.

b. Note the error message. For more information on each error, click Help; note the
Description for that Error Message.

c. To correct the error, click the GoTo link.
The appropriate window displays for you to correct that error.

10.Correct each error. Warnings do not need to be corrected in order to run the project;
but they should be checked to see if they impact the project (such as a tag that is
not defined).

11. If you delete any entries, click File > Pack to clean up the files.

12.Re-compile and verify that all of the errors have been addressed.

NOTE: You can also view the Compile Errors window from the Project Editor (File >
Compile Errors).

13.After all errors are corrected, run the project (File > Run).

The Graphics page displays in the runtime environment. Note: Until you edit the
Menu Configuration file, only basic tabs will display on the Graphics page.

14.Before you can view your one-line, you need to edit the Menu Configuration file,
which controls the appearance of the graphics page in the runtime environment.
SeeUsing Menu Configuration to Edit Pagemenu.dbf (Changing the Graphics Page
Appearance) on page 121 for help.

Using Menu Configuration to Edit Pagemenu.dbf (Changing the Graphics Page
Appearance)

The Menu Configuration form (System > Menu Configuration in Project Editor) edits
Pagemenu.dbf in your project. This controls the runtime environment screen
appearance: tabs and menus on the screen. By the entries you add there, you can also
specify actions to be taken when an option is selected.

Because it takes much effort to create the items that display on a graphics page, you
can use the menu settings from the Power SCADA PLS_Example project as a template
for your new project template. From it, you can copy and paste settings into an
individual project’s menu configuration file.

The following illustrates a blank Menu Configuration file (see the table below for
descriptions of the numbered fields):
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Menu Item Description

1: Order The relative position within the final graphics page. If you leave this field blank, the
default value 0 is used. (64 characters max.)

2: Levels 1 through 4
These items establish themenu levels that will display. For example, youmight
use "Single Lines" for level 1, followed by the substation for level 2, and the graphic
name for level 3. (Each line: 256 characters max.)

3: Menu Command

The Cicode expression that you want to execute. Typically, you will use the "page
display" command followed by the actual page you want to see. For example:

PLSPageDisplay("CB_IEC_1")

which displays the page CB_IEC_1.

4: Symbol

Displays a defined image along with the description for that level.

Images must already be defined in the project/include project. They are specified in
the format <library name>,<symbol name>. For example, in PLS_Example, the
symbol used for the level 2 of Single Lines is Substation3, entered as PLS_
Icons.Substation3.
Different menu levels are designed to be used with different symbol sizes for
optimal display. For Level 1 items (tab), the recommended symbol size is 16 x 16
pixels. For Level 2 items, (buttons), the recommended symbol size is 32 x 32
pixels. Symbols are not displayed for menu items of Level 3 or beyond.

5: Comment You can use up to 128 characters to add a comment (will not display on screen).

To copy information from the PLS_Example project, do the following:
1. Open the PLS_Example project. Then, from the Citect Project Editor, click System >

Menu Configuration.

The Menu Configuration for PLS_Example displays.
2. From Citect Explorer, change the project to your new project.

3. In the Citect Project Editor, click Menu Configuration.

Now both Menu Configuration windows display.
4. To copy the entire record, you can use the Copy Record and Paste Record menu

command. From the desired record in the PLS_Example project window, select the
menu command Edit > Copy Record. Then go to the desired record in your project
window, and select menu command Edit > Paste Record. Do further editing as
required. Alternatively, you can selectively copy information from the source record
to your project, line by line.

5. To save the menu configuration record in your project, choose either the "Replace"
or "Add" button. Compile the project; then run it again.

The Graphics page in the runtime environment of your project will now display
according to the settings you have made.
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Creating and Editing Genies
The easiest way to create a new genie is to make a copy of a similar genie from the
standard PowerLogic SCADA library and edit it in your project. We recommend, when
adding layers, that you keep the dimensions of the new layers the same as the original.
For a list of all of the standard PowerLogic genies, including all of the smaller parts that
you could use to create genies, see Appendix 1: Default Genie Library on page 163.

When you modify a genie, the modifications will be in effect for all instances of that
genie in the project.

To create a custom genie, follow these steps:
1. Open the genie that you want to use as a template: From Citect Graphics Builder,

click File > Open. Click the Genie tab, then select the library and the template
genie. Click OK.

2. Save the genie with a new name in your local project.

3. To separate the genie into layers, click the genie and drag a layer to the bottom
right.

4. Repeat the process to pull all of the layers apart.

Each layer is a sub-genie that controls a different aspect of the overall genie.
5. Make the changes that you wish to the genie.

NOTE: Be careful to maintain the same dimensions for any new layers that you
create.

6. To re-assemble the genie, draw a marquis around all of the parts; then click
Arrange > Align, and choose Top and Left. Click OK.

The newly created genie, when applied to a page, will display with the generic input
form. To create a customized form similar to those found with the default genies, you
must create a new .FRM file. Examples are found in the PLS_Include project directory.

You can rotate any of the genies.

To create a custom symbol for a custom genie, follow these steps:

PowerLogic SCADA genies are complex PowerLogic SCADA genies with the added
ability to animate colour during runtime (showing changing states). These genies are
comprised of multiple symbols that have the same attributes (all will work with Project
Color Change tool, all call the same Cicode function, etc.).

1. Create the new symbol.
2. Configure the symbol to work with the Project Color Change tool: from the Symbol

properties screen, choose the Access tab. In the Description field, enter
<PwrLineColor>.

3. Configure the symbol to display the customized colours in the runtime environment
by calling the PLSAnimBusbar() function, which is provided in PowerLogic SCADA.
This function must be called from the Multi-State Condition area of the Symbol
properties window.

Each multi-state symbol can display up to seven colors (see Changing the Colours
of Busbars and Circuit Breakers on page 130 for details). These symbols are
labeled in binary with ABC and are passed to the PLSAnimBusbar() function as the
first parameter. The second parameter is the busbar number that determines the
animated colour. Always use the %variable% notation. Using this notation permits
you to reuse genies.

See the default symbols in the PowerLogic SCADA libraries that begin with PLS_.
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4. Save the symbol and use it in a custom genie.

Deleting Information from PowerLogic SCADA
If you find you need to delete any data that you have entered (clusters, servers, genies,
etc.), follow the normal procedure to delete the data, then use the Pack command to
completely delete it. To do this, click File > Pack on the Project Editor.
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Working with Alarms
In this section, you will find these topics:

Alarms Overview on page 125

Adding Setpoints and Delays on page 125

Setting Up an Alarm Based on an Enumeration on page 126

Changing an Alarm Severity on page 126

Enabling Waveforms for Onboard Alarms on page 126

Setting Parameters for Event Log Length and Historical Logging of Events on page
126

Adding an Onboard Alarm Tag on page 128

Setting Up Audible Alarms on page 128

Alarms Overview
This section discusses two alarm types: time stamped analog and time stamped digital.
To access the alarms, from Citect Explorer, select the project folder, then click Alarms.
In the right-hand pane, the alarm types display. Double-click the one you want to
view/edit.

PC-Based Alarms

PC-based alarm tags are added in the Profile Editor, when adding each device profile.
See Adding, Editing, or Deleting a Device Profile on page 52 for instructions. For
instructions on entering setpoints and delays, see Adding Setpoints and Delays on
page 125.

Onboard Alarms

If onboard alarms have been configured in a supported device, you can use the Profile
Editor to map these alarms to digital time-stamped alarms in PowerLogic SCADA.

You cannot configure new onboard alarms from PowerLogic SCADA. You must add
the alarm at the device, then you can create the alarm tag for it here. See Adding an
Onboard Alarm Tag on page 128.

Adding Setpoints and Delays
NOTE: Any time you change setpoints, you should immediately restart the project.
Otherwise, setpoints will not be properly read (they will be truncated and either
rounded down or up to a whole integer).

There are two ways to add setpoints and delays for analog alarms. Before you enter
setpoints and delays, ensure that you have configured the alarm server so that Publish
Alarm Properties is set to TRUE.
• From the Analog Alarms window (accessible from the Project Explorer or Project

Editor screens), you can type the setpoint and delay values for each alarm.
• When in the runtime environment, you can edit setpoints/delays that were set by the

method above. See Viewing Waveforms on page 151 for instructions.

Also, set the following parameter to allow persisting of alarm parameters at runtime.

[Alarm] UseConfigLimits = 1
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Setting Up an Alarm Based on an Enumeration
For instructions on defining an enumeration in the Profile Editor, see Defining an
Enumeration on page 79.

An example of an enumeration alarm is:

0 = unknown

1 = good

2 = warning

3 = alarm

To add an alarm that is based on an enumeration, follow these steps:

1. Open the analog alarm in PowerLogic SCADA.
2. To alarm on states 0, 2, and 3:

Set Low = 1 (if the value < 1, the alarm indicates an unknown state)

Set High = 1 (if the value > 1, the alarm indicates a warning)

Set High High = 2 (if the value > 2, the alarm indicates an alarm)
3. In the Category field, ensure that the correct alarm level is entered (_PLSALM_

HIGH, _PLSALM_MEDIUM, _PLSALM_LOW, _PLSALM_EVENT).

4. Replace the alarm.

Changing an Alarm Severity
To change the severity of an alarm, follow these steps:

1. Open the analog alarm in PowerLogic SCADA.
2. In the Category field, ensure that the correct alarm level is entered (_PLSALM_

HIGH, _PLSALM_MEDIUM, _PLSALM_LOW, _PLSALM_EVENT).

3. Replace the alarm.

Enabling Waveforms for Onboard Alarms
To enable waveforms, making them available for viewing in the runtime environment,
follow these steps:

1. At the device, or via the meter configuration software (PMCU), add the alarm and
enable the automatic capture of a waveform when the alarm occurs.

2. In the Profile Editor, on the Create Device Profiles tab, for the same alarm you
added in PMCU, check the Waveform box.

When this alarm occurs at the device, the waveform will be captured. The files will
be transmitted to PowerLogic SCADA and will be available for viewing. The amount
of time this takes depends on the number of I/O servers you have and the number
of serial devices on a chain. On a very large system with numerous serial devices,
this could take as much as an hour.

You can view the waveform from the Alarm Log in the runtime environment. See
Using the Equipment Pop-Up Page on page 150 for instructions.

Setting Parameters for Event Log Length and Historical Logging of Events
You can use two parameters to determine the maximum number of entries in the Event
Log and whether you want to log entries after they are FIFO’d out of the Event Log.
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Event Storage: [Alarm]SummaryLength Parameter

The maximum number of alarms that be stored is controlled by the Alarm Summary
length parameter, which defines the maximum number of alarm summary entries
(Event Log entries) that can be held in memory. You can view these alarm summary
entries on the Alarm Log page. Each event requires 256 bytes of memory, plus the
length of the comment. 32,000 entries will require at least 8 MB of memory. If you have
many events, you should ensure that there is enough memory to store them in RAM.

The default value is 5000.

NOTE: When the value is set to a number greater than 1000 for a multiple-cluster
system, the alarm log might not display correctly. The list of alarm history that displays
on a client might be shorter than the actual history stored on the alarm server. To avoid
this problem, do one or more of the following:
• Set alarm filtering in the alarm viewer to reduce the number of alarms that are

returned by the server.
• Only support a one-cluster system.
• If a multiple-cluster system is necessary, display a separate alarm page for each

cluster.

Event Logging: [PLSEventLog] Parameter

Use this parameter to determine whether you will log Event Log entries and the file
format that will used for logging. If you choose to log, you must specify the file format:
XML or CSV.

[PLSEventLog]

FIleFormat = 0 = no file logging, 1 = CSV format, 2 = XML format (default = 0)

EntryCount number of entries logged per disk file (1-3200; default = 250)

ScanRate time in seconds between writing to file, when waiting for a new event (1 to
3200; default = 10); may be ignored if the entry count is reached or if a large number of
alarms or events is triggered

The filename will have this format:

<Project Name>_<Cluster Name>_PLSEventLog.YYMMDDHHMMSS.xxx (where xxx
is the file format selected). The log files will be stored in the Data folder.

[Path]

PLSEventLog=c:\SharedData\Alarm

To specify the alarm fields to be logged, use:

[AlarmFormat]

EventLog=OnDate | Date, OnTimeMS | Time, Custom1 | Equipment, Name |
Description,
SumState | State | Custom2 | Location, UserName | User

Format]
Summary =
Alarm =
Equipment =
LastAlarm =

[AlarmHeading]

<FieldName> = <Display Name>
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Adding an Onboard Alarm Tag
When a device onboard alarm has not been included in PowerLogic SCADA, you can
add it from the Profile Editor. You need to follow these steps to include the device’s
unique identifier. Otherwise, the alarm will not annunciate in the Graphics page.

NOTE: You can only add onboard alarms for devices using the CM4, PM8, Micrologic,
or Sepam drivers. CM4, PM8, and Micrologic unique IDs must be decimal; SEPAM
unique IDs must be hexadecimal.

1. From the device, obtain the unique identifier for this alarm. Additionally, for
MicroLogic, you need to include the unique sub-identifier.

2. You also need the file number in which alarms on stored on the device.

3. From the Profile Editor, add the onboard alarm (see Onboard Alarm Tag Addresses
on page 47 in Editing Tag Addresses.

Setting Up Audible Alarms
You can use a variety of Windows wave files for audible alarms. To enable this feature,
follow these steps:

1. Define the alarm sound to be used and the repeat interval for each priority in the
alarm you want to be audible. Enter the following information, either in the project
parameters (Citect Project Editor > System > Parameters) or in the Citect.ini file:

a. [Alarm]
b. Sound<priority>=<wave file name>
c. Sound<priority>Interval=<repeating interval in milliseconds>

If the device is added through the Profile Wizard, the alarm priority will be 1, 2, and
3 for _PLSALM_HIGH, _PLSALM_MEDIUM, _PLSALM_LOW alarms respectively.

The user can define specific wave files for the sounds, PowerLogic SCADA also
supports the following Windows operating system sounds:

SystemAsterisk

SystemExclamation

SystemQuestion

SystemDefault

SystemHand

SystemExit

SystemStart
2. After alarms are set up: When an alarm occurs, its specified alarm sound will play

continually according to the specified interval. The alarm sound will stop when
either:
— the user clicks Silence Alarm on the alarm page
— the alarm is acknowledged
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Restoring and Backing Up Projects
In this section, you will find these topics:

Restoring a Project on page 129

PowerLogic SCADA Backup on page 129

Restoring a Project
To restore a project, overwriting its current settings, follow these steps:

1. From the Citect Explorer, select the project you want to restore; click Tools >
Restore.

2. In the Restore from box, browse to the location of the file you will use to restore.

3. In the To box, check Current Project.

4. In the Options box, check Configuration files to restore backed up INI files and the
TimeSyncConfig.xml file (used to store time synchronization settings). If you backed
up the sub-directories under the project, the directories will be listed under Select
sub-directories to restore. You can restore all or no sub-directories, or you can
select specific sub-directories to restore.

5. Click OK.

PowerLogic SCADA Backup
Use this feature to back up a Citect project file. To back up a Profile Editor project file,
see Profile Editor Export on page 71.

1. From the Citect Explorer, click Tools > Backup.
2. At the Backup Project window, select the project you want to back up

3. Browse to the location where you want to store the backup file.

4. In the Options box, check “Save configuration files.” This saves the citect.ini file.

5. Click OK.

The backup .CTZ file is written to the following location:This is a Citect Zip file; you can
open it with WinZip.
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The Project Color Change Tool
Use this tool to assign colours for busbars and circuit breakers that are generated by
genies in graphics pages. You will set separate colours for each project in your system.
There are seven states (Error, Intermediate, etc.), for which you can assign colours.
You can also select a second “flash” colour for any state; when the busbar or circuit
breaker is in that state, the colour will alternate between the two colours.

It is best to set the project colours before you add genies to the project. A large number
of standard genies (beginning with PLS_) are already available; however, you can
create a custom genie and add it to the project. If you choose to add genies, follow the
instructions in Adding a Custom Genie for Use in the Color Change Tool on page 130.

To begin changing colours, see Changing the Colours of Busbars and Circuit Breakers
on page 130.

Adding a Custom Genie for Use in the Color Change Tool
To be able to change colours for a project, all of its genies must be set up in the
manner described below. The standard PowerLogic libraries of genies already have
this custom setting, but if you need to create a genie or use one that is not in the
PowerLogic libraries, follow these steps:

1. From Citect Explorer, choose the project for which you want to set/change colors.
2. From the Graphics Builder, click File > New > Genie.

3. On the Objects toolbar, click the object you want to draw or insert, then click on the
graphics page.

4. On the Properties page, set the type to Multi-state (this will be on one of two tabs:
Appearance or Fill). Set its conditions and states, then click Apply. If you need help
adding conditions and states, click Help.

NOTE: The State colors that are shown on this tab are what you will be changing in
the Project Color Change Tool.

5. Click the Access tab. In the Description field, type:

<PwrLineColor>
6. Click OK to save the genie.

7. Open the graphics page, and drag and drop the genie onto the page.

8. To run the Project Color Change Tool, you need to close any open graphics pages.

Changing the Colours of Busbars and Circuit Breakers
Open the Project Color Change tool: from the Citect Editor screen, click Tools > Project
Color Change Tool. Then follow these steps:

1. If a prompt displays telling you that Citect.ini location has changed, click OK. There
is no need to locate the file.

Colours will be changed for the genies in a project only if these conditions are true:
— The genie was set up with a multi-state type and that it has <PwrLineColor> as

its description on the Access tab.
— The selected project has supported genies.
— The selected project's direct include projects have supported genies.
— The selected project's direct include project has an include project with

supported genies, and the direct include project is not hidden.

NOTE: If no projects display, one of two things is true: either your projects are
“hidden” (in the Include folder) or the genies in the project do not have the
<PwrLineColor> setting described in Adding a Custom Genie for Use in the Color
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Change Tool on page 130. If any genie on the page does not change colour, check
to be sure that you have added the setting for that genie.

2. At the message telling you that PowerLogic SCADA is running and will be hidden,
click OK.

The Project Color Change Tool displays (the colours you see may differ):

3. From the Project Name drop-down menu, choose the project for which you want to
assign colours.

4. Click the selected colour for the first state or condition that you want to change:

Category State of the Busbar or Circuit Breaker PowerLogic SCADA
Multi-State Colours*

Error State The circuit breaker has lost communication. ABC / ABC
(colours 1 and 2)

Intermediate state The circuit breaker is between states, e.g., being racked
in or racked out. ABC (colour 3)

De-Energized state The circuit breaker is de-energized or inactive. ABC (colour 4)
Voltage level 0 These levels correspond to the four voltage levels that

(busbar voltage level), entered when adding a busbar to a
drawing. These correspond to the levels being used by
the standard that applies for each installation.

ABC (colour 5)
Voltage level 1 ABC (colour 6)
Voltage level 2 ABC (colour 7)
Voltage level 3 ABC (colour 8)

* The Symbol Properties screen is used when creating conditions for multi-state
colours. See Creating and Editing Genies on page 123 for details on animating a
custom genie.

NOTE: Although the Color Change Tool uses only numbers 1 through 8, Citect allows
you to use 0. However, using 0 produces unstable colours in graphics. Thus, we
recommend that you NOT use colour 0.
5. From the Windows Color screen, choose the new colour, then click OK.

6. If you want busbars and circuit breakers in the Graphics page to flash when they
are in a particular state, click Flash for that state, then add the “flash” colour. For
example, if you set the error state colour to red, you might add a flash colour of
green.

When the graphics page is opened for viewing and busbars or circuit breakers are
in that state, they will flash continuously between the two colours.

7. Continue to change state colours, or click Save Selected Colors to save your colour
changes.

8. To update graphics pages with the new colours, go to the Graphics Builder. Click
Tools > Update Pages.

The colours will be used for busbars and circuit breakers in all genies for this project
(as long as the genie has Multi-state as its type and has the description of
<PwrLineColor>.

© 2011 Schneider Electric All Rights Reserved 131



Using Cicode to Customize a Project
Cicode is a programming language designed for use in PowerLogic SCADA to monitor
and control plant equipment. It is a structured language similar to Visual Basic or 'C'.
You need no previous programming experience to use it. However, it is assumed that
you will have received Cicode training from PowerLogic SCADA before you attempt to
use Cicode.

Using Cicode, you can access all real-time data (variables) in the PowerLogic SCADA
project, and all PowerLogic SCADA facilities: variable tags, alarms, trends, reports, and
so on. You can use Cicode to interface to various facilities on the computer, such as
the operating system and communication ports. Cicode supports advanced features
including pre-empted multitasking, multi threads, and remote procedure calls.

For information about driver-specific INI parameters that you can configure, see
Appendix 2: Using Citect INI Parameters on page 171 .

For information about other parameters, see the CicodeReference help file, located in
Program Files\Schneider Electric\PowerLogic SCADA 7.20\Bin.
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Customizing PowerLogic SCADA Default Behaviours
In this section, you will find these topics:

Time Zone Settings on page 133

Time Synchronization on page 133

Trend Tag Scan Intervals on page 134

Calculating Disk Storage for Trends on page 135

To learn about the PowerLogic SCADA parameters that you can use to configure
drivers, see Appendix 2: Using Citect INI Parameters on page 171.

Time Zone Settings
The system allows you to interact with devices located in a different time zone than the
PowerSCADA I/O Server. To do this, the system converts any alarm/waveform
timestamp as well as the actual time sent within the Set Time command from / to the
local time zone. In order to take into account daylight savings properly, the Windows
time zones database is used. Thus, time zone names must be taken directly from this
database (case-insensitive), otherwise the system will default to using the I/O server’s
local time zone. The Windows time zone database is located in the Windows registry in
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Time
Zones\. Examples of time zone names are
• AUS Central Standard Time
• China Standard Time
• Pacific Standard Time (Mexico)

Time zones for remote devices can be specified on two levels:

1. Use section [ProtocolName.ClusterName.PortName.IODeviceName] to specify the
time zone for a particular device, e.g.

[PLOGIC870.Cluster1.PM870_Port.PM870_Device1]

Timezone = Singapore Standard Time
2. Use general section [POWERLOGICCORE] to specify the time zone for all devices,

e.g.

[POWERLOGICCORE]

Timezone = Mountain Standard Time

The device-specific time zone specification takes precedence. In other words, if both of
the above examples are present in the Citect.ini file, the PM870_Device1 would be
located in “Singapore Standard Time” time zone, and all the other I/O devices in the
project would be located in “Mountain Standard Time” time zone.

If there is no time zone specification (or if it does not match the time zone from
Windows database), the device would be in the same time zone as the machine where
the I/O Server is running; thus, no time conversion will be done.

If only the first of the above examples is present within the Citect.ini file, the PM870_
Device1 would be located in “Singapore Standard Time,” and all the other devices use
the current local time zone.

Time Synchronization
Current time can be sent to the corresponding device by means of Set Time command
or (in case of Sepam) by writing directly to the corresponding registers within the
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device. In addition to the manual procedure, this process can be scheduled to occur
periodically (using PowerLogic SCADA events).

Non-manual time synchronization causes the Set Time command to be sent
automatically, based on a device state or event originating from within the device.

Automatic time synchronization applies only to Micrologic and PM devices and takes
place based on the following rules:

1. For Micrologic devices, the value of the top-most bit of the register 679 is examined
(for both the Circuit Breaker Manager and the Chassis Manager). If the bit is equal
to 1, it means that the device is out of sync and needs to be synchronized.

2. For PM devices, an alarm 50700 (“Unary Power Up / Reset”) indicates that the
device needs to be synchronized. In addition, bit 6 of register 3055 of the device is
examined. If this bit is equal to 1, the device has a real-time clock; so automatic time
synchronization should never take place.

Trend Tag Scan Intervals
When you select a trend tag for a device profile (Add/Edit Device Profile screen), the
tag will be scanned at the “long” interval” (every 15 minutes, with FIFO storage of 12
months); but certain trend tags have an additional “short” scan interval. This interval is
set by default at 5 seconds, with FIFO storage of two weeks.

The default tags are: Current A, Current B, Current C, Voltage A-B, Voltage B-C,
Voltage C-A, Power Factor Total, Apparent Power Total, Reactive Power Total, Real
Power Total, and Frequency. When you choose one of these tags for trending, you will
get both long and short interval trending. The long interval trend will use the trend tag
name from the Profile Editor. The short interval trend tag will have the same name as
the long tag with an “s” appended to it.

You can edit the Profile Editor.exe.config file to add or delete tags that will have short
scan intervals, and to change the short scan interval for all of the tags that are listed.

To edit short scan interval settings, follow these steps:

1. Locate and open Profile Editor.exe.config in Notepad:

[Project Drive]\Documents and Settings\ All Users\Application Data\Schneider
Electric\Profile Editor\v7.20

Vista operating systems: [Project Drive]\ProgramData\Schneider
Electric\PowerLogic\Profile Editor\v7.20)

2. To change the short scan interval, scroll the "TrendShortIntervalSamplePeriod"
setting. The default value is 00:00:05, or five seconds (HH:MM:SS). Changing this
rate will change the interval for all of the tags that are listed in the setting in step 3.

3. To change the tags that are included in the short scan interval, scroll to the
"TrendShortIntervalTags" setting. The numbers listed (defaults:
1003,1004,1005,1050,1046,1042,1014,1015,1016,1001,1034) are the tag IDs.
You can add or delete tags. Tag IDs are listed on the Define Device Type Tags tab
(when the Advanced Properties option checked).

NOTE: If you choose a device that includes the tags in this list, you will always have
these short scan interval tags included.

For example, if you wanted to change the scan interval to ten seconds and add
Overcurrent A for a CM4000, you would edit these two lines in this way:

"TrendShortIntervalSamplePeriod" value="00:00:10"

"TrendShortIntervalTags"
value="1003,1004,1005,1050,1046,1042,1014,1015,1016,1001,1034,19"
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Calculating Disk Storage for Trends
There are two methods of calculating disk space usage for trends: scaled and floating
point. The Profile Editor uses floating point by default. For more information on these
calculations, see Calculating Disk Storage in the CitectSCADA.chm help file (Start >
Programs > Schneider Electric > PowerLogic SCADA 7.20 > PowerLogic SCADA
Help).
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Waveform Management
This chapter discusses how waveforms are stored and associated with alarms. In this
section, you will find these topics:

Waveform Storage on page 137

Waveform Database and Special Waveform Tags on page 138
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Waveform Storage
Waveform records are organized within devices into files. These files are periodically
checked for and downloaded as they appear on the device. When downloaded, on the
PowerLogic SCADA I/O server the files are converted into a Comtrade format and then
stored in a hierarchical fashion.

A single waveform will be stored as follows:

<Waveform DB
root>\<ClusterName>\<IODeviceName>\Waveforms\<UTCTimestamp>.CFG

<Waveform DBroot>\<ClusterName>\<IODeviceName>\Waveforms\
<UTCTimestamp>.DAT

For example,

C:\Data\Cluster1\Sepam_IODev\Waveforms\

DST_00000000001203566197_0000000511_utc.CFG

DST_00000000001203566197_0000000511_utc.DAT

Waveform DB root path is configured in the WaveformDB configuration section.

NOTE: in case of redundant I/O devices, only the name of the primary I/O device will be
used when waveform storage path is constructed.

The CFG file is a Comtrade configuration file, and the DAT file is the Comtrade data
file. Within the CFG file is a timestamp that reflects the device time start time of the
waveform (this time is not adjusted to the I/O Server time zone or daylight saving, but it
is stored per the device configuration). The file name has the UTC time in seconds
since 1970 of the waveform.

The prefix of waveform file name reflects the type of the waveform. Currently,
waveforms of the following types are supported:

DST_ Disturbance waveform

ADT_ Adaptive waveform

SST_ Steady state waveform

If it is detected that the waveform data file has changed while it is being downloaded,
the file gets discarded and is not stored on the IOServer.
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Waveform Database and Special Waveform Tags
PowerLogic SCADA allows you to browse the waveform database for specific I/O
devices. Search for all waveforms within certain time frame is also supported, allowing
you to search for all waveforms that could be linked with a given alarm. When you
perform this search, a list of all matching waveforms displays. If there are multiple
waveforms in the list, you can select the waveform you want to view.

In addition, there are two special digital waveform tags defined (0 = FALSE, 1 = TRUE):
• WaveformDownloading: indicates whether a waveform file is currently being

downloaded
• WaveformCollectionEnabled: indicates whether the waveform collection is

enabled at all

The figure below illustrates a configuration example and replication and linkage
processes.
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Graphics: Using the Runtime Environment
This chapter discusses the Graphics page in the runtime environment. In this section,
you will find these topics:

Launching and Closing the Runtime Environment on page 140

Viewing the Graphics Page in the Runtime Environment on page 141

Logging On to the Runtime Environment on page 141

Viewing the Interface on page 141

Viewing the Alarms/Events Page on page 142

When Alarms do not Display Correctly on page 145

Event/Alarm Log Columns Table on page 145

Changing the Display Name in an Alarm or Event Log on page 146

Filtering and Freezing Log Views on page 147

Using the Analysis Page on page 149

Using the Equipment Pop-Up Page on page 150

Multi-Monitor Support on page 155

Using the Graphics Test Mode on page 156

Using the Demo Mode on page 157
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Launching and Closing the Runtime Environment
Launching Runtime: To launch the runtime environment, click Start > Programs >
Schneider Electric > PowerLogic SCADA 7.20 > PowerLogic SCADA Runtime. Or, from
the Project Explorer, Project Editor, or Graphics Builder design-time page, click File >
Run.

Closing Runtime: There are two ways to shut down the runtime environment:
• You can click the “X” in the upper right corner of the screen. You must enter a user

name and password. (It is important to define at least one user in your project.)
• From the computer taskbar, click the Runtime icon:

This displays the Runtime Manager screen. Click Shutdown All. There is no
required user name/password. Unless you disable this feature on the taskbar,
users can shut down the runtime environment without having to enter any
information.
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Viewing the Graphics Page in the Runtime Environment
In the runtime environment, the Graphics Page displays with the appearance that is
determined by the Menu Configuration file for this project. If you need to change the
appearance of tabs and menus, see Using Menu Configuration to Edit Pagemenu.dbf
(Changing the Graphics Page Appearance) on page 121.

In this section, you will find these topics:

Logging On to the Runtime Environment on page 141

Viewing the Interface on page 141

Viewing the Alarms/Events Page on page 142

Using the Analysis Page on page 149

Using the Equipment Pop-Up Page on page 150

Logging On to the Runtime Environment
In the upper left-hand corner, click the Login link. Then enter your User ID and
password. The features that are available will vary, depending on the user level.

Viewing the Interface
The runtime environment page includes a variety of tabs. If your page is created based
on the Normal template from the pls_include_1 library, you will see the following:

In the upper left corner of the screen, the project name is listed. Your logon name is
below that. At the top of the page, there are left and right navigation arrows that allow
you to go to previously visited pages.

These two arrows allow you to go back and forward one page in your navigation
history. To see the history of visited pages, click the small down arrow next to the right
arrow. This displays a listing of visited pages (the current page is checked). To jump to
a page in this list, click it in the menu.

Just beneath the left and right arrows is the alarm banner. It lists the last five active
alarms.

Beneath the alarm banner is a tabbed-style menu. Its contents are determined by the
information entered in the Menu Configuration tool: Using Menu Configuration to Edit
Pagemenu.dbf (Changing the Graphics Page Appearance) on page 121. These tabs
display in two rows:
• The upper row is typically used for organizing pages into several topics (or tabs). A

typical system would include topics for single lines, alarms/events, analysis (for
trends), and system supervision (allows you to view the network connection topics).

• The lower row lists the links/pages under the topic that is currently selected in the
upper row. If you select the single lines topic on the upper row, the lower row
displays all of the links to individual single line pages.

If there are more links available than the ones that fit on the page, a small arrow
displays at the right hand side of the row. Click the arrow to display a pop-up menu of
the remaining links. Click a link in the menu to shift the contents of the row to make it
visible for selection.

NOTE: When viewing the single lines: if the busbars and circuit breakers do not display
with the expected colors, it could be that a custom genie is not set up correctly. If you
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are using a custom genie, verify that <PwrLineColor> has not been left out. See Adding
a Custom Genie for Use in the Color Change Tool on page 130 for details on
customizing genies and displaying colors.

Communications Loss

When there is a communication loss for a device, the genie or any part of the genie on
the one-line page should have cross-hatches (gray dots) over the affected area, and a
communication loss (CL) indication displays on the genie. An alarm should also
annunciate. The color state before communication was lost will remain unchanged.

However, the indication of loss of communications does not filter through the
entire bus animation: the downstream part of the drawing may still appear as if
communication is working. When any part of a one-line drawing loses
communication, do not continue to trust downstream readings until you address
the loss of communication.

Viewing the Alarms/Events Page
See also: Using the Equipment Pop-Up Page on page 150

To view the alarms or events, click the Alarms/Events tab; then select the tab for the
Alarm Log or Event Log. The Event Log displays all alarms and events that have
occurred. The Alarms Log displays enabled alarms.

The Event Log

The Event Log displays all alarms and events that have occurred.

The Alarm Log

The Alarm Log displays active enabled alarms. To sort on any of the columns, click the
column title.

To filter the alarms that display, click Filter, just above the Date column (see
instructions on using the filter option in Filtering and Freezing Log Views on page 147).
From the Advanced Alarm Filter window, you can filter by date range, by text matches
for various attributes, or by alarm type.

To freeze the view of the current log (this is also true for unacknowledged or disabled
alarms), click Freeze in upper right corner of the screen. (Note that the button name
changes to Unfreeze.) No additional alarms will display and none will drop out until
you click Unfreeze.

Each alarm provides additional options. To view these options, right-click the alarm.
Then you can:
• acknowledge or disable the alarm
• view alarm detail (similar to the genie status page in the single lines of the runtime

environment)
• view waveforms: If this option does not display, there are no waveforms for this

alarm.) Waveforms can display only if the device is set to “acquire on event,” and
the waveform option is checked in the Profile Editor (see Enabling Waveforms on
page 51).

When the waveform is available for viewing, it displays when you click this link.
Waveforms must be correctly set up before they will display. See Enabling
Waveforms for Onboard Alarms on page 126 for more information. See Viewing
Waveforms on page 151 for instructions on viewing waveforms.

When you select the waveform option, you may see a message telling you “please
try again after waveform has been acquired.” This means one of two things:
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— the alarm has been acquired at the device, but it has not yet been passed to
PowerLogic SCADA

— the device was not set to acquire a waveform, and the waveform option was
checked in the Profile Editor

NOTE: If there are multiple waveforms captures for this alarm, and if there is a
disturbance waveform, it is the only one that is available here. If there are both an
adaptive and transient, but no disturbance, the one with the earliest time stamp
displays.

Unacknowledged Alarms and Disabled Alarms

As with the Alarm Log, these logs display either unacknowledged alarms or disabled
alarms. The sort and filter options operate as they do in the Alarm Log.

Alarm and Events Logging

Alarms from the Event Log can be saved to a file on the alarm server, thus protecting
them from being lost when the FIFO size is passed. This feature is disabled by default,
but it can be enabled by setting the FileFormat INI parameter.

[PLSEventLog] FileFormat: Determines the file format to be used for logging
alarm/event data to disk files.

Allowable Values:
0 - (Disable)
1 - (CSV)
2 – (XML)

Default value: 0

Sorting Logs

To sort a log, displaying information according to one of its columns, double-click the
title. To sort the date/time, double-click the Date column; the times within that date will
automatically display, newest to oldest. When you exit the log, the settings are lost.
 When you re-enter the log, you will need to perform the sort again.

The alarms display in this order: active alarms in chronological order followed by
inactive alarms in chronological order.

Filtering and Freezing Information

To filter the information that displays, click Filter, just above the Date column (see
Filtering and Freezing Log Views on page 147 for more information). From the
Advanced Alarm Filter window, you can filter by date range, by text matches for various
attributes, or by alarm type.

To freeze the view of the current log, click Freeze, in the upper right corner of the
screen. No additional alarms will display, and none will drop out, until you click
Unfreeze.

Alarm Viewing Options

Each alarm provides additional options. To view these options, right-click the alarm.
Then you can:
• acknowledge or disable the alarm
• view alarm detail (similar to the genie status page in the single lines of the runtime

environment)
• view waveforms: If this option does not display, there are no waveforms for this

alarm.) Waveforms can display only if the device is set to “acquire on event,” and
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the waveform option is checked in the Profile Editor (see Enabling Waveforms on
page 51).

Choose this option to display waveforms that were captured by this device in the 24
hours before the time of the alarm. You can change the time range from the Search
Waveform popup that displays. Choose a date range, or click All Available to
display everything for that device in the waveforms directory. Click OK to display the
list of waveforms that match the time range. Choose the waveform you want to view,
and click View.

For information about the options available on the waveform, see Viewing
Waveforms in Using the Equipment Pop-Up Page on page 150.

Waveforms must be correctly set up before they will display. See Enabling
Waveforms for Onboard Alarms on page 126 for more information. See Using the
Equipment Pop-Up Page on page 150 for instructions on viewing waveforms from
the genie status page.

When you select the waveform option, you may see a message telling you “please
try again after waveform has been acquired.” This means one of two things:
— the alarm has been acquired at the device, but it has not yet been passed to

PowerLogic SCADA
— the device was not set to acquire a waveform, and the waveform option was

checked in the Profile Editor

If there are multiple waveforms captures for this alarm, and if there is a disturbance
waveform, it is the only one that is available here. If there are both an adaptive and
transient, but no disturbance, the one with the earliest time stamp displays.

See Changing the Display Name in an Alarm or Event Log on page 146 for more
information.

Viewing, Printing, and Export Options

Each of the logs includes these navigation buttons:

Button Description

Acknowledge Current Page of Alarms: Click to acknowledge all of the alarms that display on the
current page.

Note: You can acknowledge individual alarms in this way: On the left side of the alarm that you want
to acknowledge, right-click, then choose Acknowledge. On a touch screen, tap the left side of the
alarm to display themenu, then tap "Acknowledge."

Silence Alarms: Click to silence all active alarms. This does not clear unacknowledged alarms or
make alarms inactive; it only stops the audible portion of the alarm.

Print/Export Alarms: Click to begin printing or exporting part or all of the log. Select All or the number
of pages, then choose whether to print or export (to HTML file, which can then be opened in Excel or
 OpenOffice). When printing, the default location is:

Windows XP: Documents and Settings\All Users\Application Data\Schneider Electric\PowerLogic
SCADA 7.20\Data

Vista operating systems: ProgramData\Schneider Electric\PowerLogic SCADA 7.20\Data

Notes: When printing: To avoid truncation of data, choose the Landscape orientation.

When using Internet Explorer 8 and a dot matrix printer, youmight have problems with overlapping
columns in the printout. To solve this, either switch to Internet Explorer 7 or select a "square"matrix
(e.g., 180 x 180 DPI).

Save Columns: Click to save the configuration of columns that you have selected after you close the
Alarm Log. Youmust be an administrator to do this.

Add Columns: Click to add additional columns. Choose from the list. Columns will be placed on the
right side of the table. SeeEvent/Alarm Log Columns Table on page 145 for a list of columns an
names.
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Button Description

Auto Fit Columns: Click to correct the alignment of columns, to ensure that they all fit on the page.

Page Number: Display only; this is the page number that you are viewing.

Page To Top and Page Up: Click to either go to the top of the log or to move up one page.

Page Down: Click to move down one page.

Note: If the page is full, but there are nomore alarms, clicking here will display a blank page. Click it
again to return to the previous (full) page.

When Alarms do not Display Correctly
Alarms may display incorrectly for a variety of reasons. The following table lists some common issues and res-
olutions.

Issue Cause Resolution

Alarm Log and Event Log do not
display any data.

If there are two alarm servers,
primary and redundant (standby),
they may be synchronizing. This
causes data to display slowly.

Data will display; but it could take several minutes.

Alarms display in Alarm Log, but not
in Event Log or Banner

Themissing alarm(s) were triggered
while the runtime graphics page was
not running.

These alarms will only display in the Alarm Log unless they are
triggered again while the runtime graphics page is running. This will
only affect alarms that were triggered before the runtime screen
was running.

PC-based and onboard alarms do not
appear or disappear as expected.

This is due to the difference between way the two alarm types are handled:

When an alarm is enabled, the system processes alarms for that tag. If the alarm is disabled, the system
cannot process alarms for that tag.

For the PC-Based alarm, the condition for this is, for example, IA > 80; if the tag value for IA is > 80, the
appearance will show. The tag is constantly scanned, so the condition triggers the alarm once it is enabled.

For the Onboard alarm, the condition for this is a digital tag, which is set by the driver when a new alarm
record on the device is read. If the alarm was disabled, the driver cannot set the digital tag. When the alarm is
enabled, nothing happens because the alarm was already "processed" by the driver and will never get
reprocessed.

Thus, there is no resolution.

The number of alarms that display is
fewer than the limit set by Alarm
Summary length parameter.

This happens when the number of
alarms exceeds 1000 and the system
has multiple clusters.

Use one or more of these procedures:

Set alarm filtering in the alarm viewer to reduce the number of
alarms that can display.

Only support a one-cluster system.

If a multiple-cluster system is necessary, display a separate slarm
page for each cluster.

Cannot filter on categories for
alarms.

The new categories do not display in
the list when you want to select them.

Use Custom Filter 8 instead. Currently, it is the only means
available for adding custom filtering to alarms. For more
information, see Filtering and Freezing Log Views on page 147.

Page Down button causes an empty
page to display.

The last alarm was on the previous
page. When there are nomore
alarms, pressing Page Down displays
a blank page.

Click Page Up to return to the previous page (and the last alarms for
the system).

Event/Alarm Log Columns Table
This table lists the column headings that are available for use when viewing the event
log and alarm logs. The field name is the name that you select when you add a
column. The display name is the default column heading in the log. To change the
display name, see Changing the Display Name in an Alarm or Event Log.
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Field Name Default Display
Name Description

Tag Tag alarm tag

Name Description description of alarm e.g., Sag Vcn or Under Voltage B-C

Cluster Cluster cluster name to which the alarm belongs

Date (OnDate:
event log) Date date (MMDDYYYY) that alarm annunciated

Time (OnTime:
event log) Time time (HH:MM:SS) that alarm annunciated

TimeMS
(OnTimeMS: event
log)

Time time (HH:MM:SS:MS) that alarm annunciated

OffDate OffDate event log only: date (MMDDYYYY) that alarm dropped out

OffTIme OffTime event log only: time (HH:MM:SS) that alarm dropped out

AckDate AckDate event log only: date (MMDDYYYY) that the alarm was
acknowledged

AckTime AckTime event log only: time (HH:MM:SS) that the alarm was acknowledged

AckTimeMS AckTimeMS event log only: time (HH:MM:SS:MS) that the alarm was
acknowledged, with milliseconds

State State state of the alarm: disappearance, appearance defaults, or
customized from the alarm description field

LogState LogState alarm logs only: active or inactive

SumState State event log only: state of the entry in the event log: disappearance,
appearance

AlmComment AlmComment event log only: these entries come from the time-stamped digital
alarm window “Comment” fields

Comment Comment event log only: displays comments from the alarm

UserName User user name associated with the event

FullName FullName full user name associated with the event

custom1 Equipment default equipment name displays; used for alarm filtering and
viewing

custom2 n/a: waveform
information used for waveform acquisition

custom3 n/a: metadata,
categorization

These are all alarm/event attributes.

custom4 n/a: metadata, alarm
type

custom5 n/a: metadata, alarm
group

custom6 n/a: metadata,
subcategorization

custom7 n/a: metadata, alarm
level

custom8 n/a: user filter used for customized filtering

Changing the Display Name in an Alarm or Event Log
Although you cannot delete column headings in the alarm and event logs, you can add
and edit them via the System Parameters. To do this:

1. Open your project.
2. Open the Project Editor. Click System > Parameters.
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3. Scroll down through the options (do not use the drop down list, use the scroll bar on
the right side) until the correct Section Name and Name display. In this
documentation, the notation used is:

[Section Name]Name

For the Event Log, Find record [Format]Summary. If it does not exist, add a new
record in the form, and enter the details. The Value field lists all of the columns in
the format of:

{F1,W1}{F2,W2}{F3,W3}... where X1 is the field name (selected when adding
columns to a log) for the first column, X2 is the field name for the second column,
etc; and W1 is the width of the first column, W2 is the width of the second column,
etc. The width specification is optional. The column is automatically set to an initial
szie when the page is displayed.

For all other alarm pages: Alarm Log, Unacknowledged Alarms Logs, and
Disabled Alarms, use [Format]Alarm. Again, use the Value line to change
elements.

For equipment pop-up pages, use [Format]Equipment.
For the alarm banner, use [Format]LastAlarm. To change the display name of a
column, replace or add parameter [AlarmHeading]FieldName where FieldName is
the field name used in the [Format] parameters. Set the Value field to the display
name for the field.

4. After making any changes, compile and run the project. The headings will be
changed when you view the logs from the Graphics Page.

Filtering and Freezing Log Views

Filtering Information

To filter the information that displays in any of the alarm logs or the event log, click
Filter (in the upper left corner of the screen). The Advanced Alarm Filter screen
displays. The table below describes its settings.

Filter Option Description: Display all alarms for:

Basic Filter box:

Start Date/End
Date

a date range.
Choosing only a start date displays alarms from that date to the current date.
Choosing only an end date displays alarms for the past year up to that date.
For example, to display alarms only for today’s date, enter only a start date.

Start Time/End
Time

a time range.
Choosing only a beginning time displays alarms from that time through the end of the day
(23:59:59 or 11:59:59 p.m.).
Choosing only an ending time from the start of the day (00:00:00 or 12:00:00 a.m.) through the
time selected.

Tag

a single tag; use tag name only, do not include equipment name. For example, enter
MMXU1\A\phsA, not MainCM4\MMXU1\A\phsA.

To filter on tag and equipment, enter the tag here and the equipment in the Equipment Name
field.

Equipment Name a device (entered when using the ProfileWizard or Automation Interface; (listed in Citect
Explorer >System >Equipment)

Cluster a single cluster, which was added when setting up the project (listed in Project Editor >Servers
>Clusters)

Alarm Name the descriptive information in the Alarm Name field of the Time Stamped Digital Alarms page
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Filter Option Description: Display all alarms for:

Alarm Description Alarm Desc from Time Stamped Digital Alarms: a customized on and off text description,
such as “active” and “inactive”

Custom Filter 8

There are eight custom filters, which can be assigned by the customer in each alarm. A group
of alarms in a specific location could have the same name in CUSTOM8 so that custom
filtering can be easily applied.

Custom8 has a default assignment of “Equipment.” To change custom filter assignments, use
the AlarmFormat parameter (Project Editor >System >Parameters). This is the only means
available for filtering on a custom field. When viewing the log, you can use the new custom
filter by typing it into the Custom  Filter field.

Group Filter box:

Categorization

These “alarm filters” are created in the Profile Editor when alarms are created.

Alarm Type

Alarm Group

Subcategorization

Alarm Level

Type Filter box: These are advanced PowerLogic SCADA topics; see PowerLogic SCADA help for more
information.

State the state of the alarm

Type the data type established for the alarm tag

Area the area associated with the alarm

Category

This is the alarm category. There are four predefined categories (high, medium, low, and
event).You can assign alarms to their own categories by changing the equipment profiles and
then re-generating the database.

See the following table (Categories and Priorities) for a list of the categories and their defaults.

Keep inmind that alarms that are categorized as events need to keep the category of _PLS_
ALM_EVENT (category 1004).

Priority

This is the priority of the alarm category; not used in the default PLS_Include project.

As with the category, priority has defaults (see Categories and Priorities table below). You can
change these settings in the equipment profiles. However, be sure that you use priority 1 for
events.

Category Label Category Number Priority Number

_PLSALM_HIGH 1001 1

_PLSALM_MEDIUM 1002 2

_PLSALM_LOW 1003 3

_PLSALM_EVENT 1004 0

Freezing the View

To freeze the view in an alarm window, click Freeze in the upper left corner of the
screen. This “locks” the alarm page so that only the alarms that are currently displayed
will remain in view. The button name changes to “Unfreeze.” Alarms may continue to
occur, but they will not display until you click “Unfreeze.”
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Using the Analysis Page
The Analysis Page offers two options for viewing data trends. In either option, you must
select the tag(s) that are to be included. To be available for viewing in trends, a tag
must be included in a device profile, and it must have the “Trend Tag” box checked
(see Adding, Editing, or Deleting a Device Profile on page 52 for more information).

Trend data is automatically logged when you check “Trend Tag” for tag and then add it
to the PowerLogic SCADA project. If too many tags are chosen as trend tags, it could
cause the hard drive to fill up.

NOTE: The maximum number of tags (pens) that will display correctly on the screen is
ten. If you exceed ten pens, labels for these pens will not display correctly. Use one of
these methods to correct this issue:

1. Enlarge the window to accommodate the extra pens/labels.
2. Write custom code to cause the labels to always be in the same position,

overlapping each other when the trend pen is created. The user can then move the
label around for better viewing.

3. As with option number two, control the label positions with code; but then, move the
labels back to that same spot when a user selects the trend pen again.

There are two methods of calculating disk space usage: scaled and floating point. For
more information on these calculations, see Calculating Disk Storage in the
CitectSCADA.chm help file (Start > Programs > Schneider Electric > PowerLogic
SCADA 7.20 > PowerLogic SCADA Help).
• Trending: Use this option to view historical trends. To select tags, click the Add Pen

button on the toolbar:

Then associate the pen with a tag. By default, most trend data is polled every 15
minutes, and it is stored for one year (Citect Project Editor > Tags > Trend Tags) or
until it is FIFO’d out. Some tags are polled every 5 seconds and are stored for two
weeks. These tags are:

Current A
Current B
Current C
Apparent Power Total
Reactive Power Total
Real Power Total
Voltage A-B
Voltage B-C
Voltage C-A
Frequency
Power Factor Total

• Instant Trend: Use this option to view real-time trends. This allows viewing of data
that is not set up for storage. To select tags for this trend, click the Instant Trend
Selector on the toolbar:

NOTE: If one of the pens returns a value of "1.#R,' the tag selected was not valid; no
number could be reported for it. None of the values for any of the pens in the trend
will be updated. To solve this issue, close the trend and open it again. This time, do
not include the pen that gave the invalid return.

In either trending option, click Help for help using the tool:
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Using the Equipment Pop-Up Page
See also: Viewing the Alarms/Events Page on page 142

This page displays when you click on a device symbol/genie on a single-line page.
This page shows a detailed status for a particular device. Some controls on this page
are available only to users with certain privilege levels (see Adding and Modifying
User Accounts on page 160 for user access levels).

One of two status pages displays. The page on the left illustrates the status page for a
meter genie. The page on the right illustrates the status page for a circuit breaker
genie.

At the top of the page, the most recent alarms and events are listed (racked in/out,
Comms Loss, etc.). To view details about an individual alarm or event, right-click the
alarm. You can view:
• a waveform. (If you do not see “Waveform” in the list when you right-click the alarm,

there are no waveforms for this alarm.) Waveforms can display only if the device is
set to “acquire on event,” and the waveform option is checked in the Profile Editor
(see Enabling Waveforms on page 51).

When the waveform is available for viewing, it displays when you click this link.
Waveforms must be correctly set up before they will display. If there are multiple
waveforms, you must select from the list that displays (by default, the waveform
search returns all waveform files acquired within the 24 hours prior to the time of
the alarm). See Enabling Waveforms for Onboard Alarms on page 126 for more
information. See Viewing Waveforms on page 151 for instructions on viewing
waveforms.

When you select the waveform option, and no waveforms are returned, one of two
things is likely:
— the alarm has been acquired at the device, but it has not yet been passed to

PowerLogic SCADA
— the device was not set to acquire a waveform, and the waveform option was

checked in the Profile Editor
• details about the device (currents, voltages, powers, resets, others.),
• Finally, you can acknowledge or disable the alarm. Acknowledged and disabled

alarms are moved to their own sub-tabs.

On the left side of the of the status page, status messages display, based on the tags
defined for equipment referenced in this genie. The list varies, depending on the
device. Possible tags are:

XCBR1\Pos Position (circuit breakers only)
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XCBR1\CCBRkdPos Racked Out (circuit breakers only)
XCBR1\CBRkdPos Matching Fault/Trip Circuit Supervision (circuit breakers only)
XCBR1\Loc Local/Remote (circuit breakers only)
XCBR1\ESwPos Earth Switch (circuit breakers only)
PTRC1\Op Tripped
LPHD1\EEHealth Communication Failure

NOTE: For MicroLogic Type P devices, circuit breaker status fields will display #COM if
the device does not have a CCM. Thus, you should not add any tags that refer to the
CCM, such as Racked In/Racked Out.

On the right side of the page, real-time values will display for the tag type that you
chose in the Value field when you added the genie in the design-time mode. For
example, if you enter MMXU1\A\phsA as the value, you will see real-time currents here,
as illustrated above. If you did not enter anything in the Value field when adding the
genie, this area will be blank.

At the bottom left corner of the circuit breaker status page, Open, Close, Reset (for
circuit breakers).

At the bottom right corner, are the Setpoints, Trend, and List options. See the following
sections for descriptions.

Viewing Waveforms

After you select a waveform for viewing from the genie status page (and after the
waveform has been sent to PowerLogic SCADA), the waveform displays, as shown
below.

The toolbar at the top of the screen includes these buttons:

Button Description

Not currently used.
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Button Description

Click to display all graphs (all three voltages and all three currents of the waveform
capture.

Click to display individual voltage phases (Va =A-N, Vb =B-N, Vc =C-N).

Click to display individual current phases (Ia = phase A, Ib = phase B, Ic = phase C, In =
neutral, Ig = calculated ground current).

Click to toggle between line-to-line and line-to-neutral voltage phases.

Click to view all three voltage or all three current phases within the same graph. Phase A,
B, and C voltages display together. Phase A defaults to black, B to blue, C to red. In the
sameway, phase A, B, and C currents display together (A is black, B is blue, and C is
red).

To change colours, right-click the graph title. Select Control Properties. Go to the Colours
tab andmake changes.

Click to view each phase, both voltage and current, within a single graph. You see phase
A voltage and current in one graph, phase B voltage and current in another, and phase C
voltage and current in a third.

Click to display the Import Waveform dialog. If you have SMS installed on the computer,
it defaults to the Comtrade folder. If not, it goes to the root of the C drive, for you to locate
the waveform you want to import. Double-click the waveform to view it.

Click to begin exporting a waveform. Select the type of file you will save (bitmap, text, or
metafile). Then select the location where you want to store the waveform you are
viewing.

Click to zoom in or out. When zoomed in, there is a scroll bar at the bottom of each graph,
used tomove to the left or right.

Click to view the display as a waveform plot.

Click to view the display as a spectral plot. This feature does not work for the "3" or "V/I"
views.

Click to view the display as an RMS plot.

Select any phase; then click here to view the digital status of any of the digital channel(s)
that have been set up for this circuit monitor.

Not currently used.

Entering Setpoints for Alarms

NOTE: Any time you change setpoints, you should immediately restart the project.
Otherwise, setpoints will not be properly read (they will be truncated and either
rounded down or up to a whole integer).

To add setpoints for alarms, follow these steps:

1. View the page, then click the genie for which you want to enter setpoints. A status
window displays with the name of the genie.

2. Click Setpoints, then choose Analog, Digital, or All. When the Alarm Setpoints
screen displays, select the first value you want to change. At the “keypad” screen
(see below), enter the new value. Click OK to save it. Do this for each setpoint that
you want to change.
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Based on these setpoints, alarms can begin to display both in the alarms window at the
top of the runtime screen and on the Alarms/Events tab (assuming you have set one up
for this installation).

When there is a comms loss for a device: the last state before the loss happened is
displayed on the screen.

The indication of loss of communications does not filter through the entire bus
animation: the downstream part of the drawing may still appear as if
communication is working. When any part of a one-line drawing loses
communication, do not continue to trust downstream readings until you address
the loss of communication.

Viewing Real-Time Trends

This option displays an historical trend. The data that displays is determined by the
value that was selected in the Value Type field when this genie was added to the one-
line page.

To view a trend: From the one-line page in the runtime environment, click a genie to
view its status window. Click Trend, in the lower right corner. The Analyst screen
displays for that trend.

You can select the timeframe for the trend. You can also uncheck phases to remove
them from the trend, or highlight a phase to bring it to the front of the trend. For detailed
information about the buttons on the screen, click “?” at the top of the page.

Viewing Lists of Real-Time Information for the Genie

To view lists of real-time currents, voltages; powers; resets and controls; and
miscellaneous readings, click List, in the lower right corner, then click an item from the
list: Currents, Voltages, Powers, Resets, or Others.

For resets and controls, which are interactive, you should assign users a high level of
security. For a list of the default user levels, see Adding and Modifying User Accounts
on page 160. That link also includes information on creating unique users.

When you click an item from the list, individual tag readings display for that tag type
(depending on the tags that you have chosen for this device type). When you click any
item in that list, the tag pop-up menu displays with these options: Trend, Override Tag,
Control Inhibit Tag, and Tag Status. See Overriding Tag Status, below, for details.

Overriding Tag Status

From the list, you can right-click individual tags and override status settings. To access
this feature, the user account must be at least level 4.

Trend: This link allows you to view a trend for the tag that you clicked.

Override Tag: You can use this feature to override a real-time value that is incorrect, or
to test graphics. Enter the value that you want the system to "read" for this tag in the
Override Value line. When you click Apply, the tag is highlighted. When you have
finished the test, return to this list to remove the override.
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Control Inhibit Tag: When this feature is ON, you will not be able to process writes for
this tag. To enable this inhibit, click Apply for this tag from the list. The tag reading is
highlighted. To disable this feature, return to the list view of this tag; click Remove.

You can perform control inhibit on an entire device. To do this, you will use the
IODeviceControl Cicode function. For more inforrmation, see the I/O Device Properties
topic in the Citect. chm help file (I/O Devices Properties).

Tag Status: This screen views the status of the display value, override status, control
inhibit status, and field value. You can also change the override status and control
inhibit status on this screen.

Changing background colours: Default colours are assigned for for the tag override
and control inhibit. Change the default background colours in the parameters, not in
the ini file.

To change the colour for tag overrides, use OverrideTextBackgroundColor. To change
the colour for control inhibits, use ControlInhibitTextBackgroundColor. For detailed
help, see Page Parameters in the Parameters.chm help.
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Multi-Monitor Support
PowerLogic SCADA provides the means for viewing the runtime environment from
multiple monitors. This setup allows you to view unrelated information at separate
monitors that are placed beside each other. In this example, there are four monitors,
configured left to right in a single row:

Main Monitor Monitor 2 Monitor 3 Monitor 4

(displays Windows Start button)

In the Citect.ini file for the project (Windows XP: Documents and Settings\All
Users\Application Data\Schneider Electric\PowerLogic SCADA
7.20\User\[projectname] or Vista: ProgramData\Schneider Electric\PowerLogic SCADA
7.20\User\[projectname]), add the following instructions:

Add the following instructions to the Citect.ini file (changes can be added directly to the
Citect.ini file or in the project database, via menu command: System > Parameters in
Project Editor):

[MultiMonitors]
Monitors = 4
StartupPage1 =
StartupPage2 =
StartupPage3 =
StartupPage4 =

where

Monitors = n; n = number of monitors used to display the pages in the project

PowerLogic SCADA displays the windows according to the formation of the monitors—
such as left-to-right, top-to-bottom or grid—set in the Windows operating system. By
default, this is set via the Windows Start menu > Control Panel > Display applet.

StartupPage1 = startup page that needs to be displayed on monitor 1

StartupPage2 = startup page that needs to be displayed on monitor 2

StartupPage3 = startup page that needs to be displayed on monitor 3

StartupPage4 = startup page that needs to be displayed on monitor 4
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Using the Graphics Test Mode
Graphics Test Mode is to be used for testing or demonstration during system setup,
prior to commissioning. Always disable Graphics Test Mode before you release the
product to the end user.

Graphics Test Mode can be enabled by setting the following parameter in the project
parameters:

Section Name: PowerLogicSCADA

Name: GraphicsTest

Value: Enable Graphics Test Mode

To disable, remove this parameter information.

Graphics Test Mode is designed to enable off-line testing of animation in single-line
drawings. This feature is useful for project development, prior to commissioning a
system. Do not use this mode with physical devices that are connected to a live
environment.

NOTE: This does not prevent control to a device. The default graphics. when in
Graphics Test Mode, will write only to status tags for open, close, and breaker reset. If
you edit these graphics, or create new ones, you can write to control tags even when
you are in the Graphics Test Mode.

There are generic devices available for Graphics Test Mode. These devices have this
naming convention:

Breaker_1 through Breaker_50

and

Meter_1 through Meter_5.
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Using the Demo Mode
You can run PowerLogic SCADA without the hardware key in demonstration (Demo)
mode. In demonstration mode, you can use all PowerLogic SCADA features normally,
but with restricted runtime and I/O.

If you configure PowerLogic SCADA to run as multiple processes on one CPU or
multiple CPUs, you cannot use PowerLogic SCADA in demo mode; but if you run
PowerLogic SCADA as one process, you can use a demo mode. The following
demonstration modes are available:
• 15 minutes with a maximum of 50,000 real I/O.
• 10 hours with no static points and a maximum of one dynamic real I/O. This is

useful for demonstrations using memory and disk I/O. PowerLogic SCADA starts in
this mode if no static points are configured.

If you want to demonstrate DDE, CTAPI, or ODBC writes to PowerLogic SCADA in
this mode, you can only write one point. To write to more than one point, you must
force PowerLogic SCADA to start in 15 minute-50,000 I/O demo mode by creating
at least one static I/O point.

For this to work, you must configure a real variable tag, with an accompanying PLC
or I/O device. The tag must be used by a page or in Cicode. If you do not have a
real I/O device connected, PowerLogic SCADA displays a hardware error, which
you can disable using the IODeviceControl function.

• 8 hours with a maximum of 42,000 real I/O. This is only available through special
PowerLogic SCADA Integration Partners (CIP) keys.
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Assigning and Controlling User Privileges
NOTE: You need to give users appropriate levels of access, depending on the work
they will do. For safety reasons, only advanced users should be given access to such
features as controls and resets.

This chapter discusses how to establish user security for the system. This section
includes the following topics:

Default User Access Settings (Privileges) on page 159

Adding and Modifying User Accounts on page 160

Changing Access Rights on page 162
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Default User Access Settings (Privileges)
User access rights (privileges) are defined in System > Roles form, in the Project
Editor. The following table describes the access rights. These privileges are included
in PLSSecurity.ci file (in the PLS_Include project). Any changes made to this file will be
overwritten when PLS_Include is updated (every new release). You need to document
every change you make, so that you can update PLSSecurity.ci when PLS_Include is
upgraded.

Access Right Roles / Global Privileges

Description Access Level Label
Access
Level
Value

Operator1 Operator2 Engineer Administrator Kernel

2 4 6 7 8

Circuit breaker, switch
control PL_Sec_CBControl 1 X X X X

IED configuration PL_Sec_IEDConfig 2 X X X

Circuit breaker tagging PL_Sec_Tagging 3 X X X

Alarms acknowledgment PL_Sec_AlmAck 4 X X X X X

Alarm deletion PL_Sec_AlmDelete 5 X X X

Alarm configuration PL_Sec_AlmConfig 6 X X X

Add/remove log-in users PL_Sec_UserConfig 7 X X

Reset alarms in device PL_Sec_AlmReset 8 X X

Shutdown runtime PL_Sec_Shutdown 9 X X X

View waveforms PL_Sec_ViewWaveform 10 X X X X X

NOTE: Privileges 1, 3, and 5 are currently unused. You can use them as you wish. See
Changing Access Rights on page 162 for instructions on changing access level
privileges.

A method of limiting access to the design time/configuration environment is to remove
the user rights to certain PowerLogic SCADA files. From the server, use Windows
security to remove user accounts from individual features. For example, access to the
following list of .exe files should be restricted to users who have design
time/configuration privileges.
• CtDraw32.exe - Graphics builder
• CtEdit32.exe - Project Editor
• CtExplor.exe - Project Explorer
• ProfileWizard.exe - Profile Wizard
• ColorSwap.exe - Color Swap Tool
• ProfileEditor.exe - Profile Editor

All of these files need to have the same level of security, as they are interrelated.

Additionally, to prevent users from accessing and changing the code responsible for
enforcing user security in the runtime environment, you need to lock down the user
rights for the Cicode files (.ci extension) in the PLS_Includes project.

NOTE: Another way to lock users out from changing an existing project is to implement
read-only projects.
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Adding and Modifying User Accounts
You must add at least one user to any project before you can run and view it. Each
user must have a role and a user account. Terms you need to understand are:
• privilege: the level of access that is applied to a system element; a user account

has individual privileges, which the user can then control
• role: contains a defined set of privileges, that are assigned to users

The Users screen controls all of the user access levels for each project. To assign
PowerLogic SCADA user access, follow these steps:

1. From the PowerLogic SCADA Explorer, choose the project for which you want to
assign user access.

2. From the Project Editor, click System > Roles.

3. For the first user, assign a user role, Windows group name (optional), and global
privileges. If you need additional information, click Help from that screen. For global
privileges, see the table in Default User Access Settings (Privileges) on page 159
for the level of each type of access right.

4. After you add the first role, click Add.

5. From the Project Editor, click System > Users.

6. Assign a user account. If you need additional information, click Help from that
screen.

7. After you add the first user, click Add.

8. To add additional users, do the following: with a user displayed, click Add (which
creates a copy of the user); type the new user information in place of the old
information; then click Replace to overwrite the information.

Note that the record count increases by one with each addition. To view the users
one at a time, scroll through the list.

Using Windows Integrated Users
Instead of using the above method to define users in the project, you can incorporate
PowerLogic SCADA users and security options with the standard Windows security
system. Using the integrated Windows security feature, the Windows user can log on to
PowerLogic SCADA runtime with runtime privileges and areas configured within the
project. For a Windows user to be able to log on to runtime, it must be linked to a
PowerLogic SCADA "role," which is defined in the project with associated privileges.

To assign Windows integrated user access,

To link a Windows user to a PowerLogic SCADA role, you should add the "role" that
specifies the Windows group of which the Windows user is a member.

The pre-existing AutoLogin capability is extended to include the client, when the user
is a Windows user, having an associated PowerLogic SCADA role. In order to invoke
this functionality for a Windows user, you need to set the [Client]AutoLoginMode
parameter in the Citect.ini file.

Instead of using auto-login when the system starts up, users can also log in to
PowerLogic SCADA using any Windows user credential that is a member of the linked
group.

When the name of a PowerLogic SCADA user also has the same name as a Windows
user, the PowerLogic SCADA user takes priority at runtime. However, if a valid
PowerLogic SCADA user login fails for some reason, the Windows user credentials will
not be checked and an alert will be generated to advise that the login was not effective.
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For more information, see Using PowerLogic SCADA with Windows Security in the
CitectSCADA.chm help file (Start > Programs > Schneider Electric > PowerLogic
SCADA 7.20 > PowerLogic SCADA Help).
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Changing Access Rights
You can edit the default access rights to each of the eight levels, thus changing the
privileges that are available at each level. This is done in the PLSSecurity.ci file (in the
PLS_Include project).

To change access rights:

1. Open PLSSecurity.ci.
2. Locate the AccessRights section.

3. For each right that you want to add (for example, to add access privileges for
working with switches), add a new CASE.

4. Save and close PLSSecurity.ci.

NOTE: PLSSecurity.ci is overwritten any time that the PLS_Include project is
overwritten. This happens with every release of PowerLogic SCADA, including service
packs. To ensure that you do not lose changes that you enter, you need to:
• Note the changes that you make. Keep a copy of these changes
• Re-merge the changes every time that the PLS_Include project is overwritten.
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Appendix 1: Default Genie Library
The genie library includes a number of general genies for objects such as motors and
pumps. There are also genies that are specific to PowerLogic. These genies use a
particular naming convention, which is described in the table below. In the PowerLogic
library, each genie name begins with “pls,” and is followed by a description of the type
of genie according to this table:

first second third fourth

pls

indicates PowerLogic library

alarm =alarm base =primitive genies 1 = small

ansi =ANSI style cb = circuit breaker 2 = large

display = equipment details sw = switchgear

gen =generic cmd = control genies

iec = IEC style eq = equipment (devices)

style = navigation

Additionally, the actual genies have abbreviated names. When you highlight a genie
name, the abbreviation displays above the top row of genie icons.

The following tables list and define the individual genies in each of the PowerLogic
libraries.

PLS_ALARM

This library includes genies that provide functionality to alarm displays.

Genie Abbreviation Description

Field data portion of an alarm row

Row a genie with a collection of fields

Selector for column resizing

Setpoint a setpoint row

PLS_ANSI_BASE_1 / PLS_ANSI_BASE_2

These libraries include a variety of base symbols used to created genies for ANSI
 equipment.
1 = small size
2 = large size

Genie Abbreviation Description

sl_battery_gen single-cell battery

sl_battery_multi multiple-cell battery

sl_capacitor capacitor

sl_capacitor_vari variable capacitor

SL_Closed_HV closed circuit breaker position

sl_closed_knife closed knife switch

sl_closed_lv closed low-voltage circuit breaker

sl_conductive_path_1 conductive path 1
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Genie Abbreviation Description

sl_conductive_path_2 conductive path 2

sl_conductive_path_3 conductive path 3

sl_conductor_junction conductor junction

sl_contact_nc_closed contact break, closed

sl_contact_nc_open contact break, open

sl_contact_no_closed contact make, closed

sl_contact_no_open contact make, open

sl_contact_term contact terminal

sl_ct current transformer

sl_in_cb_rack incoming, circuit breaker racked out, plug

SL_In_Rack incoming, circuit breaker racked out, socket

sl_in_sw_head incoming switch head

sl_inductor inductor

sl_inductor_adjust adjustable inductor

sl_inductor_gen general inductor

sl_inductor_magcore magnetic core inductor

sl_inductor_vari variable inductor

sl_open open symbol

sl_open_fuse_sw open isolating fuse-switch

SL_Open_HV open high-voltage circuit breaker

sl_open_knife open knife-type switch

SL_Open_LV open low-voltage circuit breaker

sl_out_cb_rack outgoing, circuit breaker racked out, plug

SL_Out_Rack outgoing, circuit breaker racked out, socket

sl_pb_break push-button, break

sl_pb_make push-button, make

sl_pb_term push-button, terminal

sl_pt potential transformer

sl_relay relay

sl_resistor resistor

sl_resistor_adjust adjustable resistor

sl_resistor_vari variable resistor

sl_separable_con_closed separable connector, closed

sl_separable_con_open separable connector, open

sl_separable_con_plug separable connector plug

sl_separable_con_socket separable connector socket

PLS_ANSI_CB_1 / PLS_ANSI_CB_2

These libraries include genies for ANSI-type high-voltage and low-voltage drawout
circuit breakers.
1 = small size
2 = large size
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Genie Abbreviation Description

hv_cb_bus_dr_c high-voltage drawout circuit breaker, remote control

hv_cb_bus_dr_nc high-voltage drawout circuit breaker, not remote

hv_cb_bus_nd_c high-voltage non-drawout circuit breaker, not remote

hv_cb_bus_nd_nc high-voltage non-drawout circuit breaker, not remote

hv_cb_fd_dr_c high-voltage, drawout circuit breaker, remote control, with earth at bottom

hv_cb_fd_dr_nc high-voltage, drawout circuit breaker, no remote control, with earth at bottom

hv_cb_fd_nd_c high-voltage, non-drawout circuit breaker, remote control, with earth at
bottom

hv_cb_fd_nd_nc high-voltage, non-drawout circuit breaker, no remote control, with earth at
bottom

hv_cb_inc_dr_c high-voltage, drawout circuit breaker, remote control, with earth at top

hv_cb_inc_dr_nc high-voltage, drawout circuit breaker, no remote control, with earth at top

hv_cb_inc_nd_c high-voltage, non-drawout circuit breaker, remote control, with earth at top

hv_cb_inc_nd_nc high-voltage, non-drawout circuit breaker, no remote control, with earth at top

hv_cb_nes_dr_c high-voltage drawout circuit breaker, remote control, no earth

hv_cb_nes_dr_nc high-voltage drawout circuit breaker, no remote control, no earth

hv_cb_nes_nd_c high-voltage non-drawout circuit breaker, remote control, no earth

hv_cb_nes_nd_nc high-voltage non-drawout circuit breaker, no remote control, no earth

lv_cb_bus_dr_c low-voltage drawout circuit breaker, remote control, busbar-type with earth at
bottom

lv_cb_bus_dr_nc low-voltage drawout circuit breaker, no remote control, busbar-type with earth
at bottom

lv_cb_bus_nd_c low-voltage non-drawout circuit breaker, remote control, busbar-type with
earth at bottom

lv_cb_bus_nd_nc low-voltage non-drawout circuit breaker, no remote control, busbar-type with
earth at bottom

lv_cb_fd_dr_c low-voltage drawout circuit breaker, remote control, earth on load side
(bottom of drawing)

lv_cb_fd_dr_nc low-voltage drawout circuit breaker, no remote control, earth on load side
(bottom of drawing)

lv_cb_fd_nd_c low-voltage non-drawout circuit breaker, remote control, earth on load side
(bottom of drawing)

lv_cb_fd_nd_nc low-voltage non-drawout circuit breaker, no remote control, earth on load side
(bottom of drawing)

lv_cb_inc_dr_c low-voltage drawout circuit breaker, remote control, earth on feeder (top of
drawing)

lv_cb_inc_dr_nc low-voltage drawout circuit breaker, no remote control, earth on feeder (top of
drawing)

lv_cb_inc_nd_c low-voltage non-drawout circuit breaker, remote control, earth on feeder (top
of drawing)

lv_cb_inc_nd_nc low-voltage non-drawout circuit breaker, no remote control, earth on feeder
(top of drawing)

lv_cb_nes_dr_c low voltage drawout circuit breaker, no earth, remote control

lv_cb_nes_dr_nc low voltage drawout circuit breaker, no earth, no remote control

lv_cb_nes_nd_c low voltage non-drawout circuit breaker, no earth, remote control

lb_cb_nes_nd_nc low voltage non-drawout circuit breaker, no earth, no remote control
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PLS_ANSI_SW_1 / PLS_ANSI_SW_2

These libraries include ANSI-style switches:
1 = small size
2 = large size

Genie Abbreviation Description

sw_fused switch: feeder, fused

sw_fused_isolated switch: feeder, fused, isolated

sw_general switch: feeder, general

sw_knife switch: knife type

PLS_DISPLAY

This library includes two genies that provide data row items for equipment.

Genie Abbreviation Description

equiplistitem data row for the equipment tag list

EquipValueItem data row for the equipment popup

PLS_GEN_BASE_1 / PLS_GEN_BASE_2

These libraries include a variety of "parts" related to generators, motors, and
transformers.

Genie Abbreviation Description

chassis_ground chassis ground

Dev_Base device base

es_inc earth switch, incomer

es_out earth switch, feeder

Gen_1 generator, option 1

Gen_2 generator, option 2

gen_AC generator: AC

gen_DC generator: DC

genset engine-generator

ground ground

Motor_1 motor, option 1

Motor_2 motor, option 2

motor_ac motor: AC

motor_dc motor: DC

motor_synch motor: synchronous

SL_Base circuit breaker base symbol

sl_br_in circuit breaker line in, non-drawout

sl_br_out circuit breaker line out, non-drawout

SL_Bustie bus tie

SL_CommLoss comms loss

SL_Discrepancy position discrepancy
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Genie Abbreviation Description

sl_harmonic_filter_1 harmonic filter 1

sl_harmonic_filter_2 harmonic filter 2

SL_In incoming bus

SL_Local local, rather than remote control

SL_Out feeder

SL_Tripped tripped

Test_CB_Control health test for the circuit breaker control

transformer_1_in transformer 1: general, on-line

transformer_1_in_y transformer 1: star (wye), on-line

transformer_1_out transformer 1: general, off-line

transformer_1_out_d transformer 1: delta, off-line

transformer_1_out_y transformer 1: star (wye), off-line

transformer_2_in transformer 2: general, on-line

transformer_2_in_Y transformer 2: star (wye), on-line

transformer_2_out transformer 2: general, off-line

transformer_2_out_D transformer 2: delta, off-line

transformer_2_out_Y transformer 2: star (wye), off-line (no 2 IN D? or 1 IN D?)

PLS_GEN_CMD_1 / PLS_GEN_CMD_2

These libraries include genies that control display of popups and values:
1 = small size
2 = large size

Genie Abbreviation Description

CmdDetail provides access to the equipment detail popup

cmddetail_meter provides access to themeter detail popup

Control control in a circuit breaker

value value section of a circuit breaker

value_meter value section of ameter

PLS_GEN_EQ_1 / PLS_GEN_EQ_2

These libraries include the general equipment used to make up generators, motors,
and transformers:
1 = small size
2 = large size

Genie Abbreviation Description

busbar_horz horizontal busbar

busbar_vert vertical busbar

gen_ac generator: AC

gen_dc generator: DC

gen_nd_1 generator 1: no current designation
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Genie Abbreviation Description

gen_nd_2 generator 2: no current designation

mot_ac motor: AC

mot_dc motor: DC

mot_nd_1 motor 1: no current designation

mot_nd_2 motor 2: no current designation

mot_syn motor, synchronous

trans_nd_1 transformer 1: no connection designation

trans_nd_2 transformer 2: no connection designation

trans_sd_1 transformer 1: star-delta (wye-delta)

trans_sd_2 transformer 2: star delta (wye-delta)

trans_ss_1 transformer 1: star-star (wye-wye)

trans_ss_2 transformer 2: star-star (wye-wye)

PLS_IEC_BASE_1 / PLS_IEC_BASE_2

These libraries include a variety of symbols for IEC equipment:
1 = small size
2 = large size

Genie Abbreviation Description

sl_cap_bank_tuned_3 capacitor bank 3: tuned

sl_cap_bank_tuned_4 capacitor bank 4: tuned

sl_capacitor capacitor

sl_capacitor_vari capacitor, variable

sl_closed closed switch

sl_contact_nc contact break

sl_ct contact

sl_fuse_1 fuse, option 1

sl_fuse_2 fuse, option 2

SL_Head head

sl_head_2 head

sl_in_cb_rack incoming, circuit breaker when racked out, plug

SL_In_Rack incoming, circuit breaker when racked out, socket

sl_in_sw_hd_isol incoming, switch head, isolated

sl_in_sw_head incoming, switch head

sl_inductor inductor

sl_inductor_adjust inductor, adjustable

SL_Open open

sl_out_cb_rack feeder, circuit breaker when racked out, plug

SL_Out_Rack feeder, circuit breaker when racked out, socket

sl_resistor resistor

sl_resistor_adjust resistor with adjustable contact

sl_resistor_vari resistor, variable
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Genie Abbreviation Description

sl_sw_static_1 static switch 1

sl_sw_static_2 static switch 2

PLS_IEC_CB_1 / PLS_IEC_CB_2

These libraries include high-voltage drawout circuit breakers:

1 = small size

2 = large size

Genie Abbreviation Description

hv_cb_bus_dr_c high-voltage drawout circuit breaker, remote control

hv_cb_bus_dr_nc high-voltage drawout circuit breaker, no remote control

hv_cb_bus_nd_c high-voltage non-drawout circuit breaker, remote control

hv_cb_bus_nd_nc high-voltage non-drawout circuit breaker, no remote control

hv_cb_fd_dr_c high-voltage, drawout circuit breaker, remote control, earth at bottom

hv_cb_fd_dr_nc high-voltage, drawout circuit breaker, no remote control, earth at bottom

hv_cb_fd_nd_c high-voltage, non-drawout circuit breaker, remote control, earth at bottom

hv_cb_fd_nd_nc high-voltage, non-drawout circuit breaker, no remote control, earth at bottom

hv_cb_inc_dr_c high-voltage, drawout circuit breaker, remote control, earth at top

hv_cb_inc_dr_nc high-voltage, drawout circuit breaker, no remote control, earth at top

hv_cb_inc_nd_c high-voltage, non-drawout circuit breaker, remote control, earth at top

hv_cb_inc_nd_nc high-voltage, non-drawout circuit breaker, no remote control, earth at top

hv_cb_nes_dr_c high-voltage drawout circuit breaker, remote control, no earth

hv_cb_nes_dr_nc high-voltage drawout circuit breaker, no remote control, no earth

hv_cb_nes_nd_c high-voltage non-drawout circuit breaker, remote control, no earth

hv_cb_nes_nd_nc high-voltage non-drawout circuit breaker, no remote control, no earth

PLS_IEC_SW_1 / PLS_IEC_SW_2

These libraries include IEC-style switches:

1 = small size

2 = large size

Genie Abbreviation Description

sw_general general switch

sw_isolated isolated switch

PLS_METER

This library includes meter symbols.

Genie Abbreviation Description

circuit monitor PowerLogic SCADA circuit monitor

egx PowerLogic SCADA EGX

generic_meter generic meter
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Genie Abbreviation Description

ion_7650 ION 7650meter

micrologic all Mircologic meters

power_meter PowerLogic SCADA power meter

quantum PowerLogic SCADAQuantum

sepam all Sepam metersI

ITEM1

This library includes miscellaneous symbols.

Genie Abbreviation Description

Item1 value type and units block for a circuit breaker

Item2 value type and units block for a circuit breaker

tab1 menu tab

Tab2 menu tab
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Appendix 2: Using Citect INI Parameters
There are a number of Citect INI parameters that you may use to configure driver
parameters. These settings may be configured at the protocol level, cluster level, port
level, or device level. More specific settings will override a general one. The order of
precedence is:

Protocol Name > Cluster Name > Port Name > I/O Device Name

The level at which you want the INI settings to be in effect determines the name you
define. For example:

To set the default timeout for all devices using the Micrologic protocol, use:
[MICROLOGIC]
Timeout = 2000

To override this default for cluster ‘Cluster_1,’ use:
[MICROLOGIC.Cluster_1]
Timeout = 1000

To override the default value for port ‘Port_1’ on cluster ‘Cluster_1,’ use:
[MICROLOGIC.Cluster_1.Port_1]
Timeout = 3000

To override the default value for I/O device ‘CircuitBreaker_1’ on port ‘Port_1’ on
cluster ‘Cluster_1,’ use:
[MICROLOGIC.Cluster_1.Port_1.CircuitBreaker_1]
Timeout = 4000

Most settings can be configured to be specific to a particular I/O device. Exceptions are
noted in the description for the individual parameter.

Parameters Database
All INI parameters described in the sections below can be set in the Parameters
database. Using special syntax, you can access the parameters in the Project Editor
(System < Parameters):
• The section name generally corresponds to the INI section name, although it

includes the protocol name, cluster name, and primary device name only.
• The name is the INI value name.

If the parameter is set in the Parameters database, it becomes a new default for either
protocol, cluster, or a concrete device (depending on the section name hierarchy).

Examples:

Section Name: [MICROLOGIC.Cluster_1.Breaker_1]
Name: Timeout
Value: 2000
This defines a new default timeout value for a redundant pair of MicroLogic devices
(primary device is named Breaker_1 in Cluster_1).

Section Name: [PWRMODBUS.Cluster1]
Name: UseWriteMultiRegistersOnly
Value: 0

This sets UseWriteMultiRegistersOnly to 0 for all PWRMODBUS devices in Cluster 1.
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The INI file is read after the parameter database is processed; thus the override options
are set in the Parameters database.

In this section, you will find parameters organized into these categories:

General PowerLogic Driver Parameters on page 173

Performance Tuning Parameters on page 180

Waveform Parameters on page 188

Sepam Event Reading Parameters on page 190

MicroLogic Modules Configuration Parameters on page 191

Data Replication Parameters on page 192
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General PowerLogic Driver Parameters

The following parameters are common to all PowerLogic SCADA devices.

watchtime
Controls how often PowerLogic SCADA will interrogate the driver to determine whether
it is still online. This parameter can only be configured for an entire driver, and hence
will have the driver dll name as its section name. Where another setting may be
[PM870], to set this setting it must be [PLOGIC], as PLOGIC is the name of the dll. This
is the only parameter whose section name is defined in this fashion.

Parameter type: seconds
Default Value: 2
Example: [SEPAM] watchtime = 5

kernelStatisticUpdateRate
Controls how frequently the statistics displayed in the driver kernel window are
updated. This time period can be increased in order to decrease CPU load. This
parameter can only be configured for the entire protocol (as with the watchtime
parameter); it will have the driver dll name as its section name.

Parameter type: milliseconds
Default value: 5000

Examples:
[SEPAM40]
kernelStatisticUpdateRate = 20000

[SEPAM80]
kernelStatisticUpdateRate = 10000

UseWriteMultiRegistersOnly
Controls PWRMODBUS driver behaviour when a single register is to be written. This
parameter is set to 1 by default, enabling all writes to be made using "write multiple
registers" MODBUS function. Setting this parameter to 0 allows driver to perform write
using "write single register" function if (and only if) one MODBUS register is about to be
written in current operation.

Parameter type: integer
Default value: 1

Examples:

[PWRMODBUS]
UseWriteMultiRegistersOnly = 1

[PWRMODBUS.MYCLUSTER.PORT_1.BCM1]
UseWriteMultiRegistersOnly = 0
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timeout
Controls how long the driver waits for a response from a device before setting that
device as offline. This value should be greater than the device/gateway timeout period.
A timed out request will not be retried. The reason for this is that TCP is a guaranteed
transport mechanism, and the lack of a response indicates device failure or
communications failure to that device. A device connected via a gateway should use
the gateway's retry mechanism.

Parameter type: milliseconds
Default value: 5000

Examples:

[SEPAM40]
Timeout = 2000

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
Timeout = 15000

retry
Defines the number of retry attempts for specific MODBUS requests. Retries may occur
either when the request is timed out or certain MODBUS exception reply messages are
received. The exact behaviour is controlled by the RetryTimeout and RetryException
parameters.

Parameter type: number of attempts
Default value: 3

Examples:

[SEPAM40]
retry = 1

[SEPAM40.MYCLUSTER.PORT_1.SEPAM_DEVICE]
retry = 5

RetryTimeout
When enabled (by default), the driver will re-try a timed-out MODBUS request.

Parameter type: long (boolean)
Default value: 1

Examples:

[SEPAM40]
RetryTimeout = 1

[SEPAM40.MYCLUSTER.PORT_2.SEPAM_DEVICE]
RetryTimeout = 0
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RetryException
When enabled (disabled by default), the driver will re-try a MODBUS request that has
received MODBUS Exception messages. The number of retries is defined by the Retry
parameter.

When Retry Exception is enabled, retry occurs when any of the following MODBUS
exception messages is received:

SLAVE_DEVICE_FAILURE_EXCEPTION = 0x5
GATEWAY_PATH_UNAVAILABLE_EXCEPTION = 0xA
GATEWAY_TARGET_DEVICE_FAILED_TO_RESPOND_EXCEPTION = 0xB
SLAVE_DEVICE_BUSY_EXCEPTION = 0x6
MEMORY_PARITY_ERROR_EXCEPTION = 0x8
NEGATIVE_ACKNOWLEDGE_EXCPETION = 0x7

Parameter type: long (boolean)
Default value: 0

Examples:

[SEPAM40]
RetryTimeout = 1

[SEPAM40.MYCLUSTER.PORT_2.SEPAM_DEVICE]
RetryTimeout = 0

standbyRefreshRate
Controls how often a standby IO server attempts to poll a device to update its cache.
This time period determines the maximum age that values may be when switching from
a primary IO server to a standby. Decreasing this value degrades communications to
the device.

Parameter type: seconds
Default value: 60

Examples:

[SEPAM40]
standbyRefreshRate = 30

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
standbyRefreshRate = 120

standbyCheckTime
Controls how often the driver will enquire of PowerLogic SCADA as to whether it is in
standby or primary mode. This value can be increased to reduce CPU load.

Parameter type: milliseconds
Default value: 500

Examples:

[SEPAM40]
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standbyCheckTime = 500

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
standbyCheckTime = 1000

statusUnitCheckTime
This parameter defines how frequently the driver will try to re-establish the connection
with a device that has gone offline on a port that is not disconnected. It sets the
maximum rate at which the driver enquires of the device, to determine if it is still
operational. If the "watchtime" parameter is set to a longer time, that value will be used
instead.

NOTE: If a network gateway has multiple devices connected to it, and one device is
disconnected, the driver takes it offline and does not try to reconnect it according to this
parameter's schedule. If the port is taken offline and then is reconnected, the driver will
reconnect the devices immediately.

Parameter type: seconds
Default value: 5 (20 for MicroLogic)

Example:

[SEPAM40]
statusUnitCheckTime = 5

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
standbyCheckTime = 10

initUnitCheckTime
Controls how long the driver waits before attempting to bring a device online after it
has gone offline. This value can be decreased to bring offline devices back into service
in a shorter period of time. In a multi-drop scenario, this time should be relatively long,
to prevent init unit requests from stalling communications to the rest of the devices on
that port.

Parameter type: seconds
Default value: 120

Examples:

[SEPAM40]
initUnitCheckTime = 5

[SEPAM40.MYCLUSTER.PORT_1]
initUnitCheckTime = 120

initCacheTimeout
Controls how long the driver will spend attempting to populate the cache before
bringing a device online. When a tag has been incorrectly configured, the device will
come online after this period of time.

Parameter type: seconds
Default value: 60
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Examples:
[SEPAM40]
initCacheTimeout = 60

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
initCacheTimeout = 30

cacheRefreshTime
Controls the maximum rate at which the driver will attempt to repopulate its cache. If the
driver cannot refresh its cache within the time period specified, it will collect data as fast
as the network allows.

Parameter type: milliseconds
Default value: 500

Examples:
[SEPAM40]
cacheRefreshTime = 1000

[SEPAM40.MYCLUSTER.PORT_1.FAST_SEPAM]
cacheRefreshTime = 200

[SEPAM40.MYCLUSTER.PORT_1.UNIMPORTANT_DEVICE]
cacheRefreshTime = 5000

StatusRegister
Defines a holding register that the driver reads to determine whether a device is
responding to communication requests. The result of this read is not important,
however it must be a valid register address within the device.

Parameter type: register address
Default value: 1100 or 2 (Sepam)

Examples:

[PWRMODBUS]
statusRegister = 1000

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
statusRegister = 16000

StatusRegisterType
Used together with StatusRegister; defines the type of the status register. Can only be
configured for the PWRMODBUS driver. This parameter can have one of the following
values:

0 - HOLDING register (default)
1 - INPUT register
2 - COIL register
3 - DIGITAL input (input coil) register

Any other value equals the default.
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Parameter type: register type
Default value: 0

Example:

[PWRMODBUS]

statusRegister = 1000

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]

statusRegister = 16000

statusRegisterType = 2

ModbusBase
Defines the base address for a device. Some MODBUS device registers are defined
using a base address of 1. in this case, reading register 100 would actually require
reading register 99. In other devices (such as the Sepam) the base address is 0. This
parameter allows the base address to be configured according to the device.

Parameter type: integer
Default value: 0 for Sepam; 1 for all other drivers

Examples:

[PWRMODBUS]
ModbusBase = 1

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
ModbusBase = 0

RegMode
Specifies the order of bytes in a device register. It can only bet set for PWRMODBUS
driver, and is supposed to be unit-specific. Value values are:

RegMode Order of bytes

Big endian (default) 0 1 0

Little endian 1 0 1

Any other value reverts to big endian.

Parameter type: integer
Default value: 0

Examples:

[PWRMODBUS]
RrMode = 0 # Default

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
RegMode = 1 # This device has little endian registers
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timeZone
Time zone names are taken directly from the Windows registry database (case-
insensitive), and will otherwise default to using the I/O server's local time zone. The
Windows time zone database is located in the Windows registry in:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Time
Zones\. The examples of time zone names are:
AUS Central Standard Time
China Standard Time
Pacific Standard Time (Mexico)

Use the general section [POWERLOGICCORE] to specify the time zone for all devices,
e.g.
[POWERLOGICCORE]
Timezone = Mountain Standard Time

This sets the default time zone for all devices (Sepam, PLogic, Micrologic,
PWRMODBUS). Otherwise the time zone can be specified for each device with
precedence taken as described in the start of this section.

Examples:

[PLOGIC870.Cluster1.Singapore_Port]
Timezone = Singapore Standard Time

[PLOGIC870.Aus_Cluster]
Timezone = Aus Central Standard Time

Not having a time zone specification means that the device is in the same time zone as
the machine where the I/O Server is running. No time conversion will be done.
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Performance Tuning Parameters
Several parameters are provided to allow tuning of the performance. These
parameters fall into three broad categories; bandwidth allocation, packet blocking
optimisation, and tag scan rates.

Bandwidth Allocation Parameters
Bandwidth can be allocated for the different types of data as desired. The parameters
to perform this are as follows:

[Parameter] [Default Value] [Parameter Type]

EventBandwidth 25 integer

WaveformsBandwidth 12 integer

CommandsBandwidth 13 integer

RealTimeBandwidth 50 integer

The percentage bandwidth allocated to each queue will be the ratio of an individual
queue's value when compared to the total sum of defined bandwidths. The default
values have a sum of 100 for ease of reference. Any unused bandwidth will be shared
amongst the other categories.

Bandwidth can be configured at the port level, but not the device level.

Example:
[SEPAM40]
EventsBandwidth 30
WaveformsBandwidth 5
CommandsBandwidth 15
RealTimeBandwidth 50

[SEPAM40.MYCLUSTER.PORT_1]
EventsBandwidth 50
WaveformsBandwidth 30
CommandsBandwidth 10
RealTimeBandwidth 10

BandwidthAllocation

This parameter allows the ratio of bandwidth assigned to each device sharing a port to
be configured. This parameter can only be configured at the device level.

Parameter type: integer
Default value: <equal split>

Example:
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
BandwidthAllocation 70

[SEPAM40.MYCLUSTER.PORT_1.DEVICE_B]
BandwidthAllocation 30
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Packet Blocking Optimisation Parameters
For all devices except the Sepam, parameters can be configured to optimise the
MODBUS packets that are created for collection of data from the device. Sepam
devices have pre-configured blocks that are already optimised.

The parameters that control the blocking are as follows:

enableScatteredReads

This causes the driver to use the ‘scattered read’ extension that can help improve
blocking. This option should be enabled for devices that support this extension.

Parameter type: Boolean flag
Default value: 0 for generic Power MODBUS driver, 1 for PowerLogic driver

Example:
[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
enableScatteredReads 1

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_B]
enableScatteredReads 0

percentBlockFill

This parameter defines the maximum percentage of configured registers contained in a
block before the drivers creates fixed blocks instead of scattered blocks. The following
figure illustrates now a block of N registers can be constructed:
• If M<N registers are configured, the block builder can either create a scattered

block or a multi-register block.
• If M/N*100% is less than PercentBlockFill, the block builder creates a scattered

registers block.
• If the percentage of configured registers ≥ PercentBlockFill, the block builder

creates a multi-register block.

Parameter type: percentage
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Default value: 50

Example:
[PM870.MYCLUSTER.PORT_1.PM_DEVICE]
percentBlockFill 50

[CM4000.MYCLUSTER.PORT_1.CM_DEVICE]
percentBlockFill 80

maxBlockSize

This parameter defines the maximum number of registers that can be read in a single
request. By default, this is 124, but some devices can read more than this.

Parameter type: integer
Default value: 124

Example:

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
maxBlockSize 1024

minBlockSize

This parameter defines the minimum number of registers to read as a fixed block
before the block builder will instead add those registers to a scattered block. If latency
is low, and scattered reads are expensive, this value should be lower. If latency is high,
or scattered reads are inexpensive, it is better to set this value higher. Only applicable
when scattered reads are enabled.

Parameter type: integer
Default value: 20

Example:
[PM870.MYCLUSTER.PORT_1.LOW_LATENCY_DEVICE]
minBlockSize 10

[CM4000.MYCLUSTER.PORT_1.HIGH_LATENCY_DEVICE]
minBlockSize 100

Tag Scan Rate Parameters

Each tag can be configured at a priority level from 1-3 where 1 is the highest.
Parameters exist to adjust the relative scan rates of the high and low priority tags in
comparison to the nominal tag scan rate.

HighScanRate

Parameter type: percent relative to nominal
Default value: 50

LowScanRate

Parameter type: percent relative to nominal
Default value: 200

Using the default parameters, the high priority tags will be refreshed twice as fast as
the normal priority tags, and the low priority tags will be refreshed at half the rate of the
normal priority tags. These parameters can be configured at the port level and higher.

Using the default settings and a nominal tag refresh rate of 1 second:

Low Priority Tag Refresh: 2000 ms
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Normal Priority Tag Refresh: 1000 ms
High Priority Tag Refresh: 500 ms

Example:
[PM870.MYCLUSTER.PORT_1]]
HighScanRate 25
LowScanRate 500T

Advanced Tag Block Capabilities (Invalid Memory Access Blocks defined)
Some devices may restrict access to certain memory registers. Such registers may be
available for read only, write only or may not be available at all, resulting in a MODBUS
exception when the registers are addressed.

Definition: Blocks of registers that cannot be read or written to are referred as “invalid
memory access blocks.”

These devices create a challenge for the PWRMODBUS driver. If the device has
invalid blocks that do not support scattered reads (or they are disabled for this device),
the driver may try to read registers in blocks that intersect with the registers that cannot
be read. This can result in the whole block being invalidated and, in certain cases, may
also result in device being taken offline. Figure 1 (below) illustrates an invalid block in
the middle of an address space.

Figure 1 shows how the "invalid memory access block" affects MODBUS register
blocking. In this situation, if the driver does not know that the block of 3 inaccessible
registers exists, it will try to block all registers from 1 to N (depending on data that was
requested by the real-time data collector). This block, however, will never be read
successfully, as the device will respond with an exception to all attempts to read invalid
registers.

If the configuration includes information about invalid memory access blocks, the driver
will create two blocks instead of one, as shown in Figure 2:
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In Figure 2, invalid registers were taken into account when the block was constructed.
When configuring device that has invalid memory areas, it is especially important to
define all blocks that may interfere with any of the tags.

Invalid Block Tag Definition Syntax

Invalid access memory areas are defined as variable tags, using the following format
for the address:

T:IB;{m|i|c|s}:<start_register>:u<count>;E:1;L:P:0

where

• m, i, c and s define the type of MODBUS register

• <start_register> is the first register address of the invalid access block

• <count> defines the number of registers in the invalid access block

Example:

T:IB;m:300:u10;E:1;L:P:0

This defines an invalid access block of ten holding registers starting from register 300.

Configuration Notes

When one or more invalid access blocks is defined according to the syntax above, tags
configured to read any of invalid registers will be affected by it. If any of the tag
registers fall into an invalid memory access block, this tag will not be readable; any
attempt to read its value will result in #COM, as shown on Figure 3:
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However, such tags do not affect other tags, because the PWRMODBUS driver
implements algorithms that prevent tags from being invalidated by invalid memory
block logic.

Tags that try to use invalid registers are detected on startup and can be found by
analysing the log file. This is an example trace:

[DEBUG]

[REAL][GeneralDriver::BaseDatapointBuilder::BuildDataPoints()]

Adding datapoint. Tag - BCM1\H_QIVR34\SwlStr Address -

T:SS;m:283:2;E:1;L:P:26 Datapoint: class Datapoints::Status_SS

[DEBUG] [REAL][RealTimeData::DeviceCache::Subscribe()] Init

Registers: Polled Registers: Address:283 Type:3

[ERROR] [MISC] [RealTimeData::BlockBuilder::AddDataPoint()] Cannot

add datapoint, one or more invalid memory addresses fall into non-

splittable block

[ERROR] [MISC]

[GeneralDriver::BaseDatapointBuilder::BuildDataPoints()] Could not

init datapoint. Tag BCM1\H_QIVR34\SwlStr Address

T:SS;m:283:2;E:1;L:P:26. Analyze other messages, this tag address

may contain invalid registers

Such output is expected when a holding register with address 283 is declared invalid.
This trace helps figure out any configuration issues.

Write-only Memory

If a certain register range is accessible for write only, no additional configuration may
be needed. However, to prevent the driver block optimizer from including these
registers in a poll, they also must be configured by adding “invalid block” tags as
described in the Invalid Block Tag Definition Syntax, described above. Declaring these
registers invalid will not prevent drivers from trying to write to them. Figure 4 illustrates
a write-only memory configuration:
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Write-only registers should not be confused with write-only datapoints that internally
read a register before attempting to write. Declaring the register they read invalid will
result in a datapoint not working; such mistake should be avoided. Figure 4 shows
“WriteOnlyDP” as an example; this tag cannot be read (it will result in #COM), but
internally it needs to get the register value before writing into it. If this register was
declared invalid, tag writes would also fail.

Figure 5 illustrates a write-only datapoint:

Tag Blocking Notes

PowerLogic SCADA drivers support an advanced blocking mechanism for tags. That
is, real-time tags are no longer blocked together with write-only tags.

Tags found invalid, due to intersection with invalid memory areas, are not blocked with
“good” real-time tags and will not therefore interfere with them.

Write-only Tags

Beginning with driver version 2.0.1.1, the write-only tags feature is fully supported.

186 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 Appendix 2: Using Citect INI Parameters
06/2011



Appendix 2: Using Citect INI Parameters 63220-100-200E1
06/2011

There are no special logic codes or address formats for write-only tags. If a tag
references memory that was declared invalid (see Invalid block tag definition syntax,
above), and its datapoint has writing capabilities, the tag becomes write only. No
preliminary checks are performed to verify that the memory can be written to, and no
additional configuration is needed. It is assumed that, if the tag is configured to write
into memory that has been declared “invalid,” the memory can actually be written to.

It is important to understand that scaled write tags (code 110) will become write-only
tags, if that scale register can be read. Tag Device\TagN on Figure 6 explains this
case: the datapoint needs to read the scale value from the scale register in order to
write scaled value to write-only register. However, as long as the actual register
belongs to the memory that can only be written to (and it is configured using T:IB tag
syntax as explained in Invalid Block Tag Definition Syntax above), this tag cannot be
read.

The fact that the tag mentioned before cannot be read will not affect other tags reads
(see Tag Blocking Notes, above).

Note: The write-through feature of the device cache is disabled for write-only tags.
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Waveform Parameters
The following parameters configure the waveform downloading behaviour. These
parameters are only applicable for Sepam devices and PowerLogic devices that
support waveforms.

[Parameter] [Default Value] [Parameter Type]

WaveformsDisable 0 Boolean value

WaveformMatchMargin 10 seconds

WaveformCheckTime 30 seconds (PM/CM)

WaveformZone 1 integer (Sepam)

WaveformsDisable
This parameter enables or disables waveform downloading for a particular device.

Parameter type: Boolean value
Default value: 0

Example:
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
WaveformsDisable 1 //Disable waveform downloading

NOTE: This INI setting is a global setting that sets the default at startup. You can set this
for any set of devices (clusters, individual devices, etc.)

There is also a tag that will change an individual device's setting at runtime (it will reset
to the default when you restart the project). This tag is
LLNO\WaveformCollectionEnabled. 1 = True, 0 = False.

WaveformMatchMargin
Alarms are matched to waveforms by the timestamp of each. This parameter is the
maximum difference between alarm timestamp and waveform timestamp for
PowerLogic SCADA to consider it a match.

Parameter type: seconds
Default value: 10

Example:
[SEPAM40]
WaveformMatchMargin 2

WaveformCheckTime (PM, CM, and Sepam)
This parameter defines the time the driver will wait between checking for new
waveforms.

Parameter type: seconds
Default value: 30

Example:
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
WaveformCheckTime 60 (checks every 60 seconds)
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WaveformZone (Sepam)
This parameter defines the Sepam waveform zone that the Sepam driver will use to
collect waveforms from the device. This allows two masters to extract waveforms from
the same device. Valid values are 1 or 2.

Parameter type: integer
Default value: 1

Example:
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
WaveformZone 2
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Sepam Event Reading Parameters
These two Sepam parameters are described below.

EventTable
This parameter defines the Sepam event table that the Sepam driver uses to collect
alarms from a device. This allows two masters to extract alarms from the same device.
Valid values are 1 or 2.

Parameter type: integer
Default value: 1

Example:
[SEPAM40.MYCLUSTER.PORTO_1.DEVICE_A]
EventTable 2

EventIdle
This parameter defines the time that the driver will wait before requesting the next
event from a Sepam device. It may be possible to reduce this value to increase the rate
at which alarms can be retrieved from the device.

Parameter type: milliseconds
Default value: 500

Example:
[SEPAM40.MYCLUSTER.PORTO_1.DEVICE_A]
EventIdle 200
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MicroLogic Modules Configuration Parameters
A MicroLogic unit consists of three or four modules, each acting as a separate
MODBUS device; however the I/O server views MicroLogic as one I/O device. The
communication control module (CCM) is optional for MicroLogic; its presence may be
detected by the driver or specified in the INI file.

CCM
The CCM parameter specifies whether a CCM is present on the device or if the driver
should try to detect its presence ("auto mode"). Valid values are:

CCM not present - 0
CCM present - 1
Auto mode - 2 (default)

Any other value reverts to auto mode.

Parameter type: integer
Default value: 2

Example:
[Micrologic.MYCLUSTER.PORT_1.DEVICE_A]
CCM=1

Module-Specific Packet Blocking Optimisation Settings
Due to different firmware versions, MicroLogic modules may require different blocking
settings. This is especially true when MicroLogic contains a BCM that supports
MODBUS "read multiple registers" requests for up to 124 registers, and an MM or a PM
 module that supports 21 register reads at max. The MicroLogic driver allows blocking
optimisation parameters to be overridden for each of the device's modules, as in the
following example:
[Micrologic.MYCLUSTER.PORT_1.DEVICE_A]
maxBlockSize = 124

[Micrologic.MYCLUSTER.PORT_1.DEVICE_A.BCM]
maxBlockSize = 21

The parameter set for the device applies to all of its modules unless overridden in a
module-specific section (e.g., [Micrologic.MYCLUSTER.PORT_1.DEVICE_A.BCM])

These parameters can be overridden:
• enableScatteredReads
• minBlockSize
• maxBlockSize
• PercentBlockFill

This applies to the BCM, CCM, MM, and PM modules.
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Data Replication Parameters
These parameters are used to configure the data directory paths of your servers. These
settings are server wide, and must be added to the ‘WaveformDB’ area of the ini file.

Database root folder path
Waveform databases for all units will locate on the filesystem under the same common
folder. The path to the root folder will be specified in the citect.ini file:

[WaveformDB]
LocalRoot = c:\path\to\the\database\root

This path must be specified as local path.

By default, PowerLogic SCADA [DATA]: directory is be used as database root folder.

Database root UNC path
For waveform files to be accessible by the remote clients, the database root folder must
be available as network shared folder. The UNC name of this folder must be specified
in the INI file

[WaveformDB]
UNCPath = \\computerName\shareToTheLocalRootAbove

If the UNC path to the database root is not specified, all waveform file names returned
by the library will be local file names for the I/O server, making viewing the waveforms
on the remote clients impossible.

Replication destination configuration
In redundant scenario, the replication target folder must be specified for replication to
work

[WaveformDB]
ReplicationDestinationRoot=\\OtherMachine\share\path

The destination path is the name of the network share on the redundant machine
where its waveform database root is located. It must also allow write access.

No default value for it is assumed.

If not set or share is not accessible, no replication will be preformed.
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Graphics Library Parameters

Maximum number of entries that can be held in Event Log
The Alarm Summary length parameter in Citect.ini defines the maximum number of
entries that can be held in the Event Log (default = 5000 entries). You can view all
events in the Event Log and alarms in the alarm logs (Alarm Log, Unacknowledged
Alarms, Disabled Alarms).

Each event requires 256 bytes of memory, plus the length of the comment. 32,000
entries will require at least 8 MB of memory. If you have many events, you should
ensure that there is enough memory to store them in RAM.

After the parameter number is reached, older events are FIFO’d out to storage in
[Installed Project Directory]\Schneider Electric\PowerLogic SCADA 7.20\Logs

Parameters for Alarm and Event States
[Alarm]
UseConfigLimits = 1
CacheLength = 2500

!Sound1 = <wave file name>
!Sound1Interval = <repeating interval in milliseconds>
!Sound2 = <wave file name>
!Sound2Interval = <repeating interval in milliseconds>
!Sound3 = <wave file name>
!Sound3Interval = <repeating interval in milliseconds>

[AlarmFormat]
EventLog=OnDate | Date, OnTimeMS | Time, Custom1 | Equipment, Name |
Description,
SumState | State | Custom2 | Location, UserName | User

[AlarmStateText]
ON=<default text for ACTIVE state>
OFF=<default text for INACTIVE state>
ACK=<default text for ACKNOWLEDGED state>
ENA=<default text for ENABLE state>
DIS=<default text for DISABLE state>
CLE=<default text for CLEAR state>

These parameters are read only when the system starts up. The user must restart
PowerLogic SCADA if they change these parameters.

If you do not specify any value for these parameters, these default values will be used,
in this order: .

Appearance

Disappearance

Acknowledge

Enable

Disable

Clear

[PLSEventLog]
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FileFormat=0
EntryCount=250
ScanRate=10

[Path]
[PLSEventLog]=c:\SharedData\Alarm

[General] IODevCheckStartupDelay
Delay time before the I/O server starts checking for I/O device status at start-up. The
delay allows time for the I/O devices to come online. Otherwise, the I/O server would
have triggered communication failure alarms for the relevant equipment.
Allowed Values: ≥ 0
Default Value: 0

[General] IODevCheckInterval

The time interval in seconds that the I/O server repeats the I/O device status check.
Allowed Values: ≥ 2
Default Value: 2
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Appendix 3: Additional INI Parameters
The following parameters are added to support device types as they are added to the
system.

Quantum PLC Time-Stamped Events

The PWRMODBUS driver supports Quantum time-stamped events. You must set the
following INI parameter to enable time-stamped alarms downloading:

[PWRMODBUS]

TSEventsEnabled = 1
0 by default, valid values 1 or 0

TSMailboxAddress = 1104
1104 by default

TSAddrLost = 705
705 by default
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Appendix 4: Glossary

address

The address contains all the information the SCADA system needs to get values from a
known device, and to return a value determined by the values read from the device
and the calculation rules defined in the address.

alarm categorization

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms in the Alarm Log. Categories are: normal, over, over hs,
rate of change, reversal, sag, swell, transient, under, and under hs.

alarm text (On/Off)

For onboard alarms, this is the text (added while adding a custom tag) that displays
when the alarm is on or off. This text will display in the Alarm Log.

alarm filters

Setup in the Profile Editor, these filters help you filter and sort data that displays in the
Alarm Log.

alarm groups

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms. Groups are: frequencies, motors, power factors, powers,
temperatures, time, and voltages.

alarm levels

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms. Levels are: event, high, medium, and low.

alarm types

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms. Types are: diagnostic, power quality, protection, and
system.

Automation Interface

Used instead of the Profile Wizard, this tool allows you to add multiple devices at a time
to a PowerLogic SCADA project.

bandwidth

The amount of space or processor resource being used by a part of the system. You
can use the bandwidth allocation parameters to allocate bandwidth for different types
of data.

baud rate

The speed of transmission of electrical signals on a line. This is often described in bits
per second (bps), although the baud rate and bps are not truly interchangeable. The
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baud is actually the measurement of how frequently the sound changes on the line.

bitmask

A mask is defined as data that is used with an operation to extract information that is
stored in another location of the code. A bitmask is the most common mask used. It
extracts the status of certain bits in a binary string or number (a bit field or bit array).

Cicode

This programming language, which is similar to Visual Basic or "C," allows you to
access and edit real-time data in the PowerLogic SCADA project. Although not difficult
to use, the person working in Cicode must have received Cicode training from
 PowerLogic SCADA.

cluster

A discrete group of alarms servers, trends servers, reports servers, and I/O servers. It
would usually also possess local control clients. For a plant comprising several
individual sections or systems, multiple clusters can be used, one cluster for each
section.

Color Change Tool

(also Project Color Change Tool) This tool allows you to assign colours for busbars
and circuit breakers in genies, for use in graphics pages. You can assign separate
colours for up to seven different states (for example, error, intermediate). When the
busbar or circuit breaker is in the specified state, the system will change its colour to
match what is set up here.

CommsMethod (communications method)

This is the communication protocol, such as MODBUS/RTU via Gateway, that is being
used by a device. When adding devices in the automation interface, you will need to
specify the CommsMethod.

ComPort

(also COM port) The computer's communications port used to connect to devices, for
sending and receiving serial data.

composite device type

A composite profile can be made from more than one device type. Each device type
included in the composite profile can use its own protocol for communication. The
composite device type allows the engineer to use two devices for one monitoring point,
e.g., a breaker and a monitoring device. PLSCADA combines the functionality of the
two devices so that the end user only needs to consider one device when analysing
that location in their system.

configuration environment

(See design time environment.)

control

This is a command written to a device register that then causes an action within some
equipment. There are a series of default control tags in PowerLogic SCADA to achieve
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these actions. For example, in the Sepam 40, there are control tags to operate a circuit
breaker and enable a recloser.

custom device type

This is a "new" device type that is added to a system. Although the Profile Editor
includes many standard device types, it may be necessary to add a new device type
that includes custom tags, or one that includes a different set of tags than the standard
device types.

custom tag

This is a "new" tag that is added to the system. Although the Profile Editor includes
many standard tags, you may need to add a tag for a third party device, or to edit an
existing tag to change its attributes. In these cases, you need to add a custom tag.
These tags are then added to a customized device type to be made available in
profiles and projects. The custom tag creation interface applies rules to the tag creation
to help guide the user to making tags that will correctly retrieve the desired information
from devices.

DataBits

This is the number of data bits used in data transmission. The I/O device and the
ComPort must have the same value.

data type

Data types are restricted to these types that are supported by the SCADA system: dig-
ital, int, long, real, and string.

demo mode

This demonstration mode allows you to run PowerLogic SCADA without a hardware
key. You can use all of the PowerLogic SCADA features, but with limited runtime and
I/O options. See Using the Demo Mode on page 157 for details.

design time environment

To be used only by the person who is creating and installing the project for the end
user, this is the environment in which you add devices, profiles, and projects, as well
as create genies and one-lines.

device category

Used in the Profile Wizard to logically group device profiles, to make them easier to
locate. The default category is "Schneider Electric, and the default subcategories are
"Monitoring Device," "PLC," and "Protective Device." Do not confuse these terms with:
• categorization and subcategorization (alarm filters, used during runtime, to filter

and sort alarm data)
• category type: real-time filters that provide metadata for future reporting

device profile

A subset of the device type: where the device type includes all of a device type's
attributes, the device profile includes only the specific tags that are used by an
individual customer. A device profile is set up like a device type, except that it is
specially configured for a particular need. For example, a CM4000 that is being used to
monitor the main at a given facility would have a different profile from the CM4000 that
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is used to monitor water and gas at a facility. The profile also allows you to designate
that some tags will be used for trending and/or for PC based alarming.

device type

A device type contains all the information for retrieving the available information from a
given device type. This information is stored in the form of tags. Tags can be of these
types: real-time, onboard alarms, controls, and Resets. Real Time tags can be further
separated into groups such as Currents or Energies.

A device type has a name and has one or more drivers associated with it. It also has
one or more tags associated with it; for each driver/tag combination, the device type
can have an address.

device type drivers

These are programs that allow PowerLogic SCADA to interact with a device or series
of devices. PowerLogic SCADA includes several generic drivers (generic MODBUS,
Sepam 40 Range, MicroLogic 5P and 6P, CM4000 series, and PM800 series) that
interact with "standard" device types.

engineering unit templates

Used for conversions between base units and their conversions (for example, inches to
centimeters or amperes to kiloamps).

enumeration (used for the circuit breaker status)

This is a single value (0-5) that defines a condition that is determined by multiple bits.
They allow for dynamic contingencies, such as when you need to use multiple bits to
describe the position of a circuit breaker.

format code

These codes define the attributes of the address field of a tag. See Format Code
Definitions on page 80 for a list of format codes.

functional addressing

Creates addressing for a device that has data residing in different registers. Functional
addressing dynamically addresses the device, based on its configuration (using C#,
you can write code to account for user-defined variables). When you add the profile to
a project, you will enable functional addressing. Then, when exporting to the Profile
Wizard, you are prompted for the variable(s) related to these device types.

genie

A genie is a multi-layer graphic that is used on the Graphics page to indicate an object,
such as a motor, generator, circuit breaker, or switch. Using genies, you only have to
configure common behaviours of that object once. The default genie library includes a
large number of pre-defined genies. A graphics page can contain any number of
genies.

graphics test mode

Only available in the pls_example project, use this mode for off-line testing of
animation in one-line drawings. Do not use this mode with physical devices that are
connected to a live environment.
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ICD file

IED capability description: This is the file that is imported iinto the Profile Editor from an
IEC 61850 device. Editing for ICD files is limited to the ability to add/delete datasets
and control blocks, and the ability to edit buffered and unbuffered control blocks that
were created in the Profile Editor.

IEC tag name

The IEC 61850-compatible name that is created when a tag is created. This is the
name that is used by the SCADA system. The tag names provided use an abbreviated
form of the IEC 61850 naming convention. A tag name cannot include any special
characters except ( _ \ ). It can be a maximum of 32 characters.

IED

Intelligent electronic device

IID

Instantiated IED description: defines the configuration of one IED for a project; is used
as the data exchange format. This file contains data for just the IED that is being
configured.

logic code

Logic codes tell the PowerLogic SCADA program how to mathematically certain values
in device registers, thus providing values that the user needs. Examples of logic codes
are date and time for a circuit monitor or a Sepam device, digital inputs/outputs, and
IEEE power factor.

metadata

Metadata provides data about other data. In PowerLogic SCADA, metadata might
include additional information about a custom tag: its category type, utility type,
statistical type, or quantity. It is often used for reporting purposes.

multi-monitor support

This option allows you to view the runtime environment from multiple computer
monitors. In PowerLogic SCADA, this allows you to view a different startup page on
each monitor.

onboard alarm

Onboard alarms are alarms that are detected and stored in a device's data logs. If an
onboard alarm is configured within a device, you can map it, via the Profile Editor, to a
digital time-stamped alarm in PowerLogic SCADA. These alarms and associated
waveforms can be read and displayed in the PowerLogic SCADA Alarm Log.

parity

Parity is used as a simple means of detecting error by verifying that the result is odd or
even. In PowerLogic SCADA, parity is required for the generic serial or MODBUS/RTU
comms methods, when adding a device to PowerLogic SCADA.
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PC-based alarms

PC-based alarms are alarms that are detected from a device and are stored in the
software. You can add them to the Profile Editor when you create the device profile. All
PC-based alarms are analog by default.

PMCU

The Meter Configuration Help Utility. Use this application to set up the features within
PowerLogic devices, and enabling such features as onboard alarms and waveforms.
The information that is generated from PMCU is then available for use within
PowerLogic SCADA.

point (see SCADA tag)

polling priority

When adding a custom tag, this field determines the level of priority that PowerLogic
SCADA uses when reading data from the related device. Options are low, normal, or
high.

PowerLogic SCADA tag name library

This library includes electrical parameters, or measurements or topics. A tag name has
three parts:
• an easy to read name (such as Current Phase A)
• a unique identifier
• meta data (attributes used to categorize the data for intelligent display/analysis)

Profile Editor

This tool allows you to create device type tags, device types, and device profiles. This
information is then imported into PowerLogic SCADA, for use in creating graphics
pages.

Profile Wizard

This tool allows you add device profiles to, or delete them from, a PowerLogic SCADA
project. From the Profile Editor, you export profile data into a file that can be used in
PowerLogic SCADA. From there, you use the Profile Wizard to add the device profile
into a PowerLogic SCADA project.

project

A project is made up of any number of profiles. Profiles that have been added to a
project can be imported into the SCADA system and made available for setting up
actual devices in the SCADA system.

A project name must match exactly between the Profile Editor and Citect SCADA.

Each project includes: a unit template, display name, and one or more instantiated
device profiles (instantiated by choosing a device profile and specifying a name). The
following is a simple example of how device profiles and projects inherit information
from the device type.
• The device type myCM4Type can use either the Modbus driver or the IEC 61850

driver.
• The device profile myCM4Profile inherits this device type.
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• The projectmyCM4Project instantiates the myCM4Profile and calls it
myModbgusCM4, and it specifies that it uses the Modbus driver.

• When this project is imported into the SCADA system, Modbus addressing will be
used.

Project Color Change Tool

This tool, accessed from Citect Explorer, allows you to set unique colours for seven
different states in busbars and circuit breakers.

register scaling

This is a conversion that is the result of applying a scaling multiplier to a register value.

resets

This feature allows you to reset data from a device. There are some pre-defined resets,
such as device date/time and onboard data logs, You can also add custom resets.

reserved names

The following terms are reserved for use in the Include project. If you use them in
projects that you create, they can cause compilation errors:
• IO_Server
• Report_Server
• Alarm_Server
• Trend_Server
• Client

runtime environment

This is where the end user views system information. This environment includes the
one-line diagrams with interactive objects, alarm and event pages, and analysis pages
(from which users can view trends and waveforms).

SCADA tag (SCADA point)

A SCADA tag is an extension of the tag name. A SCADA tag is made up of five parts:
two in addition to those already defined in the PowerScada tag library:
• an easy to read name (such as Current Phase A)
• a unique identifier
• an address (where on a device to read the raw data from)
• a formatting scheme (what to do with the data after it is read to scale it)
• meta data (attributes used to categorize the data for intelligent display/analysis).

SCL

Substation Configuration Language, the configuration description language for
communication in electrical substations related to IEDs (defined by IEC 61850-6). This
language is used when importing/exporting ICD files. SCL files are used in such
devices as G3200 gateways.

StopBits

The number of bits that signals the end of a character in asynchronous transmission.
The number is usually 1 or 2. Stop bits are required in asynchronous transmissions
because the irregular time gaps between transmitted characters make it impossible for
the server or I/O device to determine when the next character should arrive.
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super-genie

Dynamic pages (usually pop-ups) to which the system can pass information when the
runtime page displays. You can use super-genies for pop-up type controllers (for a
very specific task that may not be always needed).

tag

Any quantity or measurement (topic) that is recorded by the device; for example,
current A. All tag names will use the IEC61850 naming convention. The user can
create custom tags; the naming convention will be in the following format:

<EquipmentName>\<PointName>

Where <EquipmentName> uses '_' (underscore character as a separator)

Where <PointName> uses '\' (backslash as a separator)

For example: SST_MV_BUSA_INC1\XCBR1\Pos

A tag contains a tag description, units, tag name, data type, and address.

Tags include the following (* indicates required information):

tag name*
display name*
group*
data type*
engineering units
Citect formatting
polling priority
alarm "on" text
alarm "off" text
category type
utility type
statistical type
quantity
alarming categorization
alarm type
alarm group
alarm subcategorization
alarm level

The tag's group determines the tag's class:

If the tag's group is onboard alarm, control, or reset, the tag's class is the same.

If the tag's group is anything else, the tag's class is real time.

tag address

This "address" includes everything you need to know about a tag (quantity/topic).
Included are the data type, priority, and logic code; and how the tag is displayed in
registers. You can change address attributes on the Edit Address screen. The full tag
address displays on the Define Device Type Tags tab when "Advanced Properties" is
selected.

© 2011 Schneider Electric All Rights Reserved 203



tag description

The tag description is a human readable name which can include spaces and special
characters (except for \ / : * ? < > | ). The description can be a maximum of 32
characters long.

tag group

The basic groups include: real-time, of which there are several sub-groups (for
example, currents, energies, frequencies and power factors); onboard; control; and
reset.

units

Units are the standard measurement associated with the quantity measured by a tag.
Units come in two types: base units and conversion units.

Some information is common to all all units, and some applies only to conversion units:

Common Information: base unit name, base unit abbreviation

Conversion Unit Information: conversion unit name, conversion unit abbreviation,
offset, multiplier

units template

The units template defines the conversion factor that must be applied to the standard
units provided in order to give the user their information in their desired units. The units
profile applies to an entire project. For example, iIf the standard unit for a device is MW,
but the user wants their project to display KW, they must define this units conversion in
the units template and then apply it to an entire project.

user privileges (user access, user rights)

This feature allows you to control the amount of access that each user has to the
system. User privileges are password-protected. SeeDefault User Access Settings
(Privileges) on page 159 for more information.

vector math

Vector math and vector math IEEE are two logic codes. They are the result of math that
use vectors, which are directed quantities.

voltage levels

Voltage levels are used in the Color Change Tool. There are four levels (0–3). The
measurement of each of these levels corresponds to a level used by the standard that
applies for each customer.
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Appendix 5: Frequently Asked Questions (FAQs)
The following items provide information about topics that generate frequent questions.

How do multiple engineers create device types and profiles at the same time?
It is highly recommend that one PC be nominated as the Master Profile Editor machine.
Until the import/export has been incorporated into the Profile Editor, customisation
must be completed at one PC. Then you can transfer the data to other machines. Not
every change needs to be made on this machine – only changes that will impact your
ability to share device types and profiles.

You must ensure that you have maintained synchronization between all the computers
for:
• units and unit templates
• categories and sub-categories
• custom tag names

Recommendations on how to do this include the following:

1. Nominate one machine as the master.
2. Have a method in place to create the customisation on the master machine.

3. Nominate one person to make the changes, or allow multiple people to access the
master machine and make their own changes.

a. Ensure that everyone who needs access to the machine has access. It would be
ideal to have something similar to Remote Desktop available to your team.
Whatever method you use, ensure that only one person can be logged in at a
time.

b. Users must log in to the master machine, make their changes/custom entries,
and then synchronize their local machine.

4. Have a daily backup in place for the master machine. Save several weeks of
backups before overwriting them.

If I don't use PowerLogic drivers, how do I create device profiles?
The easiest way to do this is to:

1. Create a device type using a non-PowerLogic driver (like MODNET).
2. Using that device type, create a device profile.

3. You need to change the addressing of the new device type. The easiest way to do
this is to copy the addressing from a known device type, and then make the
necessary changes for the new device type.

Can I install ION E or SMS on the same computer as PowerLogic SCADA?
We do not recommend this practice. Each of those applications uses SQL server,
which requires so much of the CPU that PowerLogic SCADA performance would be
severely degraded.
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When creating custom tags, how do we ensure consistency in their names and
attributes?

Until the Profile Editor has been expanded to include an import/export utility, it will take
work on part of the integration teams to keep themselves synched.

1. When you name a tag that you believe should be added as a standard tag, you
should be able to identify it. We recommend “locking” these tags. Later we can pull
the tags that were “locked” and work on creating “real” IEC tag names.

2. Create all tag names on the master computer; then copy the customtags.xml file
(located in the OS-specific data directory: Data/Profile Editor/ Vx.x) to each
computer that will be used to create and edit device-types/profiles.

3. When creating a new tag name, be sure to complete all of the alarm/logging filter
(metadata) data fields. Without these fields properly completed, the real-time and
alarm filters, and future reports/analysis will not work.

It is often easier to “copy from” a similar tag when creating a new tag. This will pre-
populate all of the fields, including the metadata/filter data. Then you can change the
tag as needed.

How should we manage categories and subcategories?
We recommend that each integration team decide in advance which categories and
subcategories they will use. The automation interface requires the entire Profile name
(which uses the category and subcategory as part of its name). Thus, you must be
consistent in naming if the profiles are going to be shared and re-used.

1. Category should be used for a vendor.
2. Subcategory should be used to describe a type of device.

3. From the master computer that has the Profile Editor installed, create the categories
and subcategories that you plan to use.

4. Copy the DeviceTypeCategories.xml file (located in the OS-specific data directory:
Data/Profile Editor/ Vx.x ) to every computer being used to create profiles.

How should we manage units and unit templates?
Until the Profile Editor has been expanded to include an import/export utility it will take
work on part of the integration teams to keep themselves synced.

Create all units and unit templates on the master computer. Then copy the units.xml
and unitstemplates.xml (located in the OS specific data directory: Data/Profile Editor/
Vx.x ) to each computer that will be used to create/edit device-types/profiles.

When should I create a device type rather than device profile?
Create a new device type, instead of a profile, when the addressing for a specific tag
needs to change. An example:

The integration team can choose which Input to which they will wire circuit breaker
status and position. In this case, the tags for circuit breaker status and position would
have different addressing, based on how that particular circuit breaker is wired. We
recommend a new device type in this case.

206 © 2011 Schneider Electric All Rights Reserved

63220-100-200E1 Appendix 5: Frequently AskedQuestions (FAQs)
06/2011



Appendix 5: Frequently AskedQuestions (FAQs) 63220-100-200E1
06/2011

How do we share or transfer device types and device profiles between com-
puters?

Until the Profile editor has been expanded to include an import/export utility, it will take
work on part of the integration teams to keep themselves synced.

Youmust ensure that you have maintained synchronization between all the
computers for:
• units and unit templates
• categories and subcategories
• custom tag names

To transfer or share device types:

1. On the source PC: From the OS-specific Data/Profile Editor/ Vx.x directory, locate
the device type of interest (<Device Type name>.xml). Copy it to the corresponding
directory on the destination PC.

2. On the source PC: From the Data/Profile Editor/ Vx.x /DeviceTypes directory, locate
the device type of interest (<Device Type name>.xml). Copy it to the corresponding
directory on the destination PC. (You must locate the proper version of the Profile
Editor. It will be associated with the version of the Profile Editor that was used to
create it.)

If you do not know the profile name, or if you want to pull over all of the profiles for a
given device type):

a. From the Profile Editor, Add/Edit Device Type screen, click “Edit Existing.”
b. Choose a Device Type to Create From.
c. Click “Display Associated Profiles.” Note the list of associated profiles to the

chosen device type.
d. Copy the profile file(s) (<Device Profile name>.xml) to the corresponding

directory on the destination machine.

Importing files into the Profile Editor

Use the import feature to import tags, device types, and profiles into the Profile Editor.
You can import either an existing project or SCL files. See Importing Files into the
Profile Editor on page 72 for full details.

How can we re-use previous Profile Editor projects?
Until the Profile editor has been expanded to include an import/export utility it will take
work on part of the integration teams to keep themselves synced. It is recommended
that you

Youmust ensure that you have maintained synchronization between all the
computers for:
• units and unit templates
• categories and subcategories
• custom tag names
• device types
• device profiles

To transfer/share projects:
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1. On the source PC: From the OS-specific Data/Profile Editor/ Vx.x directory, locate
the project of interest. Copy the entire project-specific directory to the
corresponding directory on the destination PC.

2. On the source PC: From the Data/Profile Editor/ Vx.x /DeviceTypes directory, locate
the project of interest. Copy it to the corresponding directory on the destination PC.
(You must locate the proper version of the Profile Editor. It will be associated with
the version of the Profile Editor that was used to create it.)

Importing files into the Profile Editor

Use the import feature to import tags, device types, and profiles into the Profile Editor.
You can import either an existing project or SCL files. See Importing Files into the
Profile Editor on page 72 for full details.

How do we synchronize a new PC with the master Profile Editor PC?
To synchronize a new machine with the latest device types and profiles from your
master Profile Editor PC, you can:
• Use the Import feature to import tags, device types, and profiles from either an

existing project or from SCL files. See Importing Files into the Profile Editor on page
72 for full details.

• On the source PC: From the OS-specific Data/Profile Editor/ Vx.x directory, copy the
entire OS-specific Data/Profile Editor/ Vx.x directory to the corresponding directory
on the destination machine.

What do I do before I add or remove devices in the Profile Wizard?
1. You must close all open dbf files in the Project Editor (or in Excel).
2. If you are removing a device, check “pack database after removal” on the last page

of the wizard.

3. Any changes that you made inside the Citect Project Editor (such as setpoints or
data type modifications) are lost when you delete the device from PowerLogic
SCADA.

What are the requirements for device names?
Device Name:

Keep Device name ≤ 16 characters. Use _ as a separator.

If you use a naming convention that incorporates location, you will be able to do
filtering on alarm location, etc.
• For example, Site_Building_Panel_device would be named Sx_Bx_Px_Device.

(Site1_Building1_Panel1_CM41 — S1_B1_P1_CM41).
• The fewer levels you have, the more characters you can have in each level.

Device Comment:

Use this field for an alias of the device name.

This comment will be placed in the Equipment database, which is accessible from
Cicode.
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How do I troubleshoot device communications issues?
PowerLogic SCADA drivers provide default communication settings that work with
most devices. However, in cases when communication losses occur in PowerLogic
SCADA, use this checklist for finding the issues.

1. Initial checks, if the device is attached via a gateway:
— Ensure that all communication settings are correct on the gateway and device.
— Check the gateway timeout. A setting that is too low will cause many timeouts to

occur. A setting that is too high will impact performance. We recommend a 3
second timeout, because most devices work well with this setting. Some
devices may require a higher timeout (5 seconds).

2. In all communication setups (also see the driver help for parameters):
— Ensure that the PowerLogic SCADA driver timeout is correct. We recommend

that you set this to:
gateway timeout x number of clients + padding
Example: If the gateway timeout is 3 seconds and there are 3 clients, set the
timeout in PowerLogic SCADA to 10 seconds.

— Check the maximum block read size. Some devices do not handle large block
reads well. When you lower the maximum block read size, the requests are
smaller and faster. The downside is that more requests will be sent to the
device, and tags will refresh more slowly.

— Check the device to see if there are registers that it cannot read. Some devices
do not allow access to all registers.
Example: Data is in register 100-125 and 130-150. PowerLogic SCADA will
perform one read from 100-150. If 126-129 do not allow reading, this packet will
return an exception. Use the appropriate logic code to mark these registers as
invalid reads.

— If there are still timeout/no response issues, enable retries on exception. Some
devices may not respond if they are performing other functions. In this case,
a0x0A or 0x0B exception will be returned to PowerLoic SCADA, which will
cause a communication loss. Enabling the "retry on exception" will re-try the
request.

How do I use MODBUS communications methods?
MODBUS TCP/IP via Gateway: Use this for any device that is not speaking TCP/IP
natively. These devices connect through a gateway device such as an EGX or ECC.

MODBUS TCPIP: Use this for any device that can speak TCP/IP natively. This includes
CM4 or PM8 devices that have an ECC card installed.

How can I add more than one device at a time?
The Automation Interface requires that the profiles have already been exported from
the Profile Editor to the PowerLogic SCADA project.

If the automation spreadsheet attempts to add a device that is already present in the
project, an error will be thrown.

In the event that an error is thrown (for invalid profiles, communication parameters,
etc), the row containing the error will display in Excel. To prevent duplicate device
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entries from being attempted, you must remove any rows above the row indicated
in the error message.

If you need to keep a record of the devices added to the system, then keep each of the
spreadsheets that was used to install devices in a known location for that customer.

The Setup Sheet needs to be modified for each project. Specify the entire path for each
file.

The Input Sheet requires the following:

The entire path name for each profile. The path name for a profile is based on the
category and subcategory from the Profile editor.

Example: Schneider Electric.Monitoring Device.Branch Circuit Monitor Full

In PowerLogic SCADA, what are the naming conventions for servers and
clusters?

There is no enforced naming convention for server and cluster names, other than the
restriction that each server name and cluster name must be unique. Cluster names
must be a maximum of 16 characters, no spaces; they may not begin with a number.

Each team should come up with a naming convention for the servers and clusters. If
the team is consistent, it will make it easier to edit/create the automation spreadsheet
used for device addition.

How and when do I create users for the Runtime environment?
New projects do not have any users created by default.

The default PowerLogic SCADA graphics objects (such as circuit breakers and alarm
pages) are constructed using a pre-defined set of user privileges the PowerLogic
SCADA security grid). During development, you must have users of various privilege
levels for testing purposes. Create users for each of the various levels according to the
PowerLogic SCADA security grid. To make the best use of these privileges, we
recommend that you use this security grid when adding users as you create new
projects.

See Default User Access Settings (Privileges) on page 159. For additional information,
see Using_Security.html in the CitectSCADA.chm help file (Start > Programs >
 Schneider Electric > PowerLogic SCADA 7.20 > PowerLogic SCADA Help).

How do I manage projects in the Citect Explorer environment of PowerLogic
SCADA?

Although the designer may wish to organise each project in a particular way to suit
customer's needs, the following is a recommended best practice:

1. Keep original ‘Master’ copies of the PLS_Example and the PLS_Include projects
for reference.

2. The Services group may develop a group-wide “include” project that will act as a
conduit between the PLS_Include project and all customer projects (e.g., "Group_
Include"). This will make the upgrading of PLS_Include much easier, as it will be
the only project that must be modified to be compatible with the new version in the
group-wide include project.
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Any changes made to the PLS_Include project should be made at the Group_
Include project level. This would involve removing portions of the code from the
PLS_Include project, modifying the code and saving it in the Group_Include project.
By removing (or commenting out) the original code and placing the new code in the
Group_Include project, a layer of abstraction is preserved, further simplifying the
upgrade process. In other words, the only changes to PLS_Include should be code
removal.

3. When a new customer project is started, also create a customer-level “include”
project.

Always back up and restore the customer project and its associated include
projects together.

Always restore include project(s) before restoring the customer (or top-level)
project.

4. Upgrading PLS_Include:

Document all changes to PLS_Include. This is absolutely necessary when
upgrading to a new version of the PLS_Include project.

Minimize changes to the PLS_include project.

Abstract as many changes to the PLS_Include project as possible. This should be
accomplished by the use of multiple include projects as shown in the diagram
above.

New versions of PLS_Include will include a detailed description of each change,
allowing you to merge the old and new versions.

New versions of PLS_Include will maintain backward compatibility where possible.
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On the Graphics page, what do I need to know about creating genies?
1. Creating a new genie:

The easiest way to create a new genie is to use an existing genie from the library.
This ensures that the new genie is compatible with the PowerLogic SCADA system,
and that it preserves these features:
— Compatibility with animated busbar logic is maintained. This gives you the

ability to use the setting from the Color Change Tool for animated busbar
colour.

— A sizing guide (a dotted rectangle) is included; it displays during graphics edit
mode. This guide ensures that new genies can be swapped with existing
genies without the need to recreate portions of the drawing.Save the new genie
in the appropriate project (do not overwrite the provided genies).

Save the new genie in the appropriate project (do not overwrite the provided
genies).

2. Copying a genie to another project:

Open the genie in the graphics editor, and do a <save as> into another
project/library.

3. Genie Form Files:

Any new genie (copied or created) will not have a .frm file entry associated with it.
While the new genie is functional, it will show a cryptic unformatted properties box
in the Graphics Editor. You can create your own .frm file with the needed entries by
following the instructions available in the Citect Knowledge base.

If you want to use the .frm dialog box that belongs to the genie you copied, go to the
PLS_Include library; locate the .ctm and .ftm files. Each library has its own .ctm/.ftm
files that include the description for every genie in the library. (This is an ascii text
file that you can open in any text editor.) Find the genie that you copied (or on
which you're basing the new form). Copy the portion that matches the copied genie,
and create a .frm file that has the desired library name on it. Copy in the text from
the .frm file. Restart Citect Explorer or it will not detect the new .frm.

4. Genie Sizing

The provided genies come in two sizes: size 1 and size 2. When making a new
genie for reuse among multiple projects, it will be beneficial to create a genie for
both sizes. Follow the same steps for both sizes (sizing guides are provided for
both sizes).

How do we customize existing templates?
Template Editing:

All objects on the page contain one or more Animation Numbers (ANs). Symbols take
one AN while genies may take tens to hundreds of ANs. Placeholder ANs allow you to
add objects to a template that is used on existing pages.

Some default templates contain ANs that have associated Cicode functions that rely on
the animation number to remain a fixed number. For this reason, we have pre-
allocated a set of ANs for the default templates. The base normal template uses ANs
1–263, and it has placeholder ANs from 264–500. When customizing this template,
you should use the placeholder ANs as required.

You can place an AN (or a placeholder AN) on the page by using the “System 3.x/4.x
tools available in the Graphics Builder under Tools< Options.

The default template uses ANs 1–263 and it has placeholder ANs from 264–500.
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New objects added to a page or template will take the next available ANs. Any
previously used (and now abandoned) ANs will be reused.

To add an object on the template, you must:

1. Open the template.
2. View the page properties and change the page width to 2000. This will reveal the

hidden placeholder ANs on the page. You may have to change the width to a wider
dimension for widescreen templates.

3. Determine how many ANs the new object requires. (You can place the new object
on a blank page and then view the object in the object browser.)

4. Remove exactly the amount of ANs to allow the new object to be placed on the
template. Remove ANs beginning with the lowest available placeholder AN (in the
default template, this would be 264).

5. Place the object on the template.

6. Save the template.

7. Create a new page based on this template.

8. Drop a numeric object on the page.

a. This object’s AN should be 502 (501 is reserved for placing the template on the
page).

b. If the object has an AN less than 502 then you have unused AN(s) on the
template. This must be resolved. (Place additional ANs on the template to rectify
this situation.)

c. If the object has an AN greater than 502 then you have too many ANs on the
template (a AN on the template is going beyond the 500 limit). You must find the
culprit (via the object browser) and rectify the situation using the steps above.

How do I change the default pickup/dropout text for alarms?
The default ‘pickup/dropout’ text is shown as Appearance/Disappearance.

To change globally:

This text may be changed by configuring INI parameters in the citect.ini file. For
more information, see the System Integrator’s Guide (Graphics Library Parameters
on page 193)

This is the global fallback text that will be used in the event that pickup/dropout text
is not specific on a per-alarm basis in the Device Profile. You can specify the per-
alarm pickup/drop-out text on the profile tab in the Profile Editor.

To change on an individual basis:

See the System Integrator's Guide (Viewing Device Profiles on page 51, "Alarm On
Text" and "Alarm Off Text").

What can I modify during runtime?
Set-point Configuration during runtime: In the Alarm Server entry in the project editor,
view the advanced properties (F2) and set publish alarm properties = TRUE

Events Accessible at runtime: By default, 5000 events are accessible (view, filter,
print) during runtime. Additional events are logged to disk. The number of events
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accessible at runtime may be changed by the [Alarm] SummaryLength parameter in
the INI file.

Why do the browser navigation buttons not work?
If the browser navigation buttons do not work when you are viewing the runtime
window, you have probably added a new page, but have not done the following:
• added the startup page to the Page parameter. See Setting a New Page as the

Project Startup Page on page 118 for help.
• left the INI settings at <default>. In the Computer Setup Wizard, General Options

Setup screen, do not change the StartupPage field; leave it as <default>.

What can I set up in logging and archiving?
Event Logging and Archiving:

Event fields that are logged to disk may be configured by adjusting the AlarmFormat
parameter.

There is no automatic maintenance performed on the log files. It is important that the
log/waveform data be cleared out periodically (to prevent the hard drive from filling up;
this does not affect performance).

On the Graphics page, how are colour changes displayed for voltage levels?
Definitions:

Voltage Level: This is a number from 0–3 that relates to the selected “ACTIVE” colour
in the Color Change Tool. This is a graphics-level number that is used for animation
purposes (in expressions and Cicode).

Nominal Voltage: This is the actual voltage present on the line at the customer’s site.

1. Before creating the first graphics page of a new project, determine the nominal
voltages that will be assigned to voltage levels 0–3. Examine the customer’s power
system to determine nominal voltages required.

2. As a team, decide which voltage level will represent the highest nominal voltage
present at a customer’s site (0 or 3). This will provide for easier code re-use and
project management.

3. Document the nominal voltages and voltage levels for each project, and keep them
with the project (in a text file in the project directory or in a comment in a Cicode
file).

4. Run the Color Change tool after any changes to graphics and at the very end of the
development process. This ensures that all graphics have the same colour
configuration.

Always update pages after running the Color Change Tool.

The Color Change Tool will change colours on all projects that are included by the
top-level project. Care must be taken to not ‘colour change’ a project
unintentionally.

Example Project Documentation:
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Colour Change
Voltage Level Nominal Voltages Colour

0 240 blue

1 480 green

2 4160 purple

3 12470 red

How do I create and configure busbars?
When drawing one-line diagrams:

Analyse the drawings at a customer site.

Number the busbars consistently on the one line diagram(s). If busbar 14 spans
across multiple pages, it should be numbered busbar 14 on all pages. Label the
voltage level (0–3) on each busbar.

Uses for Line Active:

Page Connections: Many one-line diagrams will span multiple pages in
PowerLogic SCADA. To connect these pages together, you must use the line active
field of the ‘incomers’ of the second and subsequent pages. Set the line active field
of the incoming busbars on these pages to an expression that references the
nearest device on the same busbar of the previous page.

Metered Busbar: Many busbars are actually metered. It is more accurate to allow
these metering devices to dictate state than to rely solely on the simulation (see
Expressions below).

Configuration of Line Active:

Simulation: If the Line-Active field is left blank, the busbar state will be determined
by surrounding devices.

Expressions:
A Cicode expression in the form of Device\Tag > Nominal Voltage (I.E., S1_B1_P1_
CM41\MMXU1\PhV\zavg > 120).

If the expression is TRUE, the ACTIVE colour will be shown. The active colour is
determined by the voltage level assigned.

If the expression is FALSE, the DE-ENERGIZED colour will be shown.

Hard-Coded:
If no upstream devices are available (in the event of an incomer, for example), you
may have no other choice than to ‘hard code’ this field to a ‘1’. This forces the
busbar to always be ACTIVE.

What INI parameters should I use for debugging?
We recommend that you contact Technical Support before performing any debugging.

Parameter: [PowerLogicCore]
DebugCategory = Error

DebugLevel = All

LogArchive = 1

LogFileSize = 200000
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Parameter Details:

DebugCategory defines which message categories to log. (See table below).
DebugLevel defines debug levels of messages to be logged. (See table below).
LogFileSize specifies maximum log file size in kilobytes. After reaching the limit, file
is saved with suffix “.BAK” and new file is started over.

Debug Levels
The following debug levels are accepted by PowerLogic driver core library:

WARN: log all warning level messages

ERROR: log all error messages

TRACE: log all trace messages

DEBUG: log all debug messages

ALL: include all level messages

Debug Categories
PowerLogic core library and drivers messages are grouped in categories. Each of
these categories can be enabled independently from others in any combination.

MISC: miscellaneous messages that do not all into any other category

ALARM: messages related to alarms, regarding collection and detection

WAVE: messages related to waveforms -- waveforms download, processing

REAL: messages related to real-time data collection

STATE: messages related to internal object-state changes

CORE: core events that do not fall into driver-specific logic

MODBUS: TCP/MODBUS messages

ENTRY: trace messages produced when driver API entry points are called by
PowerLogic SCADA

PORT: traces related to the port events

UNIT: traces related to specific unit events

WAVETOALARM: not used

DATAPOINT: debug messages related to data points

STATISTICS: enables driver statistics data output

COMMAND: messages related to commands

REPLICATION: messages produced by replication subsystem

ALL: enables all categories

Parameter: [Debug]
Menu = 1

Parameter Details:

The Menu parameter determines whether the Kernel option is displayed on the control
menu of the PowerLogic SCADA runtime menu. This can also be enabled using the
Computer Setup Editor.

How do I tune my system for best performance?
There are several parameters that you can use to enhance your system's performance:

Driver-tuning parameters:
Parameter (Back Polling Rate): [SEPAM40]
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CacheRefreshTime = 1000

InitUniCheckTime = 120

Retry = 3

Timeout = 1000

Parameter Details:
The CacheRefreshTime parameter controls the maximum rate at which the driver
will attempt to repopulate its cache. If the driver cannot refresh its cache within the
time period specified, it will collect data as fast as the network allows.

This back polling rate can be global to all devices or tuned up to a specific I/O
device.

The InitUniCheckTime parameter controls how long the driver will wait before
attempting to bring a device online after it has gone offline. This value can be
decreased to bring offline devices back into service in a shorter period of time. In a
multi-drop scenario, this time should be relatively long, to prevent init unit requests
from stalling communications to the rest of the devices on that port.

The Retry parameter defines the number of retry attempts for specific MODBUS
requests. Retries will only occur in response to the MODBUS errors which are
defined below.

The Timeout parameter controls how long the driver will wait for a response from a
device before setting that device as offline. This value should be greater than the
device/gateway timeout period.

Parameter: [Device]
WatchTime = 5000

Parameter Details:
Device WatchTime is the frequency that PowerLogicSCADA checks devices for
history files and flushes logging data to disk.

Default: 5000

Range: 1000–3600000 milliseconds.

Miscellaneous Parameters

Parameter: [Kernel]
Task = 20000

Parameter Details:
Kernel Task is the number of tasks. Increasing the number of kernel tasks is used
when “Out of Kernel Task” message is received. The change will be likely for large
systems.

Default Value: 256

Range: 50–32767

Parameter: [Page]
ScanTime = 250

Parameter Details:
Page ScanTime determines how often the Animator refreshes a graphics page at
runtime.

Default: 250

Range: 1–60000 milliseconds

Parameter: [ALARM]
ScanTime = 500
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Parameter Details:
Alarm ScanTime determines the rate at which alarms are scanned and processed.
Default: 500

Range: 0–60000 milliseconds

If a tag is configured in PowerLogic SCADA, how is it polled in the device?
In other words, is a tag only polled on demand when it is requested by a client (for
example, when the operator displays a page with the tag on it)? Or are all configured
tags polled all of the time, with the relative polling rates/communications bandwidth
carefully managed?

The ModNet driver polls real-time tags on a user demand basis (when a user opens a
page with the tags on it). Therefore, the time to retrieve data will vary, depending not
only on the communications bandwidth, but on the amount of data being requested.
This can vary significantly, depending on which pages are displayed by the operators
at any particular time.

The PWRMODBUS driver polls all configured tags; however, different types of tags can
be polled at different relative rates, and the available communications bandwidth is
carefully managed. This approach means that tag update rates are not subject to the
scaleability issues associated with operator actions (as is the case for the ModNet
driver). It is also advantageous in that performance issues associated with
communications bandwidth or IODevice response times can be determined at
SAT/time of implementation and are not subject to significant change during operation.

The different tag types can be allocated relative importance in data requests,
expressed as a percentage. (See Bandwidth Allocation Parameters in Performance
Tuning Parameters on page 180.) Keep in mind that any unused bandwidth allocation
(from, for example, events retrieval) is made available for other data types to use. If the
event does not need the default 25% allocation, it will be made available to the other
parameters (real-time tag retrieval, etc). This potentially increases the update rate of
real-time tags.

Additionally, the real-time tag relative scan rate based on priority can be set to three
different levels. (See Tag Scan Rate Parameters in Performance Tuning Parameters
on page 180.) This means that, if some real-time tags are more important that others,
you can set their relative priorities. For example, configuration tags vs. important real-
time tags vs. normal real-time tags.

Device popup from a one-line: Why do the fields overlap?
This is controlled by a parameter entry:

Section: Page

Name: EquipDetailDescLength (the total number of characters in a single row of this
popup)

Default = 48. The problem will occur with a larger font or if the window is resized. The
default value of 48 can be changed or the window and associated genies can be
resized.
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Can I change the %CLUSTER% name in the Profile Wizard?
No. If you change the placeholder %CLUSTER% to any other name in the Profile
Wizard, the system will be unable to find the actual cluster to which it refers.

When viewing PowerLogic SCADA from a web client, I see a licensing error. How
do I fix it?

First, verify that the appropriate licensing is available.

A web client requires the same number of ports open as a standard control or view-
only client. You only need to allow communication to those servers from which the
client needs information. For example, alarm, trend, reports, and I/O.

When you open PowerLogic SCADA from a client computer, and you see a licensing
error, make these port settings. This will open both PowerLogic SCADA and the
license key server (7001: USB sentinel key port) in the routers and firewalls between
the client and the server. The ports that you need to open are listed in boldface:

Default Port Server Type Server Role

21 FTP server page downloads for IDC

80 Web server project files for Web client

2073 CTAPI CTAPI communications

2074 client Cicode debugging

2075 Reports server Reports server communications

2076 Alarm server Alarm server communications

2077 Trends server Trends server communications

2078 IO server legacy I/O communications

2079 IDC Internet display server/client communications

2080 Alarm server alarm properties connector

2081 time server time server communications

2082 IO server publish subscribe I/O server communications

20222 ODBC ODBC server

A device can prevent writes to its registers: how do I ensure that writes are suc-
cessful?

PowerLogic SCADA cannot provide feedback about whether a write to a device
register is successful. If a device is capable is preventing (blocking) writes to its
registers (for example, Sepam), you need to verify that its “block” feature is not
enabled. Do this at the device.

NOTE: In Cicode, you can also use the tagwrite function in blocking mode, i.e., bSync
parameter = true; Check the return code: 0 = success, anything else = error. For more
information, see the Cicode Programming Reference help file.
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How do I prevent PowerLogic SCADA from accidentally making invalid areas in
memory available to reads and writes?

PowerLogic SCADA normally optimises its packets for greatest performance. This
optimisation can sometimes includes invalid areas of memory in devices. These invalid
areas can be specifically defined and excluded from optimisation packets created by
PowerLogic SCADA. See Advanced Tag Blocking Capabilities in Performance Tuning
Parameters on page 180 for more information.

How do I create an audit in the Event Log for user logins and logouts?
//LOGOUT

FUNCTION

PLSLoginUser()

//INT iPage = PageInfo(1);

INT iPage = WinNumber();

IF mbLoginFormShown[iPage] = TRUE THEN

RETURN; //form already shown

END

//prevent multiple forms

mbLoginFormShown[iPage] = TRUE;

IF (UserInfo(0) <> "0") THEN
// Confirm User Action
IF (0 = Message(StrToLocalText("@(Confirm)"), StrToLocalText("@(Logout)"),
1+32)) THEN
PLSAlmDspEventAdd(0, 0, 1, "User Logout", Name(), "Logout", "");
Logout();
END
mbLoginFormShown[iPage] = FALSE;
RETURN;

END

IF (0 = LoginForm())

PLSAlmDspEventAdd(0, 0, 1, "User Login", Name(), "Login", "");

END

mbLoginFormShown[iPage] = FALSE;

END
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Why do I get an "out of memory" message when I try to run the Automation Inter-
face?

The problem is that you did not have Microsoft Excel installed before you installed
PowerLogic SCADA. The only solution is to uninstall both Excel and PowerLogic
SCADA; then, reinstall first Excel and then PowerLogic SCADA.

Why am I seeing #COM for circuit breaker status in the genie status page?
If this is a Micrologic P device, and it does not have a CCM, you will not be able to view
data referring to circuit breaker status, e.g. racked in/racked out. When there is no
CCM, the device profile should not have tags that refer to the CCM.

Why can't I acquire waveforms in the waveform viewer?
The "acquire" feature (the "A" button on the waveform viewer) does not work in
PowerLogic SCADA. You can, however, view waveforms from device onboard
waveform files. To do this:
• At the device or in the meter configuration software, add the appropriate alarm, and

enable automatic capture of the waveform when the alarm occurs.
• In the Profile Editor (Create Device Profiles tab), check the Waveform box for the

alarm you added.
• When the alarm occurs, the waveform is captured. You can view the waveform in

the Alarm Log. You can also view alarms/waveforms from a drawing in the runtime
environment. Click the genie for the device; right-click the alarm to view the
waveform.

Note that, in very large systems, it could take as much as an hour for the waveform
to appear.

Why won't the Excel DBF Add-In toolbar install?
When you are installing the Excel DBF Add-In toolbar, you may see this error: "Error
1308. Source file not found....."

You can click "ignore" at this error, and the install will finish. The next time you open
Excel, the DBF toolbar will display.

What causes the "First dbf record" error message? How do I keep it from hap-
pening?

The error message "First dbf record" tells you that a project is not found. This happens
when you add a project, and then rename it or delete it. Then, when you try to create a
new project, you see this error message.

To resolve this issue, simply shut down and then restart the Citect Explorer.
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